
Mercury IT Governance Center™

Mercury Project Management™

User’s Guide
Version: 6.0



This manual, and the accompanying software and other documentation, is protected by U.S. and 
international copyright laws, and may be used only in accordance with the accompanying license 
agreement. Features of the software, and of other products and services of Mercury Interactive 
Corporation, may be covered by one or more of the following patents: United States: 5,511,185; 
5,657,438; 5,701,139; 5,870,559; 5,958,008; 5,974,572; 6,137,782; 6,138,157; 6,144,962; 
6,205,122; 6,237,006; 6,341,310; 6,360,332, 6,449,739; 6,470,383; 6,477,483; 6,549,944; 
6,560,564; 6,564,342; 6,587,969; 6,631,408; 6,631,411; 6,633,912; 6,694,288; 6,738,813; 
6,738,933; 6,754,701; 6,792,460 and 6,810,494.  Australia: 763468 and 762554.  Other patents 
pending. All rights reserved.

Mercury, Mercury Interactive, the Mercury logo, the Mercury Interactive logo, LoadRunner, 
WinRunner, SiteScope and TestDirector are trademarks of Mercury Interactive Corporation and 
may be registered in certain jurisdictions.  The absence of a trademark from this list does not 
constitute a waiver of Mercury's intellectual property rights concerning that trademark. 

All other company, brand and product names may be trademarks or registered trademarks of their 
respective holders.  Mercury disclaims any responsibility for specifying which marks are owned 
by which companies or which organizations.

Mercury
379 North Whisman Road
Mountain View, CA 94043
Tel: (650) 603-5200
Toll Free: (800) TEST-911
Customer Support: (877) TEST-HLP
Fax: (650) 603-5300

© 1997–2005 Mercury Interactive Corporation. All rights reserved.

If you have any comments or suggestions regarding this document, please send email to 
documentation@mercury.com.

Publication Number: ITG60ProjectMgtUG1104A



Table of Contents
List of Figures ........................................................................................................................................ xi

List of Tables ........................................................................................................................................ xiii

Chapter 1: Introduction.......................................................................................................................15

 About This Document.............................................................................................................................................. 16

 Who Should Read This Document ................................................................................................................... 17

 Related Documents.................................................................................................................................................. 17

 Overview of Mercury Project Management ................................................................................................. 18

Chapter 2: Setting Up a Project Plan ............................................................................................21

 Overview of Setting Up a Project Plan ........................................................................................................... 22

 Before Starting............................................................................................................................................................ 22

 Creating a Project ..................................................................................................................................................... 23

 Setting Up a Master Project................................................................................................................................. 26

Creating the Master Project Entity ............................................................................................................ 26

Selecting Information to Track and Display.......................................................................................... 28

Setting Up Exception Behavior.................................................................................................................... 29

Setting Exception Rule Behavior ........................................................................................................ 30

Summary Condition ................................................................................................................................... 33

Cost Health Indicator ................................................................................................................................ 34

Setting Up Indicators ........................................................................................................................................ 35

Setting Scheduling Options........................................................................................................................... 36

Setting a Default Date From Which to Schedule ....................................................................... 37

Setting Scheduling With or Without Actual Start/Finish Dates .......................................... 38

Setting Scheduling Options for Resource Dependency ........................................................ 39

Setting the Region...................................................................................................................................... 40
iii



Table of Contents
Setting Security Restrictions ........................................................................................................................ 41

Setting Security for the Master Project........................................................................................... 41

Setting Security for Cost Data ............................................................................................................. 42

Setting Up the Project Team......................................................................................................................... 43

Deleting Resources from a Project Team ...................................................................................... 45

Setting Up Microsoft Project Integration................................................................................................ 46

Microsoft Project File Information ...................................................................................................... 47

Activity History.............................................................................................................................................. 47

Control Mode................................................................................................................................................. 47

Resource Identification ............................................................................................................................ 48

Importing Custom Fields from a Project Template ........................................................................... 48

 Adding Tasks to a Project ..................................................................................................................................... 50

Adding Tasks to the Project Plan Tab ...................................................................................................... 50

Adding Tasks Using Project Templates ................................................................................................... 51

Setting Up Project Hierarchy ........................................................................................................................ 52

Useful Keyboard Shortcuts in the Project Plan Tab ................................................................. 54

Attaching Additional Information to a Project or Task .................................................................... 55

Creating a Task From a Request ................................................................................................................ 55

Adding Milestones .............................................................................................................................................. 58

 Setting Up Project Dependencies .................................................................................................................... 59

Setting Internal Predecessors ...................................................................................................................... 61

Setting an External Predecessor Task..................................................................................................... 61

Setting an External Predecessor Project................................................................................................ 64

Setting an External Predecessor Request............................................................................................. 67

 Creating a Master Project Schedule ............................................................................................................... 69

Generating the Schedule................................................................................................................................ 69

Scheduling Errors................................................................................................................................................ 70

Scheduling Warnings ........................................................................................................................................ 71

 Establishing a Project Baseline .......................................................................................................................... 72

Selecting Baseline Fields ................................................................................................................................ 72

Taking a Baseline ................................................................................................................................................ 75

Managing Baselines ........................................................................................................................................... 75

Comparing Baselines ........................................................................................................................................ 77

Chapter 3: Configuring Tasks ..........................................................................................................79

 Overview of Configuring Tasks........................................................................................................................... 80

 Task Elements ............................................................................................................................................................. 80

Notifications ........................................................................................................................................................... 81

References ............................................................................................................................................................. 81

Activities................................................................................................................................................................... 81

Task States ............................................................................................................................................................. 82

 Adding Tasks to Project Plans ............................................................................................................................ 82

Creating a Task From a Request ................................................................................................................ 83

Creating a Milestone ......................................................................................................................................... 86
iv Mercury Project Management™ User’s Guide



Table of Contents
 Editing Task Information ........................................................................................................................................ 87

 Assigning Resources................................................................................................................................................ 88

Assigning Resources in the Project Plan Tab....................................................................................... 88

Assigning Resources in the Task Information Window................................................................... 89

Assigning Multiple Resources in the Task Information Window ................................................ 89

Assigning Resource Groups.......................................................................................................................... 90

Determining Project Resources .................................................................................................................. 91

 Assigning Skills ........................................................................................................................................................... 91

 Adding Action Items................................................................................................................................................. 92

 Adding Notes ............................................................................................................................................................... 93

 Setting Up Notifications ......................................................................................................................................... 93

Using Smart URLs in Notifications............................................................................................................. 94

Nested Tokens in Notifications.................................................................................................................... 97

 Entering Cost Data ................................................................................................................................................... 99

 Attaching References to Tasks ........................................................................................................................100

Attaching Existing Requests........................................................................................................................100

Searching for Requests to Attach ....................................................................................................101

Attaching New Requests...............................................................................................................................103

Attaching Packages .........................................................................................................................................104

Searching for Packages to Attach ...................................................................................................105

Attaching New Packages ..............................................................................................................................106

Attaching Tasks..................................................................................................................................................107

Searching for Tasks to Attach ............................................................................................................108

Attaching Releases ..........................................................................................................................................110

Attaching Documents .....................................................................................................................................111

Attaching URLs...................................................................................................................................................112

Dependency Relationships ..........................................................................................................................113

 Configuring Task Predecessors .......................................................................................................................113

 Changing the Task State .....................................................................................................................................114

 Setting Scheduling Constraints........................................................................................................................115

 Configuring User Data...........................................................................................................................................115

Project/Task User Data Roll-Up.................................................................................................................115

Creating Project/Task User Data Roll-Up.....................................................................................116

Editing Project/Task User Data Roll-Up ........................................................................................119

Deleting Project/Task User Data Roll-Up .....................................................................................121

Example: Using Project/Task User Data Roll-Up......................................................................122

Chapter 4: Managing a Project Plan ........................................................................................... 125

 Overview of Managing a Project Plan...........................................................................................................126

 Setting Up a Project Plan ....................................................................................................................................128

 Adding Tasks to a Project Plan ........................................................................................................................129
v



Table of Contents
 Taking a Baseline.....................................................................................................................................................129

 Revising the Project Plan.....................................................................................................................................130

Viewing and Modifying Project Plan Hierarchy .................................................................................130

Project Plan States...........................................................................................................................................131

Modifying States ........................................................................................................................................132

Updating Scheduling and Dependencies.............................................................................................133

Changing Scheduled Duration, Start, Finish, and % Complete.........................................133

Changing Predecessors.........................................................................................................................134

Updating Tasks from the Standard Interface .....................................................................................135

Concurrent Editing ...........................................................................................................................................136

Unrelated Subprojects in a Master Project .................................................................................136

Simultaneous Edits on a Master Project.......................................................................................136

Simultaneous Editing and Updating of a Task...........................................................................137

Updating an Unrelated Task................................................................................................................137

 Updating the Schedule .........................................................................................................................................138

 Viewing Project and Task Progress................................................................................................................138

Searching for Projects in the Workbench............................................................................................138

Searching for Tasks in the Workbench .................................................................................................139

Viewing the Summary Condition ..............................................................................................................140

Viewing Milestones...........................................................................................................................................141

Viewing the Project Plan Critical Path....................................................................................................142

Viewing the Critical Path in the Project Window......................................................................142

Viewing the Critical Path from the Project Overview Gantt Portlet ...............................143

Obtaining a Critical Path Table ..........................................................................................................145

Viewing Exceptions ..........................................................................................................................................145

Viewing Exceptions in the Standard Interface...........................................................................145

Viewing Exceptions in the Workbench..........................................................................................146

Using the Mercury IT Governance Dashboard to View Progress ............................................147

Project Management Reports ....................................................................................................................147

Comparing Against the Baseline...............................................................................................................147

 Tracking and Analyzing Project Plan Costs ...............................................................................................149

 Tracking Project Plan History............................................................................................................................149

 Completing, Cancelling, and Deleting Project Plans.............................................................................150

Completing Project Plans .............................................................................................................................151

Reopening a Completed Project Plan............................................................................................151

Canceling Project Plans.................................................................................................................................152

Deleting Project Plans ....................................................................................................................................152

 Creating a URL to Open the Project Plan Window ...............................................................................153

 Printing a Project Plan Gantt Chart................................................................................................................153

Printing a Gantt Chart.....................................................................................................................................153

Exporting a Gantt Chart to an Image File ............................................................................................154

Chapter 5: Updating Tasks: Project Plan Participant Activities....................................... 157
vi Mercury Project Management™ User’s Guide



Table of Contents
 Overview of Updating Tasks ..............................................................................................................................158

 Locating Tasks ..........................................................................................................................................................158

Searching for Tasks and Project Plans..................................................................................................159

Locating Tasks Using the Task Search Page .............................................................................159

Locating Project Plans Using the Project Search Page........................................................161

Finding Tasks Using the My Tasks Portlet............................................................................................162

Finding Tasks Using Notifications.............................................................................................................163

Finding Tasks in the Workbench...............................................................................................................163

Searching for Tasks in the Workbench .........................................................................................163

Searching for Project Plans in the Workbench .........................................................................164

Updating Tasks in the Project Plan Tab ........................................................................................165

Updating Tasks in the Task Information Window.....................................................................166

 Viewing Project Plan Information....................................................................................................................166

Viewing Project Overview.............................................................................................................................167

Viewing Project Plan Details........................................................................................................................169

Viewing Project Plan Hierarchy .................................................................................................................170

Viewing Exceptions ..........................................................................................................................................171

Getting to the Exception Detail Page.............................................................................................172

Viewing Project References ........................................................................................................................172

Viewing the Project Plan Gantt Chart ....................................................................................................173

Viewing the Critical Path ...............................................................................................................................174

Viewing Project Plan Milestones ...............................................................................................................174

Viewing Resource Information...................................................................................................................174

 Updating Tasks .........................................................................................................................................................175

Viewing and Updating Task Details .........................................................................................................176

Getting to the Task Details Page ......................................................................................................177

Viewing and Updating Multiple Tasks.....................................................................................................178

Getting to the My Tasks Portlet.........................................................................................................178

 Viewing and Adding Notes .................................................................................................................................179

 Viewing and Modifying References................................................................................................................179

Adding References to Tasks .......................................................................................................................180

Attaching Existing Mercury IT Governance Center Entities ...............................................180

Attaching New Requests.......................................................................................................................182

Attaching Files ............................................................................................................................................183

Attaching URLs...........................................................................................................................................184

Viewing and Editing References ...............................................................................................................185

Deleting References ........................................................................................................................................187

 Visibility Between Project Plans and Programs .......................................................................................188

 Running Reports ......................................................................................................................................................188

Chapter 6: Using Project Templates........................................................................................... 191

 Overview of Using Project Templates...........................................................................................................192

 Setting up a Project Template ..........................................................................................................................192
vii



Table of Contents
Adding Tasks to a Project Template .......................................................................................................193

Creating Custom Fields for Project Templates .................................................................................193

Defining Custom Fields for Project Templates..........................................................................193

Modifying the Layout of Custom Fields.........................................................................................200

Adding Fields to Existing Project Plans .........................................................................................202

Configuring Tasks in a Project Template..............................................................................................203

Configuring Settings for a Project Template ......................................................................................203

Setting Ownership for a Project Template ..........................................................................................204

 Creating a Project Template from an Existing Project Plan..............................................................206

Project Plan to Project Template Conversion Details....................................................................208

 Creating a Master Project from a Project Template .............................................................................212

 Creating a Subproject from a Template......................................................................................................212

Chapter 7: Integrating Project Management with Microsoft Project.............................. 215

 Overview of Integrating Project Management with Microsoft Project.........................................217

 Synchronization Modes........................................................................................................................................217

Project Management controlled................................................................................................................217

Microsoft Project controlled........................................................................................................................218

Project Management controls actuals ...................................................................................................218

 Project Management Strategies ......................................................................................................................219

Overview of Converting a Microsoft Project File to an IT Governance Project ...............219

Publishing a Mercury IT Governance Project through Microsoft Project............................220

Publishing a Microsoft Project File through Project Management..........................................221

Using Project Management to Track Actuals in Microsoft Project .........................................221

 Requirements for the Project Management–Microsoft Project Interface .................................222

Microsoft Project Requirements ...............................................................................................................222

Access Grants.....................................................................................................................................................223

Required Software............................................................................................................................................223

 Exporting to Microsoft Project from Project Management ...............................................................224

 Importing from Microsoft Project....................................................................................................................228

 Synchronizing Microsoft Project and Project Management .............................................................234

 Synchronization of Resources..........................................................................................................................236

 Impact of Microsoft Project Rules on Fields .............................................................................................238

Solutions for Project Managers .................................................................................................................239

Enabling/Disabling Fields ......................................................................................................................239

Priority Order...............................................................................................................................................240

Setting Up Projects ..................................................................................................................................240

Avoiding Potential Conflicts When Setting Up Your IT Governance Project.............241

 Conditional Editing Allowed In Project Management ...........................................................................241

Editing Project Management Controlled Projects ...........................................................................241

Editing Microsoft Project Controlled Projects ...................................................................................242

Workbench Interface ..............................................................................................................................242
viii Mercury Project Management™ User’s Guide



Table of Contents
Standard Interface....................................................................................................................................242

Project Management Controls Actuals..................................................................................................243

Conditional Editing Summary Table ........................................................................................................243

 Summary of Synchronization Behavior........................................................................................................245

 Integration with Other Mercury IT Governance Center Products..................................................246

Limitations on References ...........................................................................................................................246

Creating New Tasks while Adding a Reference ........................................................................246

Task Updated by Request/Request Updates Task..................................................................246

Task-Successor References................................................................................................................246

Allowed Types of References During a Synchronization.............................................................247

Microsoft Project control mode.........................................................................................................247

Shared control mode ..............................................................................................................................247

References Summary Table ........................................................................................................................247

 Available Reports.....................................................................................................................................................249

Microsoft Project Synchronization Report...........................................................................................249

Unsuccessful Resource Matches Report .............................................................................................251

Project Detail Report.......................................................................................................................................252

 Troubleshooting........................................................................................................................................................253

Resource Calendars ........................................................................................................................................254

Units .........................................................................................................................................................................254

Advanced Predecessors................................................................................................................................254

Advanced Constraints ....................................................................................................................................255

Calculation of Roll-up Values .....................................................................................................................255

Microsoft Project’s Manual Scheduling Mode ...................................................................................255

Scheduling Your Project in Microsoft Project....................................................................................255

Appendix A: Integrating Requests and Project Plans .......................................................... 257

 Overview of Integrating Requests and Project Plans .........................................................................  258

 Referencing Requests from Project Plans ...............................................................................................  258

 Creating Tasks from Requests .......................................................................................................................  259

 Dependencies Between Tasks and Requests ........................................................................................  261

Making Tasks Dependent on Requests.................................................................................................261

Task Waits on Request Closure (Successor Relationship).................................................262

Task Can’t Complete Until Request Closes (FF Predecessor)..........................................263

Task Auto-Updated by Request ........................................................................................................264

Making Requests Dependent on Tasks.................................................................................................264

Request Waits on Task Closure (Predecessor) ........................................................................265

 Visibility into Tasks and Requests ................................................................................................................  265

Requests Holding Up Progress..................................................................................................................265

Project References Section.........................................................................................................................266

Appendix B: Project Management Portlets.............................................................................. 267

 Projects Portlets .....................................................................................................................................................  268
ix



Table of Contents
Appendix C: Reports by Category ............................................................................................... 269

 Overview of Report Categories......................................................................................................................  270

 Administrative Reports .......................................................................................................................................  270

 Change Management Reports........................................................................................................................  273

 Demand Management Reports ......................................................................................................................  275

 Financial Management Reports .....................................................................................................................  276

 Portfolio Management Reports ......................................................................................................................  277

 Program Management Reports......................................................................................................................  277

 Project Management Reports .........................................................................................................................  278

 Resource Management Reports....................................................................................................................  280

 Time Management Reports..............................................................................................................................  282

Index ...................................................................................................................................................... 283
x Mercury Project Management™ User’s Guide



List of Figures

Figure 2-1 Master project .......................................................................................................................................... 26

Figure 2-2 Settings window - Exception Rules tab ...................................................................................... 30

Figure 2-3 Set project region in New Project window................................................................................ 40

Figure 2-4 MSP Synchronization tab ................................................................................................................... 46

Figure 2-5 Project Plan tab ....................................................................................................................................... 52

Figure 2-6 Predecessors tab of the Task Information window .............................................................. 60

Figure 2-7 Project Plan tab ....................................................................................................................................... 61

Figure 3-1 Resource icon .......................................................................................................................................... 88

Figure 3-2 Resource Finder icon ........................................................................................................................... 88

Figure 3-3 Sample project structure.................................................................................................................... 98

Figure 3-4 Sample notification with nested tokens ..................................................................................... 99

Figure 3-5 User data roll-up ...................................................................................................................................122

Figure 3-6 User data roll-up example ...............................................................................................................123

Figure 4-1 Project window with Project Plan tab ........................................................................................130

Figure 4-2 Directional arrow buttons.................................................................................................................130

Figure 4-3 Gantt chart with milestones............................................................................................................141

Figure 4-4 Project Milestones section ..............................................................................................................141

Figure 4-5 Project Overview Gantt section with milestones.................................................................142

Figure 4-6 Gantt chart with critical path..........................................................................................................142

Figure 4-7 Project Schedule Change report..................................................................................................148

Figure 4-8 Print Gantt Chart wizard ...................................................................................................................154

Figure 4-9 Export Gantt Chart wizard...............................................................................................................155

Figure 5-1 My Tasks portlet....................................................................................................................................162

Figure 5-2 Project Overview page ......................................................................................................................168
xi



List of Figures
Figure 5-3 Project Details page............................................................................................................................169

Figure 5-4 Project Summary section.................................................................................................................170

Figure 5-5 Project Hierarchy page......................................................................................................................171

Figure 5-6 Subprojects and Tasks Summary section ...............................................................................171

Figure 5-7 Project Exception Detail page .......................................................................................................172

Figure 5-8 Project Exception Summary section..........................................................................................172

Figure 5-9 Project References section.............................................................................................................173

Figure 5-10 Project Overview Gantt section....................................................................................................173

Figure 5-11 Project Overview Gantt section filter page - Display Options section.....................173

Figure 5-12 Project Milestones section ..............................................................................................................174

Figure 5-13 View Resource page for a manager with cost access .....................................................175

Figure 5-14 My Tasks portlet....................................................................................................................................178

Figure 5-15 Task Detail page References section ........................................................................................186

Figure 5-16 Project References section.............................................................................................................187

Figure 5-17 Task Detail page References section ........................................................................................187

Figure 5-18 Project Custom Detail report creation page..........................................................................189

Figure 6-1 Project Template window.................................................................................................................193

Figure 6-2 Custom Fields for Project Template Layout tab ..................................................................200

Figure 7-1 Microsoft Project Synchronization report ...............................................................................249

Figure 7-2 Unsuccessful Resource Matches report ..................................................................................251

Figure 7-3 Project Detail report............................................................................................................................253

Figure A-1 Project Information window - References tab ......................................................................259

Figure A-2 Task Information window - References tab and References section.......................262

Figure A-3 Example process for FF Predecessor relationship .............................................................264

Figure A-4 References section for requests ..................................................................................................265

Figure A-5 Request portlet filter page Preventing Action On field ....................................................266

Figure A-6 Project References section.............................................................................................................266
xii Mercury Project Management™ User’s Guide



List of Tables

Table 2-1 Exception rules for master projects ............................................................................................. 30

Table 2-2 Default values for triggering color change in summary condition ............................... 33

Table 2-3 Default values for triggering color change in cost health indicator ............................ 34

Table 2-4 Keyboard shortcuts in the Project Plan tab ............................................................................. 54

Table 2-5 Possible predecessor relationships to a project or task ................................................... 60

Table 2-6 Scheduling errors, causes, and possible solutions............................................................... 71

Table 2-7 Scheduling warnings, causes, and possible solutions......................................................... 72

Table 3-1 Task state definitions............................................................................................................................ 82

Table 3-2 Smart URL tokens .................................................................................................................................. 95

Table 3-3 Dependency relationships ...............................................................................................................113

Table 4-1 Project plan states and descriptions..........................................................................................131

Table 4-2 Task attributes editable from the Update Tasks page......................................................135

Table 6-1 Field window Attributes tab fields................................................................................................195

Table 6-2 Field window Defaults tab fields...................................................................................................196

Table 6-3 Field window Dependencies tab fields......................................................................................196

Table 6-4 Items copied or created during the project plan to project template conversion ....

208

Table 7-1 Conditional editing allowed in Project Management.........................................................243

Table 7-2 Allowed references during synchronization ...........................................................................248

Table 7-3 Microsoft Project Synchronization report parameters .....................................................250

Table 7-4 Unsuccessful Resource Matches report parameters........................................................251

Table A-1 Dependency relationships - requests to tasks .....................................................................261

Table B-1 Projects portlets ....................................................................................................................................268
xiii



List of Tables
Table C-1 Administrative reports........................................................................................................................270

Table C-2 Change Management reports ........................................................................................................273

Table C-3 Demand Management reports ......................................................................................................275

Table C-4 Financial Management reports......................................................................................................276

Table C-5 Project Management reports .........................................................................................................278

Table C-6 Resource Management reports ....................................................................................................280

Table C-7 Time Management reports ..............................................................................................................282
xiv Mercury Project Management™ User’s Guide



Chapter

1

Introduction

In This Chapter:

� About This Document
� Who Should Read This Document
� Related Documents
� Overview of Mercury Project Management
15



 Chapter 1: Introduction
About This Document

This guide describes how to navigate and use Mercury Project Management™. 
Each chapter covers a specific topic on navigation or usage:

� Chapter 1, Introduction, on page 15

Includes an overview of Mercury Project Management and details the 
document’s intended audience and related guides.

� Chapter 2, Setting Up a Project Plan, on page 21

Describes how to create a project plan and set up its tasks, scheduling, and 
baselines.

� Chapter 3, Configuring Tasks, on page 79

Explains how to configure tasks within a project plan, including assigning 
resources, setting up notifications, and creating Milestones.

� Chapter 4, Managing a Project Plan, on page 125

Discusses how to manage a project plan from creation to completion, 
including viewing task progress, updating the schedule, and printing the 
Gantt chart.

� Chapter 5, Updating Tasks: Project Plan Participant Activities, 
on page 157

Describes how participants in project plans can locate and update tasks, 
including viewing and updating notes and references.

� Chapter 6, Using Project Templates, on page 191

Discusses the creation and use of project templates to speed project plan 
creation.

� Chapter 7, Integrating Project Management with Microsoft Project, 
on page 215

Discusses how to use Project Management in conjunction with Microsoft 
Project to various degrees, depending on the level of integration desired.

� Appendix A: Integrating Requests and Project Plans on page 257

Explains how to use Project Management in conjunction with Mercury 
Demand Management™ to leverage the capabilities of both systems.
16 Mercury Project Management™ User’s Guide



 Chapter 1: Introduction
� Appendix B: Project Management Portlets on page 267

Lists the portlets delivered as part of Project Management.

� Appendix C: Reports by Category on page 269

Lists the reports delivered as part of Mercury IT Governance Center™.

Who Should Read This Document

The intended audience for this document includes all end-users of Project 
Management:

� Project leaders or managers who create and manage project plans and tasks

� Project leaders or managers who create and manage calendars

� Business users responsible for reporting on project plans and tasks

Related Documents

Related documents for this book are:

� General category:

� Guide to Documentation

� Key Concepts

� Getting Started

� Related product areas:

� Mercury Demand Management User’s Guide

� Mercury Change Management User’s Guide

� Mercury Resource Management User’s Guide

� Mercury Time Management User’s Guide

� Mercury Time Management Configuration Guide
Who Should Read This Document 17



 Chapter 1: Introduction
� Security Model Guide and Reference

Overview of Mercury Project Management

Mercury Project Management enables organizations to streamline and 
standardize the management of project activities using a template-based, 
collaborative approach. Project plans are defined as a hierarchical structure of 
projects and subprojects that logically group and organize tasks or activities. 
Project Management defines the step-by-step processes required to complete 
specific tasks and deliverables. Organizations can easily manage project plan 
activities within and across the technology chain because all project team 
members, whether internal or external, collaborate and interact through an 
intuitive interface. The underlying product framework guides users through a 
dynamic, self-documenting process to support activities such as the execution 
of standardized checklists or the collection of deliverables using document 
attachments.

For example, when creating a new and updated version of a business system, a 
company could classify its efforts into subprojects for each major functional 
area.

� Each of these functional subprojects could be further broken down into 
tasks directed to areas such as web content, application and database tasks.

� These tasks can be linked to requests and packages from Mercury Demand 
Management and Mercury Change Management™, giving instant visibility 
to more detailed activities supporting an overall project plan.

� In conjunction with Mercury Resource Management™, task and skill 
assignments can be tracked against resource availability. Resource 
utilization can also be measured, visualized, and optimized.

� Baselines of the project plan and relevant fields can be taken at any time, 
giving a basis for project plan performance comparisons.

To make use of their full range of features, resources and resource-related 
configurations should be set up in Resource Management prior to using Project 
Management. For more detailed information, see Before Starting on page 22 or the 
Mercury Resource Management User’s Guide.
18 Mercury Project Management™ User’s Guide



 Chapter 1: Introduction
� Project plan cost data is also tracked on the task level, which can be fed 
into a project plan budget and analyzed for trends and patterns. Project plan 
spending can also be monitored.

� Project Management also supports standard integration with Microsoft 
Project so that functions such as task scheduling and resource management 
can be utilized at any point during a project plan’s execution.
Overview of Mercury Project Management 19



 Chapter 1: Introduction
20 Mercury Project Management™ User’s Guide



Chapter

2

Setting Up a Project Plan

In This Chapter:

� Overview of Setting Up a Project Plan
� Before Starting
� Creating a Project
� Setting Up a Master Project

� Creating the Master Project Entity
� Selecting Information to Track and Display
� Setting Up Exception Behavior
� Setting Up Indicators
� Setting Scheduling Options
� Setting Security Restrictions
� Setting Up the Project Team
� Setting Up Microsoft Project Integration
� Importing Custom Fields from a Project Template

� Adding Tasks to a Project
� Adding Tasks to the Project Plan Tab
� Adding Tasks Using Project Templates
� Setting Up Project Hierarchy
� Attaching Additional Information to a Project or Task
� Creating a Task From a Request
� Adding Milestones

� Setting Up Project Dependencies
� Setting Internal Predecessors
� Setting an External Predecessor Task
� Setting an External Predecessor Project
� Setting an External Predecessor Request
21



 Chapter 2: Setting Up a Project Plan
� Creating a Master Project Schedule
� Generating the Schedule
� Scheduling Errors
� Scheduling Warnings

� Establishing a Project Baseline
� Selecting Baseline Fields
� Taking a Baseline
� Managing Baselines
� Comparing Baselines

Overview of Setting Up a Project Plan

This chapter describes the process of creating a project plan. Project plans 
allow organizations to define business initiatives as a hierarchical structure of 
tasks and subprojects that logically groups and organizes activities and 
deliverables. Using project plans, users can define, browse, edit, and manage 
complex business initiatives. 

Before Starting

Resources in Mercury Project Management can be tracked to optimize their 
time and capabilities with Mercury IT Governance Center’s Resource 
Management functionality. Together with Mercury Resource Management, a 
project manager can:

� Configure a regional calendar and set the following:

� Number of hours in a working day

� Working days for each week

Many project plan activities are performed in the Workbench interface. If you have 
installed a pop-up blocker in your Web browser, the Workbench will not open unless 
you disable pop-up blocking behavior for your Mercury IT Governance Center Web 
site.
22 Mercury Project Management™ User’s Guide



 Chapter 2: Setting Up a Project Plan
� Holidays

Project plans can then be associated with a region for accurate project and 
resource scheduling

� Set a calendar for each resource, determining total availability as well as 
specifying vacation days

� Assign a primary skill and cost rate to a resource

� View resource load by time period, project plan, or individual

� Compare project plan assignments to staffing profiles

For a project manager to take full advantage of these features, resource and 
calendar information should be set up in Mercury Resource Management 
before creating a project in Mercury Project Management. See the Mercury 
Resource Management User’s Guide for detailed information on how to 
perform these tasks.

The following useful tasks can also be performed using Mercury Resource 
Management:

� Mapping of resources into an organization model and tying organization 
units to security groups

� Tracking the future supply of resources using resource pools

� Projecting the allocation of resources over time using staffing profiles

See the Mercury Resource Management User’s Guide for additional details.

Creating a Project

Master projects (or project plans) handle, link, and reference all of the 
variables vital to planning a successful endeavor. Master projects consist of 
different subsets of information — tasks, subprojects, action items, cost data, 
notes, packages, requests, and references — that can be linked to each other. In 
addition, the master project maintains global settings and configurations that 
are tracked throughout an initiative’s life cycle.
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There are three main stages in the creation of a project plan:

� Stage One - Setting up a Master Project

� Stage Two - Adding Tasks to a Project Plan

� Stage Three - Creating a Master Project Schedule

Stage One: Setting Up a Master Project

The master project is the overarching entity that keeps track of a particular 
initiative. The master project can be configured to display useful data about the 
project plan as it moves toward completion. Project templates can also be used 
to define an entire master project, and can be subsequently modified.

� Creating the Master Project Entity
Using the Workbench, you will create a master project. When enabled, this 
project plan will be visible to other users through the Mercury IT 
Governance Dashboard.

� Selecting Information to Track and Display
The master project contains configurable fields that collect information 
which will be tracked as the project plan progresses. These fields, which 
include % Complete and Confidence, provide a constant point of reference 
for project managers and participants throughout an initiative’s life cycle.

� Setting Up Exception Behavior
During the course of a project plan’s life, some things can go wrong — 
resources can be missing, tasks can be completed late or not at all, the 
project plan can go over budget, etc. The master project contains exception 
rules that can be configured to deliver advance warning of these 
circumstances or to signal when they have occurred.

For example: A particular task currently has no resource assigned to it, and 
it is scheduled to begin in two days. The master project can flag this 
exception for review.

� Setting Up Indicators
The master project also features configurable project plan indicators. 
Indicators can display exceptions that have occurred, project plans with 
custom fields, tasks or project plans that might require rescheduling, tasks 

A master project can also be configured to track information related to SOP 98-1 
compliance. See the Mercury Financial Management User’s Guide for more detailed 
information.
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with defined notifications, and any scheduling constraints that apply to a 
task.

� Setting Scheduling Options
The master project can be set to schedule its project plan based on different 
configurations for resource availability and actual start and finish dates.

For example: Andrew, Jered, and Dave are the assigned resources for a 
project plan, but Jered is going on vacation for a week, and all three people 
need to be present for the initiative to move forward. The project plan can 
be set not to include Jered’s vacation time as viable for scheduling.

� Setting Security Restrictions
Project managers can set Security Restrictions on a project plan so that 
only those directly involved in a project plan can view its information.

Stage Two: Adding Tasks to a Project

Projects consist largely of tasks and subprojects. Tasks and groups of tasks 
(using templates) can be added freely to any project plan. Below are some 
common procedures used when you add and modify tasks:

� Adding Tasks to the Project Plan Tab

� Adding Tasks Using Project Templates

� Setting Up Project Hierarchy

� Attaching Additional Information to a Project or Task

Stage Three: Creating a Master Project Schedule

Once the tasks have been added and the scheduling options have been set, the 
project plan can be scheduled. Project Management will calculate scheduled 
start and finish dates automatically, and inform the user of any errors it 
encounters in the process.
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Setting Up a Master Project

The master project is the entity in Project Management that keeps track of a 
business initiative. It can be configured to display useful data about a given 
project plan as it moves toward completion.

Figure 2-1. Master project

Creating the Master Project Entity

To create a master project:

1. Log on to Mercury IT Governance Center and open the Workbench.

2. From the shortcut bar, select Project Mgmt > Projects. 

The Project Workbench window opens. 

3. Click New Project.

The New Project window opens.

When a user creates or edits a project or subproject, that user is the only one able to 
save changes. All other users will be warned of this before attempting to edit that 
project or subproject at the same time.

In the case of two users wanting to edit two different subprojects under one master 
project, opening and editing only the desired subprojects from the Project Workbench 
will enable each user to save changes without interfering with each other.

Two users can even edit separate tasks in the same project plan without risk.
26 Mercury Project Management™ User’s Guide



 Chapter 2: Setting Up a Project Plan
4. In Master Project Name, enter the name of the project plan.

You can optionally select to use a project template to define the structure 
and custom fields for the new project plan. For more detailed information 
on project templates, see Using Project Templates on page 191.

5. Click OK.

The Project window opens.

6. Add tasks according to the project plan schedule.

See Adding Tasks to a Project on page 50 for more details. You need to 
add at least one task to the project plan in order to save the master project.

7. Click Save.

You can now set up your project plan. This includes setting up master 
project options and adding and configuring tasks to the project plan. 

To copy a project plan to create a new master project:

1. Open the Project Workbench window.

2. Query for the project plan that you would like to copy.

3. In the Results tab, select the project plan.

4. Click Copy.

The Copy Project window opens. 
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5. In the Project Name field, enter the new name of the project plan.

6. Select the information that you would like to copy from the original project 
plan by clicking the associated checkboxes. 

7. Click Copy.

Selecting Information to Track and Display

The master project allows project managers to choose information they would 
like to track over the course of the project plan. Fields selected in this window 
become enabled for all project plan participants.

To select information to track and display:

1. From the menu at the top of the Workbench, select Project > Settings.

The Settings window opens.

2. Click the Project Fields tab.

3. For each field, select the appropriate checkbox.

� Selecting the checkbox in the Enabled column makes the field active for 
the project plan and available in the Update Tasks page in the standard 
interface
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� Selecting the checkbox in the Manager Use Only column enables the 
field for the project plan, but not in the standard interface

If you do not want the field displayed in either location, do not select a 
checkbox for that field.

4. Apply the changes.

To apply changes to the project plan and continue to set desired 
information without closing the window, click Apply. To apply changes to 
the project plan and close the window, click OK.

Setting Up Exception Behavior

The master project comes with a set of predefined exception rules. A project 
manager can specify which exception rule(s) are to be enabled, as well as the 
criteria needed to trigger them. A project manager can also configure the 
summary condition, which is a simple color-coded indicator of the health of a 
project plan. The summary condition watches for exceptions that have been 
triggered, and changes color according to rules that can be set by the manager. 
The health of the project plan in terms of its cost can also be represented with 
the configurable cost health indicator.

For example: For a project plan with a very low margin for error, you can set 
the percentage of triggered exceptions needed to change the summary 
condition red to 20, giving clear early warning of problems.

A project plan whose cost needs watching can be configured such that its cost 
health indicator takes into account violations of the planned budget.
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Figure 2-2. Settings window - Exception Rules tab

By default, Unassigned Tasks, Late Tasks, and Tasks Starting Late are enabled 
and included in the project summary condition.

Setting Exception Rule Behavior

The master project includes the exception rules described in Table 2-1:

Table 2-1. Exception rules for master projects

Exception Rule Description

Unassigned 
Tasks

Task has no resource assigned and Scheduled Start Date 
occurs in X days, where X is a user-configurable number.

Late Tasks
Task is not yet “Complete,” and the Current Day is X days past 
the Scheduled Finish Date.

Tasks Starting 
Late

Task is not yet “In Progress,” and the current date is X days past 
the Scheduled Start Date.

Late Estimated 
Finish

Estimated Finish Date is more than X days past the Scheduled 
Finish Date.

Not Enough 
Time Left

Estimated Remaining Duration exceeds the time left between 
the current date and the Scheduled Finish Date by X days.
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The following parameters for all exception rules are configurable:

� Enabled
Project managers can decide whether or not the particular exception rule is 
enabled.

� Rule (number of days)
Specifies the number of days the particular exception rule waits for or 
monitors.

� Include in Summary Condition
Decides whether or not the violations of the particular exception rule are 
included in Project Management’s summary condition (see Summary 
Condition on page 33).

Each exception rule within the Exception Rules tab can be configured 
independently.

To set exception rule behavior:

1. From the menu at the top of the Workbench, select Project > Settings.

The Settings window opens.

2. Click the Exception Rules tab.

Predecessor 
Has Exception

Task directly preceding a milestone has triggered one of the 
above exceptions.

Critical Path 
Running Late

Task preceding a milestone on the project plan critical path has 
triggered one of the above exceptions.

Table 2-1. Exception rules for master projects [continued]

Exception Rule Description
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3. To enable a particular exception rule, select the checkbox to its left in the 
Enabled column.

4. To set the number of days that trigger a particular exception rule, enter the 
desired number into the text field inside that Rule.

5. To include a particular exception rule in a project’s summary condition 
View, select the checkbox to its right in the Include in Summary Condition 
column.

6. Apply the changes.

To apply changes to the project plan and continue to set exception rule 
behavior without closing the window, click Apply. To apply changes to the 
project plan and close the window, click OK.

Some exception rules require that certain fields in the Project Fields tab be enabled 
in order to trigger. For example, the Not Enough Time Left rule requires Estimated 
Remaining Duration to be enabled. See Selecting Information to Track and Display 
on page 28 for more information on enabling fields in the Project Fields tab.
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Summary Condition

The summary condition is a graphical indicator of the health of a project plan, 
located next to the project plan name. A project’s summary condition color 
begins green and changes to yellow or red depending on the percentage of 
tasks within a project plan that have triggered exceptions. This percentage is 
configurable in this tab, by any project manager. A project’s summary 
condition will not be calculated until the project plan is saved.

For example: A project manager sets the threshold value for yellow to 30%. 
Four tasks trigger an exception in a project plan consisting of ten tasks total. 
The summary condition view indicator turns yellow, and will remain yellow 
until at least two tasks are reworked until they no longer trigger exceptions 
(this could be accomplished by changing a start date, or modifying resources). 
Once this occurs, the summary condition indicator turns green.

To set the values for triggering color changes in the summary condition:

1. From the menu at the top of the Workbench, select Project > Settings.

The Settings window opens.

2. Click the Exception Rules tab.

3. Enter the desired triggering value into each text field.

Do not include the percent sign (%).

4. Apply the changes.

To apply changes to the project plan and continue to set exceptions without 
closing the window, click Apply. To apply changes to the project plan and 
close the window, click OK.

Table 2-2. Default values for triggering color change in summary condition 

Green 0%

Yellow 30%

Red 60%
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Cost Health Indicator

The Cost Summary is part of Mercury Financial Management, and can be 
enabled or disabled on a per-project-plan basis. It appears on the Project 
window’s Cost tab, and as an indicator on the Project Plan tab if enabled in the 
Settings window’s Indicators tab. It is used to indicate the health of a project 
plan in terms of its cost. Project cost health is calculated in the following areas:

� Cost Performance Index (CPI)
The cost efficiency ratio of the project plan’s Earned Value (Baseline Costs 
* % Complete) to Actual Costs. 
Calculated as Earned Value / Actual Cost. CPI for a healthy project plan 
should be at least 1.

� Schedule Performance Index (SPI)
The difference in value between the scheduled completion of a task/project 
plan and its actual completion.
Calculated as Earned Value / Planned Value. SPI for a healthy project plan 
should be at least 1.

� Prorated Budget
A comparison of project costs to date with the portion of the budget 
planned to have been spent to date.

Any one of these factors can be enabled or disabled when calculating project 
plan cost health.

For example: A project manager doesn’t care about CPI or SPI, but wants to 
know when his project plan exceeds its prorated budget by 2%. Exceeding the 
budget by 5% is the upper limit of tolerance.

He deselects the boxes Include CPI Violation in the Cost Indicator and Include SPI 
Violation in the Cost Indicator.

He configures the indicator to turn yellow if Actual Costs Exceed Prorated 
Budget by 2%, and red if Actual Costs Exceed Prorated Budget by 5%.

Table 2-3. Default values for triggering color change in cost health indicator

Color CPI SPI Actual Costs > Prorated Budget By

Green > 1 > 1 < 5%

Yellow < 1 < 1 > 5%

Red < 0.7 < 0.7 > 10%
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Setting Up Indicators

Project Management provides project plan indicators to give users a better at-
a-glance overview of their project plans in progress. The following indicators 
can be configured to be displayed at the master project level. Indicators appear 
in the Project Plan tab to the left of subproject and task names, where 
appropriate.

� Constraint
Displays for tasks with scheduling constraints.

� Custom Fields
Displays for project plans that have custom fields defined.

� Exception
Displays for tasks that have triggered exceptions, and also displays the 
summary condition for project plans.

� Notification
Displays for tasks that have notifications defined.

� Scheduling
Displays for updated tasks or project plans that might require rescheduling.

� Cost Health
Displays for project plans that have Financial Management enabled.

To set indicators to be displayed:

1. From the menu at the top of the Workbench, select Project > Settings.

The Settings window opens.

2. Click the Indicators tab.
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3. To display a particular indicator, select the checkbox to its left in the 
Displayed column.

The exception indicator is displayed by default.

4. Apply the changes.

To apply changes to the project plan and continue to set exceptions without 
closing the window, click Apply. To apply changes to the project plan and 
close the window, click OK.

Setting Scheduling Options

Project managers can set different scheduling options, depending on the 
project plan’s level of resource dependency. Project Management’s Scheduling 
Options also allow for the creation of schedules based on actual start and finish 
dates. The default configuration is set to not use actual dates.
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Setting a Default Date From Which to Schedule

Project managers can set a default date for Project Management to start 
scheduling from. This is useful for setting a hard date from which to begin an 
initiative, no matter what occurs during the planning process.

To set a default date from which to schedule the project plan:

1. From the menu at the top of the Workbench, select Project > Settings.

The Settings window opens.

2. Click the Scheduling tab.

3. Select the Progressive scheduling option.

4. Select the desired date from the Default Date from which to Schedule field.

5. Apply the changes.

To apply changes to the project plan and continue to set Scheduling 
Options without closing the window, click Apply. To apply changes to the 
project plan and close the window, click OK.
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Setting Scheduling With or Without Actual Start/Finish Dates

A project manager can choose to determine a project plan’s schedule using 
actual start/finish dates. This is the default scheduling mode.

To determine whether scheduling is based on actual dates or not:

1. From the menu at the top of the Workbench, select Project > Settings.

The Settings window opens.

2. Click the Scheduling tab.

3. Set one of the two scheduling date options:

� To schedule your project plan using actual start/finish dates, select 
Standard. This is the default setting.

� To schedule your project plan without using actual start/finish dates, 
select Progressive.

Once a project plan becomes Active, its tasks can be marked In Progress. When 
tasks are marked In Progress, actual start dates are specified for that task. If the 
master project is set to use actual start/finish dates in scheduling, it will use these 
dates to determine the schedule.
38 Mercury Project Management™ User’s Guide



 Chapter 2: Setting Up a Project Plan
4. Apply the changes.

To apply changes to the project plan and continue to set scheduling options 
without closing the window, click Apply. To apply changes to the project 
plan and close the window, click OK.

Setting Scheduling Options for Resource Dependency

Every business initiative has some minimum resource requirements, usually in 
the form of available personnel. The master project can be set to consider 
resource requirements when creating its schedule. For instance, it is possible to 
set the master project to ignore resource availability and schedule accordingly. 
The default configuration is set to require all resources to be available on any 
given day. When creating the master project’s schedule, Project Management 
will only consider days when all resources are present.

To set the minimum resource requirements for the master project schedule:

1. From the menu at the top of the Workbench, select Project > Settings.

The Settings window opens.

2. Click the Scheduling tab.

3. To specify the minimum resource requirement necessary for a day to be 
considered available, select the condition desired.
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4. Apply the changes.

To apply changes to the project plan and continue to set scheduling options 
without closing the window, click Apply. To apply changes to the project 
plan and close the window, click OK.

Setting the Region

Not all companies have the same work week or length of working day. Project 
Management allows you to schedule a project plan based on a particular 
regional calendar. This is set by choosing the region the project plan uses when 
you first create the project.

Figure 2-3. Set project region in New Project window

Only one condition can be selected at a time.

Only one region can be selected.
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Setting Security Restrictions

Project managers can set security restrictions on a master project such that only 
those who are involved in the project plan can view it. Someone who is not a 
manager or participant in a project plan will not be able to open or edit it. 
Additionally, the project plan will not appear in any searches run by a non-
participant or non-manager, both from the Project Workbench and Project 
Search page. Project Management defines project plan participants as users 
who are involved in project plans, but lack the administrative responsibilities 
of a project manager. For more information on project plan participants, see 
Updating Tasks: Project Plan Participant Activities on page 157.

Setting Security for the Master Project

To set security restrictions for a master project:

1. From the menu at the top of the Workbench, select Project > Settings.

The Settings window opens.

2. Click the Security tab. 

3. Select the restriction type desired from the This Project and its Tasks can be 
viewed by section.

� To allow any user to view and search for the project plan, select All 
Users.
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� To restrict project plan visibility to only those involved in the project 
plan, select Participant Restricted.

4. Apply the changes.

To apply changes to the project plan and continue to set other options in the 
Settings window, click Apply. To apply changes to the project plan and 
close the window, click OK.

Setting Security for Cost Data

To set security restrictions for a master project’s Cost data:

1. From the menu at the top of the Workbench, select Project > Settings.

The Settings window opens.

2. Click the Security tab. 

3. Select the restriction type desired from the Cost information on the Project 
and its Tasks can be viewed by section.

� To allow any user to view Cost data for the project plan, select All 
Users.

� To restrict Cost data visibility solely to master project and its project 
managers, select Project Managers for this Master Project only.
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� To restrict Cost data visibility to the master project, and its subprojects’ 
project managers, select Project Managers for Master Project <Project 
Name> and all of its subprojects.

� To restrict Cost data visibility to only those involved in the project 
plan, select Participants for only the Tasks and Projects for which they 
are Participants.

� To restrict Cost data visibility to only those specified in the Settings 
window’s Project Team tab, select Project Team only.

4. Apply the changes.

To apply changes to the project plan and continue to set other options in the 
Settings window, click Apply. To apply changes to the project plan and 
close the window, click OK.

Setting Up the Project Team

Project managers can specify who will be allowed to act as resources for a 
project plan. Resources can be users and groups of users. In the Project Team 
tab, the project manager can choose

� Allow all users with the Project option enabled in their security groups to 
be resources for a project plan.

� Only allow those resources who are specified in the Project Team tab to be 
used as resources for a project plan. These resources are listed in the tab’s 
resource table.

To set up the project team for a master project:

1. From the menu at the top of the Workbench, select Project > Settings.

The Settings window opens.

2. Click the Project Team tab. 

Exception: Users with the SysAdmin: Override Key Fields Segmentation access 
grant can add any users as a resource to the project plan. 
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3. To allow all resources with the Project option enabled in their security 
groups to be used as resources for a project plan, click the appropriate 
checkbox.

Skip the steps shown below and go to the last step of this procedure.

4. To specify resources for a project plan, deselect the appropriate checkbox.

5. Click Add.

The Resource: New window opens.

6. Select a resource or group of resources from the Resource auto-complete 
list.

The name of the selected resource appears in the required Resource field of 
the Resource: New window.
44 Mercury Project Management™ User’s Guide



 Chapter 2: Setting Up a Project Plan
7. Add the resource. 

Click Add to add the current resource and continue adding more resources. 
Click OK to add the current resource and close the Resource: New window.

8. Save the selections.

Click OK to save the selections and close the window. Click Save to save 
the selections and leave the window open.

Deleting Resources from a Project Team

To delete a specified resource from a project team:

1. From the Project Team tab, select the resource in the tab’s Resource table.

2. Click Remove.

The resource is removed from the Resource table.

3. Save the action.

Click OK to save the action and close the window. Click Save to save the 
action and leave the window open.
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Setting Up Microsoft Project Integration

The Project Management - Microsoft Project interface allows project managers 
to synchronize project information in a project plan with the project 
information in a Microsoft Project file. Information can also be imported from 
Microsoft Project to Project Management and exported from Project 
Management to Microsoft Project.

Project Management has three different synchronization modes that a project 
manager can choose from. The various synchronization modes let the project 
manager use different strategies for importing/exporting information between 
Project Management and Microsoft Project. See Control Mode on page 47 for 
more information about synchronization modes.

Before exporting or synchronization, the project manager must select a 
synchronization mode from the MSP Synchronization tab in the Settings 
window. The MSP Synchronization tab is shown in Figure 2-4.

Figure 2-4. MSP Synchronization tab

The MSP Synchronization tab is available only for project plans, but not for project 
templates.
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Microsoft Project File Information

The Microsoft Project File Information section displays the path and filename 
information of the Microsoft Project file associated with a Project 
Management project plan. The Microsoft Project file can be stored on a local 
machine or a local network.

Activity History 

The Activity History section displays information about the last synchronization, 
export or import that took place for this project plan.

Control Mode

The Control Mode section lets the project manager select a synchronization 
mode. The available options are:

� Mercury Project Management-controlled
The project manager creates a project plan in Project Management to 
perform planning and tracking activities, such as scheduling tasks and 
tracking actuals. After exporting, the Microsoft Project file is used for 
reports and distribution. (This is the default value for new project plans 
created in Project Management.)

� Microsoft Project-controlled 
The project manager creates a project in Microsoft Project and 
synchronizes it in the Workbench. For all subsequent synchronizations, 
information in Project Management is updated with current information 
from Microsoft Project.

� Mercury Project Management controls actuals
The project manager plans and schedules the project in Microsoft Project 
while using Project Management to track actuals. Each subsequent 
synchronization updates the Microsoft Project file with actuals data from 
Project Management. The Mercury IT Governance Project is updated with 
changes to the project structure or schedule in Microsoft Project.

When importing information from Microsoft Project to Project Management, the MSP 
Synchronization tab is not available because the Mercury IT Governance project 
plan file has not been created yet. The Import Wizard performs the same functions as 
the MSP Synchronization tab sections described below.
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Resource Identification

The Resource Identification section lets the project manager choose how missing 
resources created during an export or synchronization will be named in the 
Microsoft Project file. (This section is only enabled when the Control Mode is 
set to Mercury Project Management-controlled.) Select one of the following 
options:

� Mercury username
The username is used as the name of the new Microsoft Project resource 
created during synchronization. 

� Full Name 
The Full Name is used as the name of the new Microsoft Project resource 
created during synchronization.

After selecting the Control Mode and Resource Identification options, click OK 
to save your selections.

Importing Custom Fields from a Project Template

Project templates are used in Project Management to create repeatable 
processes to be used in project plans. They can be used as a model and serve as 
a basis for master projects or subprojects. Project templates can also contain 
custom fields that can capture information not normally covered by standard 
project plan and task fields. These custom fields are unique to their project 
template.

Custom fields can be associated with an existing project plan without 
importing the project template they come from. This allows you to capture 
whatever information is needed without having to simultaneously import a 
superfluous set of project plans or tasks. Custom fields appear in the Project or 
Task Information window on their own tab.

To associate custom fields from a project template with your own project plan:

1. Open the project plan.

2. In the Project Plan tab, double-click the project plan name or select it and 
click Edit.

The Project Information window opens.
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3. Select the project template containing the desired custom fields from the 
Custom Fields Defined In auto-complete list.

4. Save the changes in the Project Information window. 

Click Apply to save changes and continue working in the Project Information 
window. Click OK to save changes and close the Project Information 
window. Click Cancel to close the Project Information window without 
saving any changes.

5. Save the changes to the project plan.

Click Save to save changes and continue working on the project plan. Click 
OK to save changes and close the project plan. Click Cancel to close the 
project plan without saving any changes.
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Adding Tasks to a Project

Once the master project has been configured, you can add tasks to the project 
plan and specify task details, including assigning resources or resource groups. 
Tasks can be added individually or in a pre-sequenced group with a project 
template. Tasks can also be organized in a hierarchical fashion quickly and 
easily.

Adding Tasks to the Project Plan Tab

To add a task to the Project Plan tab:

1. Within the Project window, click Add Task.

A new task appears in the Project Plan tab below the current selection.

You can also add a new task by selecting the last item in the Project Plan tab 
and pressing Insert or the down arrow on your keyboard.

2. Edit the new task’s information.

� Tasks can be edited directly inside the Project Plan tab. Click on a field 
to edit its contents.

� Tasks can also be edited through the Task Information window, which 
displays more detailed information on a task.

i. Double-click on the new task. The Task Information window opens.
50 Mercury Project Management™ User’s Guide



 Chapter 2: Setting Up a Project Plan
ii. Modify the information under each tab in the Task Information 
window as necessary (for details, see Editing Task Information 
on page 87).

3. Apply the changes.

To apply changes to the project plan without closing the window, click 
Apply. To apply changes to the project plan and close the window, click 
OK. You can also copy and paste tasks using Ctrl+c and Ctrl+v. Multiple 
tasks can be copied by holding down the Shift key and selecting with the 
mouse.

Adding Tasks Using Project Templates

Pre-defined bundles of tasks can be added with the use of project templates. 
The template will be copied into the working Project Plan tab as a subproject, 
along with its default values for Scheduled Effort, Scheduled Duration, and 
notifications.

To add a set of tasks using a project template:

1. Within the Project window, select Project Created From Template from the 
Add Task drop-down list.
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2. Click Add.

The Add Project Template window opens.

3. Select a Project Template from the auto-complete list.

4. Click OK.

The Add Project Template window closes. The selected template is added to 
the project plan as a collapsed subproject.

5. Modify the information for any task inside the subproject by either editing 
it directly in the Project Plan tab, or double-clicking on the task and editing 
fields.

See Adding Tasks to the Project Plan Tab for more detailed information.

Setting Up Project Hierarchy

Project Management allows users to add tasks and subprojects (from 
templates) in any order. Once the tasks have been added, Project Management 
users can also arrange and group them in a hierarchy.

Figure 2-5. Project Plan tab 

Project templates can be modified to contain custom fields. See Creating Custom 
Fields for Project Templates on page 193 for more detailed information.
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To move an item up in the hierarchy:

1. In the Project Plan tab, select the task or collapsed subproject.

2. Click the Up Arrow button or press Ctrl+up arrow on your keyboard.

The selected task or subproject moves up in the list.

� If the selected item is not at the same level as the item it is switched 
with, it is indented or out-dented to match the level of the item it is 
switched with.

� If the switch results in a subproject with no immediate children, that 
subproject is converted to a task after it moves.

To move an item down in the hierarchy:

1. In the Project Plan tab, select the task or collapsed subproject.

2. Click the Down Arrow button or press Ctrl+down arrow on your keyboard.

The selected task or subproject moves down in the list.

� If the item immediately above the selected item is an expanded 
subproject, the selected item becomes its child.

� If the item immediately above the selected item is a collapsed 
subproject or task, the selected item is indented or outdented to match 
the subproject or task’s level.

� If the selected item was the only child of a subproject, that subproject is 
converted to a task after the selected item moves.

To indent an item:

1. In the Project Plan tab, select the task or collapsed subproject.

2. Click the Right Arrow button or press Ctrl+right arrow on your keyboard.

The selected task or subproject moves one level deeper in the hierarchy.

� If the item immediately above the selected item is a task, that task is 
converted to a subproject.
Adding Tasks to a Project 53



 Chapter 2: Setting Up a Project Plan
To outdent an item:

1. In the Project Plan tab, select the task or collapsed subproject.

2. Click the Left Arrow button or press Ctrl+left arrow on your keyboard.

The selected task or subproject moves out one level in the hierarchy.

� If the selected item was a child of a subproject, it becomes either a task 
or subproject on the same level as its former parent.

� If the selected item was a subproject’s only child, that subproject is 
converted to a task.

� If the selected item was a task with other tasks of the same level 
beneath it, those tasks are converted to children of the selected item, 
which is now a subproject.

Useful Keyboard Shortcuts in the Project Plan Tab

Tasks and subprojects within the Project Plan tab can be manipulated from the 
keyboard as well as the buttons in the Project window. Table 2-4 lists all 
available keyboard shortcuts.

If the selected item is the first child of a subproject, you will not be able to indent it.

Table 2-4. Keyboard shortcuts in the Project Plan tab

Keystroke Action

Insert Inserts a task into the hierarchy above the current row.

Delete Deletes the selected task from the project plan.

Ctrl+Up Arrow Moves a task up in the hierarchy.

Ctrl+Down Arrow Moves a task down in the hierarchy.

Ctrl+Left Arrow Outdents a task in the hierarchy.

Ctrl+Right Arrow Indents a task in the hierarchy.

Down Arrow (on last 
task in hierarchy)

Adds a new task to the hierarchy below the last row.
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Attaching Additional Information to a Project or Task

Tasks and subprojects can contain other types of information, such as Demand 
Management requests, Change Management packages, attachments, and 
URLs. They can also be configured to send notifications based on certain 
conditions. 

Project managers can create tasks from requests in the Workbench. The newly 
created task is linked as a reference to the originating request. See Creating a 
Task From a Request for more information.

Refer to Configuring Tasks on page 79 for detailed instructions on:

� Assigning Resources

� Setting Up Notifications

� Editing Task Information

� Attaching References to Tasks

� Configuring Task Predecessors

� Setting Scheduling Constraints

Creating a Task From a Request

A task can be created from a request and added to the project plan. The new 
task will have a reference to the originating request.

To create a task from a request:

Ctrl+C Copies the selected task.

Ctrl+V
Pastes a task or tasks (must be on the project plan’s last 
line).

F2 Edits the selected cell in the Project Plan tab.

ESC Cancels changes to a cell in the Project Plan tab.

Left or Right Arrow 
(while editing)

Saves edits and moves cursor to the next cell in the Project 
Plan tab.

Table 2-4. Keyboard shortcuts in the Project Plan tab

Keystroke Action
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1. Within the Project window, select Task Created From Request from the 
drop-down list at the bottom left corner of the window.

2. Click Add.

The New Task From Request window opens.

3. Specify the request(s) to use in the Request No auto-complete list, or click 
Search to search for the request(s).

The Request Selection window opens.

4. Search for the request(s) to use by entering search criteria in the 
appropriate fields and clicking List.

The requests that match your search criteria display in the Query Results 
section of the window.
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5. Select the request(s) in the Query Results section that you want turn into 
tasks. 

You can select multiple requests in the Query Results section. When they 
are added to the project plan, a new task is created for each selected 
request. 

6. Create the new task.

Click OK to create the new task and close the window. Click Add to create 
the new task and perform additional searches for more requests.

7. Save the new task.

Click Save to save the new task and leave the Project window open. Click 
OK to save the new task and close the Project window. The new task has 
been created from the selected request and is part of the current project 
plan. The task is linked to the request. You can change the reference for 
this task at any time by double-clicking it, opening the Task Information 
window and editing it in the References tab.
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Adding Milestones

Milestones are used to mark significant events in a project plan, often the 
completion of a deliverable or arrival of a deadline. As markers, milestones are 
typically set by project managers to complete as soon as they are reached and 
therefore generally do not have effort or duration, though they can be 
configured to possess duration. Milestones are created the same way as tasks.

To create a Milestone:

1. Within the Project window, click Add Task.

A new task appears in the Project Plan tab below the current selection. You 
can also add a new task by selecting the last item in the Project Plan tab and 
pressing Insert or the down arrow on your keyboard.

2. Double-click on the new task.

The Task Information window opens.

3. Select the Mark task as milestone checkbox.

If you want the Milestone to mark itself as Complete automatically when 
all predecessors are complete, select the Milestone automatically completes 
checkbox.
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4. Modify the information under each tab in the Task Information window as 
necessary (for details, see Editing Task Information on page 87).

5. Apply the changes.

To apply changes to the task without closing the window, click Apply. To 
apply changes to the task and close the Task Information window, click OK. 
To close the Task Information window without saving changes, click Cancel.

Setting Up Project Dependencies

Project Management allows you to create dependencies between a project plan 
or task and another, completely separate project plan or task.

For example: Manager Bob has a Training project plan for a new software 
module being installed on his group’s computers. In order for his project plan 
to get started, the Software Upgrade project plan headed by Manager Steve 
must be finished first. Bob can create a Finish-Start Dependency relationship 
between the Software Upgrade project plan and his own Training project plan.

These dependency relationships are controlled from the Predecessors tab of 
the Project or Task Information window.

A task will be automatically converted to a Milestone if its duration is 0.
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Figure 2-6. Predecessors tab of the Task Information window

The types of predecessor relationships available are described in Table 2-5.

Table 2-5. Possible predecessor relationships to a project or task

Predecessor 
Type

Description Possible Relationships

Task/Project
A task or project plan 
in the current project 
plan

Finish/Start - The project plan or task 
can start once its predecessor has 
completed.

External Task
A task from a 
separate project plan

Finish/Start - The project plan or task 
can start once its predecessor has 
completed.

External Project
A separate project 
plan 

Finish/Start - The project plan or task 
can start once its predecessor has 
completed.

Request
A request (possible 
for tasks only)

Finish/Start - The task can start once 
its predecessor has completed.

Finish/Finish - The task and request 
can start at the same time, but neither 
will be marked complete until both are 
complete.
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Setting Internal Predecessors

Setting a project/task predecessor that is contained in the same project plan can 
be done directly in the Project Plan tab.

Figure 2-7. Project Plan tab 

In the Predecessor column, type the sequence number of the desired 
predecessor project or task and click Save to save changes.

Setting an External Predecessor Task

To set an external predecessor task for a task or project plan:

1. Open the Project or Task Information window of the project plan or task.

2. Click the Predecessors tab.
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3. Click Add.

A line is added to the Predecessors tab table.

4. In the Type column, select External Task from the drop-down list.

5. In the Project column, select the external project plan from the auto-
complete list.
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6. In the Name column, select the task Name from the auto-complete list.

7. Click the field in the ID/Seq column to display the task ID.

8. Apply the changes.

Click Apply to save changes and continue working in the Project or Task 
Information window. Click OK to save changes and close the Project or Task 
Information window. Click Cancel to close the Project or Task Information 
window without saving any changes.
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Setting an External Predecessor Project

To set an external predecessor project for a task or project plan:

1. Open the Project or Task Information window of the project plan or task.

2. Click the Predecessors tab.

3. Click Add.

A line is added to the Predecessors tab table.
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4. In the Type column, select External Project from the drop-down list.

5. In the Project column, select the external project plan from the auto-
complete list.

6. In the Name column, select the project plan or subproject name from the 
auto-complete list.

7. Click the field in the ID/Seq column to display the project plan or 
subproject ID.
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8. Apply the changes.

Click Apply to save changes and continue working in the Project or Task 
Information window. Click OK to save changes and close the Project or Task 
Information window. Click Cancel to close the Project or Task Information 
window without saving any changes.
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Setting an External Predecessor Request

To set an external predecessor request for a task:

1. Open the Task Information window of the task.

2. Click the Predecessors tab.

3. Click Add.

A line is added to the Predecessors tab table.
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4. In the Type column, select Request from the drop-down list.

5. In the ID/Seq column, select the request ID from the auto-complete list.

6. In the Relationship column, select Finish-Start or Finish-Finish from the 
drop-down list.
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7. Apply the changes.

Click Apply to save changes and continue working in the Task Information 
window. Click OK to save changes and close the Task Information window. 
Click Cancel to close the Task Information window without saving any 
changes.

Creating a Master Project Schedule

Project Management generates schedules for master projects, based on the 
configurations set in the Scheduling tab of the Settings window.

Generating the Schedule

To generate the schedule for a master project:

1. In the Project window, click Schedule Project.

The Scheduling window opens.
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2. Specify whether to schedule all or part of the project.

a. To schedule the whole project, select Schedule Entire Opened Project.

b. To schedule only a specific part of the project, make sure you have 
selected the part you want to schedule in the Project Plan tab, and select 
Schedule Selected Part of Project. If a subproject is clicked, all of its 
children will be scheduled.

3. Specify a date to begin scheduling from by clicking on and selecting from 
the Start Scheduling From field.

4. Click Schedule.

Scheduling Errors

It is possible for certain combinations of input to cause a schedule to be 
unworkable. If any of these errors are encountered, the schedule will not be 
created. Table 2-6 describes scheduling errors, their causes, and possible 
solutions.

If scheduling errors occur, no schedule will be generated and a list of errors will 
appear. Take note of each error and its cause, and make the necessary adjustments 
within the project plan. See Scheduling Errors for more details.

If scheduling warnings occur, a schedule will be generated and a list of warnings will 
appear. Take note of each warning, as they can be important to the initiative’s 
success. See Scheduling Warnings for more details.
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Scheduling Warnings

It is possible for certain combinations of input when using actual-based 
scheduling or scheduling constraints to cause a schedule to be potentially 
unworkable. Warnings appear when actual-based scheduling has been 
specified. The schedule will still be created, however. Table 2-7 describes 
scheduling warnings, their causes, and possible solutions.

Table 2-6. Scheduling errors, causes, and possible solutions

Scheduling 
Error

Cause Possible Solution

Circular 
dependency

The predecessors of a set of projects 
or tasks contains a cycle. This cannot 
be scheduled.

Break the cycle by 
removing or changing a 
predecessor. 

Not enough 
available 
resources for 
task

The amount of working days available 
from the pool of resources assigned to 
a task is less than the duration of the 
task. This situation can occur if a 
resource does not have any available 
working days, or perhaps for 
contractors who only have set periods 
of time to work.

Assign more resources 
to the task, increase 
resource availability via 
resource calendars, or 
change the Scheduling 
setting to require less 
resource availability.

Selected 
Subproject has 
dependencies 
outside of 
items to be 
scheduled

There are tasks or projects that are not 
in the selected sub-tree, but have 
predecessors in the selected sub-tree.

Select a larger sub-tree 
that includes all 
dependents, or remove 
the dependencies.

No tasks to be 
scheduled

There are no non-complete, non-
cancelled tasks within the selected 
sub-tree to be scheduled

Add tasks, or select a 
larger sub-tree that 
includes non-complete 
or non-cancelled tasks.
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Establishing a Project Baseline

A baseline is the original approved project plan. As scope changes happen, the 
baseline is updated to reflect those changes as part of the approved plan. A 
project manager uses baselines to continuously monitor the health of their 
project plan in terms of schedule and cost by comparing the current project 
plan to the baseline plan.

Selecting Baseline Fields

You can select any of the following project plan fields to display in the 
baseline view:

� Activity

� Summary Condition

� Scheduled Start

� Scheduled Duration

Table 2-7. Scheduling warnings, causes, and possible solutions

Scheduling 
Warning

Cause Possible Solution

Duration extends 
past finish date for 
task

The duration for a task is longer 
than the number of available 
working days between the 
earliest possible start date and 
the actual finish date.   This 
assumes there is no actual start 
date.

Move the actual finish 
date, change the 
duration, or change the 
number of available 
working days.

Duration does not fit 
within actual dates of 
task

The duration of a task is longer 
than the number of available 
working days between the actual 
start and finish dates.

Change actual dates, 
duration, or number of 
available working days.

Actual start date of 
task occurs before 
predecessor finishes

The actual start date of a task 
occurs before its earliest 
possible start date.

Change actual start 
date, predecessors, or 
the earliest possible 
start date.
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� Scheduled Finish

� Scheduled Effort

� Predecessor Information

� Resource/project manager

� Department

� Description

� Priority

� Resource Group

� Task Category

� Planned Labor

� Planned Non-Labor

� Planned CapEx

� Planned OpEx

� Planned Cost

� Skill

To select fields for a baseline:

1. Open the project plan.

2. From the menu at the top of the Workbench, select Project > Settings.

The Settings window opens.
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3. Click the Baselines tab.

4. In the Baseline Fields section, double-click the fields or use the arrow 
buttons to move fields from the Available Fields list to the Selected Fields list.

5. Apply the changes.

To apply changes to the project plan and continue to set baseline options 
without closing the window, click Apply. To apply changes to the project 
plan and close the window, click OK.
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Taking a Baseline

To take a baseline:

1. Open the project plan.

2. Select Project > Baseline from the menu at the top of the Workbench.

The Baseline window opens.

3. Enter a Name and optional Description for the baseline.

4. Click OK.

The baseline has been taken. It can be viewed from the Baselines tab of the 
Project window.

5. Click Save to save the baseline along with the project plan.

Managing Baselines

Multiple baselines can be taken for a single project plan. You can specify 
which is the active project plan baseline, as well as delete baselines at any 
time.

To manage project plan baselines:

1. Open the project plan you have taken baselines of.

2. From the menu at the top of the Workbench, select Project > Settings.

While any project manager can see the active baseline for a project plan, only the 
project manager for the master project can manage baselines (take new baselines, 
delete baselines, specify the active baseline).
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The Settings window opens.

3. Click the Baselines tab.

4. Select the radio button next to the baseline you want to be active for the 
project plan.

5. (Optional) Highlight a baseline you want to delete.

6. (Optional) Click Delete.
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a. A dialog box will open asking if you are sure you want to delete the 
baseline.

b. Click Yes to delete the baseline.

7. Apply the changes.

To apply changes to the project plan and continue to set baseline options 
without closing the window, click Apply. To apply changes to the project 
plan and close the window, click OK.

Comparing Baselines

The Project Schedule Change report can be used to compare baselines to each 
other, or to the project plan schedule as it currently stands. See Reports by 
Category on page 269 for a full listing of all Project Management reports.
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Configuring Tasks

In This Chapter:

� Overview of Configuring Tasks
� Task Elements

� Notifications
� References
� Activities
� Task States

� Adding Tasks to Project Plans
� Creating a Task From a Request
� Creating a Milestone

� Editing Task Information
� Assigning Resources

� Assigning Resources in the Project Plan Tab
� Assigning Resources in the Task Information Window
� Assigning Multiple Resources in the Task Information Window
� Assigning Resource Groups
� Determining Project Resources

� Assigning Skills
� Adding Action Items
� Adding Notes
� Setting Up Notifications

� Using Smart URLs in Notifications
� Nested Tokens in Notifications

� Entering Cost Data
� Attaching References to Tasks

� Attaching Existing Requests
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� Attaching New Requests
� Attaching Packages
� Attaching New Packages
� Attaching Tasks
� Attaching Releases
� Attaching Documents
� Attaching URLs
� Dependency Relationships

� Configuring Task Predecessors
� Changing the Task State
� Setting Scheduling Constraints
� Configuring User Data

� Project/Task User Data Roll-Up

Overview of Configuring Tasks

This chapter explains how to configure tasks within a project plan, including 
assigning resources, setting up notifications, and creating Milestones.

Task Elements

Project plans are repositories of information consisting of tasks, action items, 
subprojects, notes, and references. These elements define and process specific 
business initiatives within an organization. Project plans are not static entities. 
They gather additional information and are modified as they move through 
their tasks to completion. 

Tasks are the components of a project plan that must be completed in order for 
the project plan to complete successfully. Project managers gather the 
information from tasks and make appropriate changes to them through the life 
of the project plan. This means the tasks must be configured to deliver the 
kinds of specific information that project managers need. For example, project 
managers can need to be notified when tasks are completed or their states 
change.
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Tasks also need to be modified as issues arise during the project plan, such as 
extending task schedules or assigning additional resources to a task to make a 
deadline. Team members must update their individual statuses as they 
complete assigned tasks. 

Notifications

Project managers can set up notifications for tasks within a project plan. Email 
messages can be sent to appropriate team members whenever a specific event 
occurs on a task. This would include such events as:

� The completion of a task.

� The changing of a task’s state designation. For example, the task could 
progress from ‘Ready’ to ‘In Progress.’

� The triggering of an exception rule by a task.

� The arrival of a task’s start or finish date approaches.

References

Tasks can include additional references to other entities or points of 
information, allowing easy access and visibility to data related to the current 
task. Summary information for references is viewed as part of the task. 

There are several reference types defined for tasks: requests, packages, 
projects, releases, attachments, and URLs.

Activities

Tasks can be grouped by user-defined categories into activities. For example, 
certain tasks could be grouped within a Design category, while other tasks 
could be grouped within a Production category. Activities can be marked as 
capitalized and used to track SOP 98-1 compliance. For more information on 
activities and their use, see the Mercury Financial Management User’s Guide.

Project managers can create tasks from requests in the Workbench. Once the task is 
created, it automatically has a reference to the originating request. See Creating a 
Task From a Request on page 83 for additional details.
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Task States

In the Workbench, the task state is displayed in the State column of the Project 
window. The available states for a task are defined in Table 3-1.

Adding Tasks to Project Plans

Tasks can be added to a project plan individually or in a pre-sequenced group, 
as defined in a project template. Tasks can also be quickly and easily organized 
in a hierarchical fashion. See Adding Tasks to a Project on page 50 for more 
information. 

Table 3-1. Task state definitions

Task State Definition

New A newly created task starts in this state. 

Pending Predecessor
A task that is holding for one or more predecessors to 
be completed.

Pending Request 
A task that is holding for one or more requests to be 
completed.

Ready A task that is ready to be worked on by its resource.

In Progress 
A task that is moving through the actions necessary for 
its completion.

Completed A task that has been finished.

Cancelled
A task that is not complete and will not be worked on, 
as it is no longer required for the completion of the 
project plan.

Bypassed
An incomplete task that is left unfinished after the 
project plan is completed.

Depending on their defined level of responsibility in a project plan, users can only be 
able to change tasks between certain states. 

For example, project managers can change a task from Ready to In Progress to 
Cancelled, or from Bypassed back to Ready. Project participants are only able to 
change a task from Ready to In Progress to Complete.

Available task states can also depend on the state of the project plan.
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Creating a Task From a Request

A task can be created from a request on the Project window in the Workbench. 
The new task will have a reference to the originating request.

To create a task from a request:

1. Log on to Mercury IT Governance Center and open the Workbench.

2. Open a project plan.

3. Go to the Project Plan tab.

4. Select Task Created From Request from the drop-down list at the bottom 
left corner of the window.

5. Click Add.

The New Task From Request window opens.
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6. Specify the request(s) to use in the Request No. auto-complete list, or click 
Search to search for the request(s). 

The Request Selection window opens.

7. Search for the request(s) to use by entering search criteria in the 
appropriate fields.

8. Click List.

The requests that match your search criteria display in the Query Results 
section of the window.
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9. Select the request(s) in the Query Results section that you want turn into 
task(s). 

You can select multiple requests in the Query Results section. When they 
are added to the project plan, a new task is created for each selected 
request. 

10. Make sure that Task Updated by Request is specified as the Relationship.

11. Click OK to create the new task and close the window or click Add to create 
the new task and perform additional searches for more requests.

The new task has been created from the selected request and is part of the 
current project plan. The task is linked to the request. You can change the 
reference for this task at any time by double-clicking it, opening the Task 
Information window and editing it in the References tab. 

12. Click Save to save the new task and leave the Project window open or click 
OK to save the new task and close the Project window.
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Creating a Milestone

Milestones can be created for a project plan in the same way as tasks.

To create a Milestone:

1. Within the Project window, click Add Task.

A new task appears in the Project Plan tab below the current selection. You 
can also add a new task by selecting the last item in the Project Plan tab and 
pressing Insert or the down arrow on your keyboard.

2. Double-click on the new task.

The Task Information window opens.

3. Select the Mark task as milestone checkbox.

If you want the Milestone to mark itself as Complete automatically when 
all predecessors are complete, select the Milestone automatically completes 
checkbox.

4. Modify the information under each tab in the Task Information window as 
necessary (for details, see Editing Task Information).

5. Apply the changes.
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To apply changes to the task without closing the window, click Apply. To 
apply changes to the task and close the Task Information window, click OK. 
To close the Task Information window without saving changes, click Cancel.

Editing Task Information

Users with appropriate security permissions can edit information for tasks 
displayed in the Project Plan tab. Task information can be edited directly in the 
Project Plan tab, or in the Task Information window.

To edit task information from the Project Plan tab:

1. Locate the task to edit.

� If you are editing an existing task, query and open an existing project 
plan.

� If you are editing a newly created task, you are already in the Project 
Plan tab.

2. Click on any desired fields to edit their contents directly.

3. Click OK or Save to save the information.

To edit task information in the Task Information window:

1. Locate the task to edit.

2. Open the Task Information window and do one of the following:

� Query and open the task directly from the Task Workbench. The Task 
Information window opens.

� Query and open an existing project plan. Double-click the task to edit, 
or select it and click Edit. The Task Information window opens.

3. Make whatever changes are necessary in the Task Information window.

A task will be automatically converted to a Milestone if its duration is 0.
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4. Click OK or Save to save the information.

Assigning Resources

Users with appropriate security permissions can assign resources to tasks 
displayed in the Project Plan tab. Resources can be assigned directly in the 
Project Plan tab, or in the Task Information window. 

Assigning Resources in the Project Plan Tab

Resources can be assigned for new and existing tasks in the Project Plan tab in 
the following ways:

� You can select a resource directly by clicking the Resource icon.

Figure 3-1. Resource icon

� You can search for and then assign a suitable resource by clicking the 
Resource Finder icon.

Figure 3-2. Resource Finder icon

For more detailed information on using the Resource Finder, see the 
Mercury Resource Management User’s Guide.

To assign resources to existing and new tasks in the Project Plan tab:

1. In the Workbench, open the Project Plan tab for the project plan you are 
editing.

� If you are assigning resources to an existing task, query and open the 
project plan containing the task.

Updating information in the Project Plan tab is more direct, while more detailed 
information can be edited in the Task Information window.
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� If you are assigning resources to a newly created task, you are already 
in the Project Plan tab.

2. Select the task to assign resources.

3. Click the Resource icon to assign a resource, or the Resource Finder icon 
to search for and assign an appropriate resource.

See the Mercury Resource Management User’s Guide for more detailed 
information on using the Resource Finder.

4. Click OK or Save to save the information.

Assigning Resources in the Task Information Window

Resources can be assigned to existing tasks and new tasks in the Task 
Information window.

To assign resources to existing or new tasks in the Task Information window:

1. Open the Task Information window. 

2. Click the Details tab.

3. Select a resource from the Resource field.

4. Click OK or Apply to save the information.

Assigning Multiple Resources in the Task Information Window

Multiple resources can be assigned to existing tasks and new tasks. Once 
multiple resources have been assigned, their individual effort hours or booked 
skill can be adjusted at any time.

To assign multiple resources to existing or new tasks in the Task Information 
window:

1. Open the Task Information window. 

2. Click the Resources tab.
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3. Specify a resource in the Add Resource to Task auto-complete list.

4. Click Add.

Repeat as necessary.

5. To adjust the number of effort hours for a resource, click the numeric field 
in the Effort (hours) column and enter a new value.

6. Save the information.

Click Apply to store the information and continue to work in the Task 
Information window, or click OK to save the information and close the 
window. The resource assignments will not be saved until you click either.

Assigning Resource Groups

In order to add resource groups, first make sure that the field is enabled in the 
Project Settings. See Selecting Information to Track and Display on page 28 
for details.
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Determining Project Resources 

Project managers can specify users who will be allowed to act as resources for 
a project plan. In the Project Team tab of the Project Settings window, the 
project manager can choose one of the following:

� Allow all users with the Project option enabled in their security groups to 
be resources for a project plan.

� Allow only those resources who are specified in the Project Team tab to be 
used as resources for a project plan. These resources are listed in the tab’s 
Resource table.

See Setting Up the Project Team on page 43 for more information about 
setting up the resources in the Project Team tab for a master project.

Assigning Skills

When creating a project plan, you can assign a skill to any task without 
specifying a resource. This allows you to create a project plan that identifies 
the skills needed to complete its tasks without necessarily pinpointing the 
specific resources available. Additionally, capturing skills required to complete 
tasks provides a more detailed estimate of the project plan cost; this helps 
make sure the budget is correct and the right resources are allocated. 

To assign skills to existing and new tasks in the Project Plan tab:

1. In the Workbench, open the Project Plan tab for the project plan you are 
editing.

� If you are assigning a skill to an existing task, query and open the 
project plan containing the task.

� If you are assigning a skill to a newly created task, you are already in 
the Project Plan tab.

2. Select the task to assign a skill to.

3. Select a skill from the task line, in the Skill column.

4. Click OK or Save to save the information.
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Adding Action Items

Action items are used to capture important “to do” items that do not require the 
formal definition, tracking, and hierarchical restrictions of a task. Action items 
can be added to existing tasks and new tasks. Action items are added in the 
Task Information window.

To add an action item to a task:

1. Open the Task Information window. 

2. In the Task Information window, click the Action Items tab. 

3. Click Add.

The Action Item window opens.

4. Enter information in the required fields and drop-down lists.

Select Required = Yes if you want the action item to be required. The task 
will not complete until the action item has been completed.

5. Click Add to add the action item and continue to create more, or click OK to 
add the action item and close the window.

6. Save the action item.

Click Apply to store the information and continue to work in the Task 
Information window, or click OK to save the information and close the 
window. The action item will not be saved until you click OK.

7. Save the task information.

If the Task Information window is opened from the Project Plan tab, you must 
click OK or Save in the Project window to save the task information.
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Adding Notes

Users can enter free-form text in the Notes tab of the Task Information window. 
Saved entries are marked with a timestamp.

To add notes to a task:

1. Open the Task Information window. 

2. In the Task Information window, click the Notes tab. 

3. Enter any notes into the New Notes text field.

To increase the viewable area, click Enlarge.

4. Click Apply to store the notes and continue to work inside the Task 
Information window, or click OK to save the notes and close the window. 
The notes will not be saved until you click OK.

5. Click OK or Save in the Project window to save the task information.

Setting Up Notifications

Notifications are set up in the Task Information window. 

To set up a notification for a task:

1. Open the Task Information window for the task.

2. In the Task Information window, click the Notifications tab. 

3. Click New.

The Add Notification for Task window opens.

4. In the Setup tab, enter information as described in the Table 3-2 
on page 95.

The Notes tab can contain up to 32K of information per project plan. 
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The Event drop-down list allows you to choose to send a notification based 
on any of the following criteria:

� The task has reached a specific state.

� The task has triggered a particular exception.

� The task’s Scheduled Start or Finish date is approaching, has arrived, 
or has passed.

5. To add a new user to the Recipients, click New.

The Add New Recipient window opens.

6. Enter information in the required fields.

7. Click Add to add the new recipient.

Note that the enabled Multi capability of the Username auto-complete list 
enables you to select multiple recipients. Click OK to return to the Add 
Notification for Task window. Click Cancel to return to the Add Notification for 
Task window without saving any changes. 

8. (Optional) In the Add Notification for Task window you can use the Edit and 
Delete buttons to modify the list of recipients. Click Token to view the 
available tokens.

9. (Optional) Click the Message tab in the Add Notification for Task window if 
you want to view and edit the message notification template. 

10. (Optional) Notifications can be configured to include the Web address 
(URL) for a specific project plan or task. This is referred to as a Smart 
URL. You can include a Smart URL token for the notification. See the next 
section, Using Smart URLs in Notifications, for more information.

11. Click OK to close the window.

Using Smart URLs in Notifications

Notifications can be configured to include the Web address (URL) for the 
specific project plan or task. When users receive a notification email and click 
the URL, they are taken directly to the project plan or task. The available 
tokens for project plans and tasks are described in Table 3-2.
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To use a Smart URL:

1. Follow the procedure described in Setting Up Notifications.

2. Open the Task Information window.

3. Click the Notifications tab. 

4. Click New.

The Add Notification for Task window opens.

5. Click the Message tab.

6. Click Tokens.

The Token Builder window opens.

Table 3-2. Smart URL tokens

Smart URL Token Description

PROJECT_URL
URL to access the Project Overview page for 
this project plan.

WORKBENCH_PROJECT_URL
URL to access the Project window for this 
project plan in the Workbench.

TASK_URL
URL to access the Task Detail page for this 
task.

WORKBENCH_TASK_URL
URL to access the Task Information window for 
this task in the Workbench.
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7. Click either the project or task folder to display the list of tokens.

The figure above shows the Smart URLs for tasks.

8. In the Token column of the window, select the appropriate token from the 
list of tokens, such as CREATED_BY or DEPARTMENT_CODE for 
project plans.

The token you select displays in the Token field.

9. Select the token in the Token field.

10. Press Ctrl+c to copy the token’s name.

11. Click Close to close the Token Builder window.

12. Click in the notification’s Body text section at the point where you want to 
insert the Smart URL.

13. Press Ctrl+v to paste the token of the Smart URL in the Body section. 

The figure below shows the project plan URL in the Body section of an 
HTML-format notification.
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14. Click OK to close the Add Notification for Task window.

15. Click OK to close the Task Information window.

The email notification sent from this task will contain a URL to open a 
specific project plan or task.

Nested Tokens in Notifications

Notifications can be configured to include project plan information using 
tokens. As project plan hierarchies become more complex, token syntax can 
become correspondingly involved. For example, consider a project plan with 
the following structure:
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Figure 3-3. Sample project structure

A notification from task 2 can use tokens to refer to project plan information 
on any level above it. The sample notification below displays the Project Name 
for the master project and its subprojects.
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Figure 3-4. Sample notification with nested tokens

Entering Cost Data

If Project Management’s Financial Management capability has been enabled 
for this project plan, you can track and enter Actual Cost data in the Project 
window. See the Mercury Financial Management User’s Guide for more 
detailed information.
Entering Cost Data 99



 Chapter 3: Configuring Tasks
Attaching References to Tasks

Project Management features a number of methods for capturing additional 
information, or references, related to your project plans. References are 
attached from the Task Information window. 

To attach references to a task:

1. Open the Task Information window. 

2. In the Task Information window, click the References tab.

3. Attach the reference.

Attaching Existing Requests

To attach an existing request to a task:

1. Open the Task Information window.

2. Click the References tab.

3. Select Request (Existing) from the New Reference drop-down list.

4. Click Add.

The New Reference - Request (Existing) window opens.

5. To select the request to attach, use one of the following methods:

� Enter the request number in the Request No. field or select a request 
from the Request No. auto-complete list. (Hold down Ctrl+click or 
Shift+click to select more than one request.) The selected request 
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displays in the Request No. field. If you selected multiple requests, they 
all display in the Request No. field separated by semi-colons. 

� Click Search to search for requests in a separate query window and 
follow the procedure in Searching for Requests to Attach.

6. Select the type of relationship you want to assign between the task and its 
reference from the list.

See Dependency Relationships on page 113 for a description of the various 
relationships that can be assigned.

7. Click OK.

You return to the References tab in the Task Information window. The new 
attached request displays as a reference.

8. Click OK to close the Task Information window. 

You return to the Project window. 

9. Click Save to save the attached request as a reference in the project plan.

Searching for Requests to Attach

To search for requests to attach to a task:

1. From the New Reference - Existing Request window, click Search.

A new query window opens.
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2. Query for the request(s) you want to use by entering search criteria in the 
appropriate fields.

3. Click List.

The requests that match your search criteria display in the Query Results 
section of the window. 

4. Select the request(s) in the Query Results section that you want to attach to a 
task.

5. Select the type of relationship you want to assign between the task and its 
request.

See Dependency Relationships on page 113 for a description of the various 
relationships that can be assigned.

6. Click OK to attach the request(s) to the task and close the current window. 

You return to the References tab in the Task Information window. 

7. After you return to the Task Information window, the new attached request 
displays as a reference.

8. Click OK to close the Task Information window.

You return to the Project window.
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9. Click Save to save the attached request as a reference in the project plan.

Attaching New Requests

A new request can be created from the References tab and immediately 
attached to a task. This saves time from having to create a new request in 
Demand Management, searching for it, and attaching it to the task.

To attach a new request to a task:

1. Open the Task Information window.

2. Click the References tab.

3. Select Request (New) from the New Reference drop-down list.

4. Click Add.

The New Reference - Request (New) window opens.

5. Select a request type from the Request Type auto-complete list.

6. Select the type of relationship you want to assign between the task and its 
reference from the list.

See Dependency Relationships on page 113 for a description of the various 
relationships that can be assigned.

7. Click Create.

The standard interface opens with the request type loaded.

8. Enter any necessary information in the request’s fields.
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9. Click Save.

The request is submitted. You return to the References tab in the Task 
Information window. The new attached request displays as a reference.

10. Click OK to close the Task Information window.

You return to the Project window. 

11. Click Save to save the attached request as a reference in the project plan.

Attaching Packages

To attach a package to a task:

1. Open the Task Information window.

2. Click the References tab.

3. Select Package from the New Reference drop-down list.

4. Click Add.

The New Reference - Package (Existing) window opens.

5. To select a package for an attachment, use one of the following methods:

� Enter the package number in the Package No. field or select a package 
from the Package No. auto-complete list. (Hold down Ctrl+click or 
Shift+click to select more than one package.) The selected package 
displays in the Package No. field. If you selected multiple packages, 
they all display in the Package No. field separated by semi-colons. 

� Click Search to search for packages in a separate query window and 
follow the procedure in Searching for Packages to Attach.
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6. Select the type of relationship you want to assign between the task and its 
reference from the list.

See Dependency Relationships on page 113 for a description of the various 
relationships that can be assigned.

7. Click OK.

You return to the References tab in the Task Information window. The new 
attached package displays as a reference.

8. Click OK to close the Task Information window.

You return to the Project window. 

9. Click Save to save the attached package as a reference in the project plan.

Searching for Packages to Attach

To search for packages to attach to a task:

1. From the New Reference - Package (Existing) window, click Search.

A new query window opens.

2. Query for the package(s) you want to use by entering search criteria in the 
appropriate fields.
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3. Click List.

The packages that match your search criteria display in the Query Results 
section of the window. 

4. Select the package(s) in the Query Results section that you want to attach to 
a task.

5. Select the type of relationship you want to assign between the task and its 
reference from the list.

See Dependency Relationships on page 113 for a description of the various 
relationships that can be assigned.

6. Click OK to attach the package(s) to the task and close the current window.

You return to the References tab in the Task Information window. The new 
attached package displays as a reference.

7. Click OK to close the Task Information window.

You return to the Project window.

8. Click Save to save the new package as a reference in the project plan.

Attaching New Packages

A new package can be created from the References tab and immediately 
attached to a task. This saves time from having to create a new package in 
Change Management, searching for it, and attaching it to the task.

To attach a new package to a task:

1. Open the Task Information window.

2. Click the References tab.

3. Select Package (New) from the New Reference drop-down list.

4. Click Add.

The New Reference - Package (New) window opens.
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5. Click Create.

The Package window opens.

6. Enter any necessary information in the package’s fields.

7. Click Save.

The package is submitted. You return to the References tab in the Task 
Information window. The new attached package displays as a reference.

8. Click OK to close the Task Information window.

You return to the Project window. 

9. Click Save to save the attached package as a reference in the project plan.

Attaching Tasks

To attach a task to a task:

1. Open the Task Information window.

2. Click the References tab.

3. Select Task from the New Reference drop-down list.

4. Click Add.

The New Reference - Task window opens.
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5. To select a task for attachment, use one of the following methods:

� Enter the task name in the Task Name field or select a task from the 
Task Name auto-complete list (hold down Ctrl+click or Shift+click to 
select more than one task). The selected task displays in the Task Name 
field. If you selected multiple tasks, they all display in the Task Name 
field separated by semi-colons. 

� Click Search to search for tasks in a separate query window and follow 
the procedure in Searching for Tasks to Attach.

6. Select the type of relationship you want to assign between the task and its 
reference from the list.

See Dependency Relationships on page 113 for a description of the various 
relationships that can be assigned.

7. Click OK.

You return to the References tab in the Task Information window. The new 
attached task displays as a reference.

8. Click OK to close the Task Information window. 

You return to the Project window. 

9. Click Save to save the attached task as a reference in the project plan.

Searching for Tasks to Attach

To search for tasks to attach to a task:

1. From the New Reference - Task window, click Search.

A new query window opens.
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2. Query for the task(s) you want to use by entering search criteria in the 
appropriate fields.

3. Click List.

The tasks that match your search criteria display in the Query Results 
section of the window. 

4. Select the task(s) in the Query Results section that you want to attach to a 
task.

5. Select the type of relationship you want to assign between the task and its 
attachment from the list.

See Dependency Relationships on page 113 for a description of the various 
relationships that can be assigned.

6. Click OK to attach the task(s) to the task and close the current window. 

You return to the References tab in the Task Information window. The new 
attached task displays as a reference.

7. Click OK to close the Task Information window.

You return to the Project window.

8. Click Save to save the attached task as a reference in the project plan.
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Attaching Releases

To attach a release to a task:

1. Open the Task Information window.

2. Click the References tab.

3. Select Release from the New Reference drop-down list.

4. Click Add.

The New Reference - Release window opens.

5. To select a release for an attachment, enter the Release Name in the Release 
Name field or select a release from the Release Name auto-complete list. 
(Hold down Ctrl+click or Shift+click to select more than one release.) The 
selected release displays in the Release Name field. If you selected multiple 
releases, they all display in the field separated by semi-colons. 

6. Select the type of relationship you want to assign between the task and its 
reference from the list.

See Dependency Relationships on page 113 for a description of the various 
relationships that can be assigned.

7. Click OK.

You return to the References tab in the Task Information window. The new 
attached release displays as a reference.

8. Click OK to close the Task Information window.

You return to the Project window.

9. Click Save to save the attached release as a reference in the project plan.
110 Mercury Project Management™ User’s Guide



 Chapter 3: Configuring Tasks
Attaching Documents

To attach a document to a task:

1. Open the Task Information window.

2. Click the References tab.

3. Select Attachment from the New Reference drop-down list.

4. Click Add.

The Add Document window opens.

5. To select a Document for an attachment, click the File Chooser icon.

Open the drive and directory where the file you want to attach is located 
and select it. The name of the Document displays in the Attachment field.

6. Enter a description in the Description field.

7. Click OK.

You return to the References tab in the Task Information window. The new 
attached Document displays as a reference.

8. Click OK to close the Task Information window.

You return to the Project window.

9. Click Save to save the attached Document as a reference in the project 
plan.
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Attaching URLs

To attach a URL to a task:

1. Open the Task Information window.

2. Click the References tab.

3. Select URL from the New Reference drop-down list.

4. Click Add.

The New Reference - URL window opens.

5. Enter the name of the URL in the URL field.

6. Enter a description in the Description field.

7. Click OK.

You return to the References tab in the Task Information window. The new 
attached URL displays as a reference.

8. Click OK to close the Task Information window.

You return to the Project window.

9. Click Save to save the attached URL as a reference in the project plan.
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Dependency Relationships

The dependency relationships available when you attach references of various 
types to a task are described in Table 3-3.

Configuring Task Predecessors

Task predecessors are configured from the Project Plan tab. A predecessor is a 
task or project plan that has a defined relationship between its start or finish 
date, and the start or finish dates of the task that is dependent on it.

When request references are attached to a task, they can also act as 
predecessors for the dependency relationship you assign to them. For instance, 

Table 3-3. Dependency relationships

Relationship Description

Adding requests to tasks

FF Predecessor
The task does not complete until the selected request 
closes.

Predecessor
Action is not allowed on this task until the selected 
request closes.

Related to this Task The selected request is related to this task.

Successor
No Action is allowed on the selected request until this 
task closes.

Task Updated by Request
This task is automatically updated by the selected 
request.

Adding packages to tasks

Related to this Task The referenced package is related to this task.

Adding projects to tasks

Related to this Task Referenced project plan is related to this task.

Adding releases to tasks

Related to this Task Referenced release is related to this task.

Adding tasks to tasks

Related to this Task The referenced task is related to this task.
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if you assign a predecessor relationship between a task and a request that has 
been attached to the task as a reference, action is not allowed on this task until 
the request closes. 

See Attaching References to Tasks on page 100 for more information on how 
to assign relationships between tasks and references.

See Dependency Relationships on page 113 for a list of the dependency 
relationships and their descriptions.

See Setting Up Project Dependencies on page 59 for more detailed 
information on setting task and project plan predecessors.

Changing the Task State

There are two methods for changing a task’s state. A task’s state can be 
changed from inside the Project window, or in its Task Information window.

To change a task’s state from the Project window

1. States can be changed for existing tasks and new tasks.

� If you are changing the state of an existing task, query and open an 
existing project plan.

� If you are changing the state of a newly created task, you are already in 
the Project Plan tab.

2. In the Project Plan tab, select a new state for the task from the drop-down 
list in the State column.

To change a task’s state from its Task Information window

1. Open the Task Information window. 

2. Select the new task state from the Task State drop-down list at the top of the 
window.

3. Click OK.

4. Click Save to save the task state changes.
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Setting Scheduling Constraints

Scheduling constraints prevent certain changes to a schedule. If a project 
manager attempts to schedule a constrained task outside of its constraint, 
Project Management will alert the user to the conflict and reset the date to its 
previous value. Scheduling constraints are set in the Task Information window. 

To set a task’s scheduling constraints:

1. Open the Task Information window. 

2. Click the Details tab in the Task Information window.

3. Under Scheduling Constraints, select the type of constraint you want to use 
from the Constraint Type drop-down list.

4. Enter a date in the Constraint Date field.

5. Click OK.

Configuring User Data

User data is the set of custom fields that can be defined for various Project 
Management entities. User data fields can be used to capture data not covered 
by the default project/task information fields, such as Cost. These fields are 
accessed through the User Data tab in the Task Information window. If no user 
data has been defined for a particular entity, the tab is disabled. 

Project/Task User Data Roll-Up

Values from task user data fields can be configured to “roll up” (combine/
process values in a meaningful way) into parent project user data fields. The 
following types of task user data can roll up into project user data:

� Numeric fields (Text Field component type with Numeric data mask)

� Date fields

For each project plan, a project user data field can show a roll-up of task user 
data values using one of the following methods:
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� Average
Shows the average of all values of a specified task user data field for every 
task under the project (Numeric fields).

� Maximum
Shows the largest of all values of a specified task user data field for every 
task under the project (Numeric and Date fields).

� Minimum
Shows the smallest of all values of a specified task user data field for every 
task under the project (Numeric and Date fields).

� Sum
Shows the summation of all values of a specified task user data field for 
every task under the project (Numeric fields).

Project/task user data roll-up can be used to capture various important aspects 
of a project plan.

� Using the “Average” roll-up method, the average cost of all a project plan’s 
tasks can be easily determined and automatically recalculated each time a 
task is updated.

� Using the “Maximum” roll-up method, the latest date out of a project 
plan’s tasks can be captured.

� Using the “Minimum” roll-up method, the earliest date out of a project 
plan’s tasks can be captured.

� Using the “Sum” roll-up method, the total cost of a project plan’s tasks can 
be easily determined and automatically recalculated each time a task is 
updated.

Creating Project/Task User Data Roll-Up 

User data must be configured for projects and tasks before specifying roll-up 
methods. 

1. Create and configure project and task user data fields.

2. Link project and task user data fields with roll-up method.

Once project and task user data fields have been configured and saved, the roll-
up relationship can be specified.

To specify the roll-up method:

1. Log on to Mercury IT Governance Center and open the Workbench.
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2. From the shortcut bar, select Configuration > User Data.

The User Data Workbench opens.

3. Select Project User Data from the User Data Type drop-down list.

4. Click List.

The Results tab opens with the project user data type loaded.

5. Select the project user data and click Open.

6. Click the Roll-Up tab.

7. Click New.
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The Add New Roll-Up window opens.

8. Select the Project User Data Field that will contain rolled-up task user data 
values.

9. Select the Task User Data Field whose values will roll up into the chosen 
Project User Data Field.

10. Select the Roll-Up Method from the drop-down list.

The drop-down list will only display valid options for the data types of the 
Project and Task User Data Fields.

11. Select Yes to enable the roll-up.

12. Click OK.

The roll-up relationship is added to the Roll-Up tab.

13. Click Save.

Only two user data fields of the same type can be selected for roll-up (for example, a 
Numeric field cannot roll up into a Date field, nor vice versa).

While a task user data field can have multiple roll-up relationships associated with it, 
a Project user data field cannot have more than one roll-up relationship defined.
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Editing Project/Task User Data Roll-Up 

Project/task user data roll-up can be edited from the Workbench once it has 
been created.

To edit a project/task user data roll-up relationship:

1. Log on to Mercury IT Governance Center and open the Workbench.

2. From the shortcut bar, select Configuration > User Data.

The User Data Workbench opens.

3. Select Project User Data from the User Data Type drop-down list.

4. Click List.

The Results tab opens with the project user data type loaded.

5. Select the project user data and click Open.

6. Click the Roll-Up tab.
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7. Select the roll-up relationship to edit.

8. Click Edit.

The Edit Roll-Up window opens.

9. Make any desired changes to the Project/Task User Data Field or Roll-Up 
Method.

10. Click OK.

The roll-up definition is updated in the Roll-Up tab.

11. Click Save.
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Deleting Project/Task User Data Roll-Up 

Project/task user data roll-up can be deleted. This deletion only removes the 
roll-up relationship; it does not delete the referenced user data fields.

To delete a project/task user data roll-up relationship:

1. Log on to Mercury IT Governance Center and open the Workbench.

2. From the shortcut bar, select Configuration > User Data.

The User Data Workbench opens.

3. Select Project User Data from the User Data Type drop-down list.

4. Click List.

The Results tab opens with the project user data type loaded.

5. Select the project user data and click Open.

6. Click the Roll-Up tab.
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7. Select the roll-up relationship to remove.

8. Click Remove.

9. Click Save.

Example: Using Project/Task User Data Roll-Up

Company X would like to capture total travel cost for its project plans. Total 
project plan travel cost in this case is to be calculated by adding the travel costs 
of individual tasks. User data fields for task travel cost and project plan total 
travel cost are each defined. The relationship is illustrated below:

Figure 3-5. User data roll-up 

Each task has its own Travel Cost user data field. The values for each task Travel 
Cost user data field are rolled up using the “Sum” roll-up method into the 
project Total Travel Cost user data field.

Travel Cost UD

Travel Cost UD

Travel Cost UD

Total Travel Cost UD(sum)
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Figure 3-6. User data roll-up example 

+

=
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Managing a Project Plan

In This Chapter:

� Overview of Managing a Project Plan
� Setting Up a Project Plan
� Adding Tasks to a Project Plan
� Taking a Baseline
� Revising the Project Plan

� Viewing and Modifying Project Plan Hierarchy
� Project Plan States
� Updating Scheduling and Dependencies
� Updating Tasks from the Standard Interface
� Concurrent Editing

� Updating the Schedule
� Viewing Project and Task Progress

� Searching for Projects in the Workbench
� Searching for Tasks in the Workbench
� Viewing the Summary Condition
� Viewing Milestones
� Viewing the Project Plan Critical Path
� Viewing Exceptions
� Using the Mercury IT Governance Dashboard to View Progress
� Project Management Reports
� Comparing Against the Baseline

� Tracking and Analyzing Project Plan Costs
� Tracking Project Plan History
� Completing, Cancelling, and Deleting Project Plans

� Completing Project Plans
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� Canceling Project Plans
� Deleting Project Plans

� Creating a URL to Open the Project Plan Window
� Printing a Project Plan Gantt Chart

� Exporting a Gantt Chart to an Image File

Overview of Managing a Project Plan

This chapter describes how to oversee a project plan from inception to 
completion using Mercury Project Management. 

Business initiatives can be divided into a set of goals that must be met through 
the completion of measurable tasks by an assigned group of people. The tasks 
must be monitored to determine if they are on schedule. In order to provide 
organization and structure for these activities, a project manager is responsible 
for managing the work group and project plan.

Some common responsibilities for project managers include:

� Organizing and assigning tasks.

� Tracking task and project plan progress, and ensuring that assigned tasks 
are completed on time.

� Communicating project plan status to participants and stakeholders, 
including the appropriate escalation of project plan-related issues.

Project managers can integrate and streamline these responsibilities using the 
features of Project Management. The following sections provide instructions 
for performing common Project Management tasks, such as setting up a project 
plan and tracking its status.

In Project Management, project managers are those users who have specific Project 
Management-related access grants. See the Security Model Guide and Reference 
for details.
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This chapter discusses:

� Setting Up a Project Plan
Every master project contains a set of options to configure that are specific 
to the project plan, such as what information is tracked and displayed, the 
rules for the display of indicators and exceptions, scheduling, and who can 
view tasks and project plans.

� Adding Tasks to a Project Plan
After the global options have been configured for a master project, tasks 
and subprojects can be arranged and ordered into a meaningful hierarchy.

� Taking a Baseline
Project managers can take a baseline of their project plans, which can be 
used to monitor a project plan’s changes as it moves through its life cycle.

� Revising the Project Plan
Project managers can move their project plans into different project plan 
“states.” These states help managers to maintain visibility and control over 
a project plan.

� Updating the Schedule
After making revisions, a project manager might find it necessary to 
reschedule the project plan. This includes recalculating Start and Finish 
dates.

� Viewing Project and Task Progress
Managers can search for project plans and tasks, as well as track a 
particular project plan’s progress using its summary condition. Any 
exceptions that have been triggered can also be displayed.

� Tracking and Analyzing Project Plan Costs
Project cost data can be collected and analyzed by the project manager to 
track budgets, compare project plan sizes, or spot potential trouble.

� Tracking Project Plan History
Project plan history is maintained and can be viewed for project plans and 
tasks.

� Creating a URL to Open the Project Plan Window
Project managers can construct a URL that opens their project plan in the 
Workbench.

� Printing a Project Plan Gantt Chart
Project managers can print the project plan Gantt chart, with a wide range 
of filtering options. The project plan Gantt chart can also be exported to an 
image file and used in presentations.
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Setting Up a Project Plan

Project Management’s master project entity is made up of the following 
components:

� Tasks

� Subprojects

� Activities

� Notes

� Packages 

� Requests 

� References 

These components are used to define and process a specific business initiative. 
The master project also contains a number of global settings that can be 
configured to suit a particular project plan’s objectives. See the following 
sections for more information on setting up a project plan:

� Selecting Information to Track and Display on page 28

� Setting Up Exception Behavior on page 29

� Setting Up Indicators on page 35

When a user creates or edits a project plan or subproject, that user is the only one 
able to save changes.

In the case of two users wanting to edit two different subprojects under one master 
project, opening and editing only the desired subprojects will enable each user to 
save changes without interfering with each other.

See Concurrent Editing on page 136 for more detailed information.

When you import a large Microsoft Project (or a large number of projects) into Project 
Management, tables in the Mercury IT Governance Center database are updated to 
handle this new configuration. Because of the scope of database changes, you 
should re-run the database statistics on your Mercury IT Governance Center 
database. Contact your application administrator for help with this procedure.
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� Setting Scheduling Options on page 36

� Setting Security Restrictions on page 41

� Setting Up the Project Team on page 43

� Setting Up Microsoft Project Integration on page 46

� Establishing a Project Baseline on page 72

Adding Tasks to a Project Plan

Once the master project has been configured, the project manager can add 
tasks to the project plan and specify task details, including assigning resources 
or resource groups. Tasks can be added individually or in a pre-sequenced 
group with a project template. Tasks can also be organized in a hierarchical 
fashion quickly and easily.

See the following chapters and sections for more details on including tasks in a 
project plan:

� Adding Tasks to a Project on page 50

� Creating a Task From a Request on page 83

� Configuring Tasks on page 79

� Using Project Templates on page 191

Taking a Baseline

A baseline is the original approved plan for a project plan.  As scope changes 
happen, the baseline is updated to reflect those changes as part of the approved 
plan. A project manager uses baselines to continuously monitor the health of 
their project plan in terms of schedule and cost by comparing the current 
project plan to the baseline.

See Establishing a Project Baseline on page 72 for more detailed information 
about taking and using project plan baselines.
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Revising the Project Plan

Project plans rarely remain unchanged during a project plan’s life. Revisions 
are commonly made to accommodate project plan updates, reorganizations and 
reassignments. Project Management enables project managers to revise their 
plan quickly. 

Viewing and Modifying Project Plan Hierarchy

The ordering and grouping of tasks and subprojects is graphically displayed in 
the Project Plan tab.

Figure 4-1. Project window with Project Plan tab

Use the directional arrow buttons to reorganize the project plan hierarchy.

Figure 4-2. Directional arrow buttons

When a user creates or edits a project plan or subproject, that user is the only one 
able to save changes. All other users will be warned of this before attempting to edit 
a project plan or subproject that is already open.

In the case of two users wanting to edit two different subprojects under one master 
project, opening and editing only the desired subprojects from the Project Workbench 
will enable each user to save changes without interfering with each other.
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Tasks can be grouped and ordered into subprojects, using the right arrow to 
indent. Subprojects can have their tasks removed and made into separate tasks 
using the left arrow to outdent. Top-to-bottom reordering can be performed on 
subprojects and tasks as well, using the up and down arrows. For step-by-step 
instructions, see Setting Up Project Hierarchy on page 52.

Project Plan States

To display the different stages in a project plan’s life from planning to 
completion, a master project can have various states associated with it. These 
states are New, Plan, Active, Completed and Cancelled. Project managers can 
move project plans into different states to facilitate the work associated with 
that stage of the project plan. The following table describes the various project 
plan states, their behaviors, and applications.

Table 4-1. Project plan states and descriptions 

Project Plan 
State

Behavior Application

New

Project plans and their tasks are not shown 
in the My Tasks portlet or the Dashboard.

Notifications are not sent and exceptions 
are not triggered.

All project plans start in this state. Once a 
project plan is moved out of the ‘New’ state 
it becomes permanently visible and cannot 
return to this state.

This state allows a project manager to 
manipulate the project plan without 
having to notify participants or 
stakeholders.

On Hold

Project plans and their tasks are displayed 
in My Tasks and the Dashboard but cannot 
be edited.

Notifications are not sent and exceptions 
are not triggered.

Hierarchy can be modified.

This state allows a project manager to 
manipulate the project plan (such as 
changing project hierarchy and revising 
predecessors). This state informs 
participants and other managers that a 
rework is being done.

Active

Project plans and their tasks can be seen in 
My Tasks and in the Dashboard.

Notifications are sent and exceptions are 
triggered.

Project plan structure can change.

This is the state of a project plan that is 
actively being managed. 
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Project Management also features a set of task states. For a list of task states, 
see Task States on page 82.

Modifying States

Project managers can change states at the master project, subproject, or task 
level at any time.

To change the state of the master project:

1. Open the project plan to edit.

For more details on searching for and opening project plans, see Searching 
for Projects in the Workbench on page 138.

2. In the Project Plan tab, select the row at the top of the hierarchy.

This is the master project.

3. Select a new state for the master project from the drop-down list in the 
State column.

4. Click Save.

To change the state of a task, subproject, or group of tasks or subprojects:

1. Open the project plan to edit.

For more details on searching for and opening project plans, see Searching 
for Projects in the Workbench on page 138.

Completed

Project plans and their tasks can be seen in 
the Dashboard but not in My Tasks.

Notifications are not sent and exceptions 
are not triggered.

This is the state of a project plan that 
has been worked to completion. The 
project plan can be edited but will not 
show up as a project plan or task that 
needs attention.

Cancelled

Project plans and their tasks can be seen in 
the Dashboard but not in the My Tasks 
portlet.

Notifications are not sent and exceptions 
are not triggered.

This state is used for project plans that 
are not complete but will not be worked 
on.

Table 4-1. Project plan states and descriptions  [continued]

Project Plan 
State

Behavior Application
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2. In the Project Plan tab, select the task or subproject whose state you want to 
change.

When selecting a group of tasks or subprojects, be sure they are all in the 
same state.

3. Select a new state for the task or subproject from the drop-down list in the 
State column.

4. Click Save.

Updating Scheduling and Dependencies

Project managers are able to update aspects of a project plan at any time to 
reflect the changing state of a business initiative.

Changing Scheduled Duration, Start, Finish, and % Complete

The Scheduled Duration, Scheduled Start, Scheduled Finish, and % Complete fields 
are viewed in the Project Plan tab.

To change Scheduled Duration, Start, Finish, or % Complete for a task:

1. Open the project plan to edit.

For more details on searching for and opening project plans, see Searching 
for Projects in the Workbench on page 138.

2. In the Project Plan tab, select the task to update. 

� Tasks can be edited directly inside the Project Plan tab. Click on a field 
to edit its contents.

� Tasks can also be edited through the Task Information window, which 
displays more detailed information on a task.

3. Click Edit.

The Project or Task Information window opens, depending on whether you 
have selected a project or task.

If you want to update a subproject’s Scheduled Duration, Start, Finish, or % 
Complete, you must update its individual tasks’ values. This is accomplished by 
selecting a task in the Project window and clicking Edit. You can then follow the 
process described below.
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4. In the Task Information window, click the Details tab. 

5. Update fields in the Details tab.

To update Scheduled Start and Finish dates, enter the desired date in the 
appropriate date field. To make sure these dates are set explicitly and will 
not change after the Schedule Project button is clicked, select a Constraint 
Type (such as Start No Earlier Than or Finish No Earlier Than) from the 
Constraint Type drop-down list.

To update Scheduled Duration and % Complete, enter the new information 
into the appropriate text field.

6. Apply the changes.

To apply changes to the task and continue to update the task without 
closing, click Apply. To apply changes and close the window, click OK.

Changing Predecessors

You can specify which tasks must be completed before beginning another task. 
The tasks that first need to be completed are predecessors of the dependent 
task. Predecessors can be changed directly in the Project Plan tab.
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External tasks, project plans, and requests can also be set as predecessors for 
tasks. For more information on setting these types of predecessors, see Setting 
Up Project Dependencies on page 59.

To change the predecessors for a particular task:

1. Open the project plan to edit.

For more details on searching for and opening project plans, see Searching 
for Projects in the Workbench on page 138.

2. In the Project Plan tab, click the row that contains the task or subproject to 
update.

3. To update predecessors, enter the sequence numbers of the new 
predecessors, separated by semicolons, into the text field of the dependent 
task.

Updating Tasks from the Standard Interface

Many attributes of project plan tasks can be edited simultaneously from the 
standard interface using the Update Tasks page. Table 4-2 lists these attributes.

Table 4-2. Task attributes editable from the Update Tasks page

Task Field

Task State

% Complete

Estimated Finish Date

Estimated Remaining Duration

Estimated Remaining Effort

Actual Start Date

Actual Duration

Actual Effort

Confidence

Resource

Actual Labor Cost

Actual Non Labor Cost
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To make changes to many tasks simultaneously:

1. Open the project plan in the standard interface.

For more details on searching for and opening project plans in the standard 
interface, see Locating Project Plans Using the Project Search Page 
on page 161.

2. In the Project Summary portlet, click Update Tasks.

The Update Tasks page opens.

3. Make the desired updates to any tasks and click Save.

If a task is being updated by another user, changes to that particular task 
will fail and an error message will appear listing any tasks that were unable 
to retain changes.

Concurrent Editing

Project Management allows users to edit and update parts of project plans 
simultaneously, allowing for more efficient representation of changes to a 
project plan.

Unrelated Subprojects in a Master Project

Yukio and Bob are project managers with access to the same master project.

1. Yukio opens the master project and begins working on one of its 
subprojects.

2. Bob opens the same master project and begins working on a different 
subproject.

3. Yukio and Bob are both able to save their changes.

Simultaneous Edits on a Master Project

Yukio and Bob are project managers with access to the same master project.

1. Yukio opens the master project and begins working on one of its 
subprojects.
136 Mercury Project Management™ User’s Guide



 Chapter 4: Managing a Project Plan
2. Bob opens the same master project and tries to edit part of the same 
subproject Yukio is working on.

3. Bob receives a message that another user is currently editing that part of 
the project plan. Bob cannot make changes.

Simultaneous Editing and Updating of a Task

Yukio is a project manager and Carlos is a resource assigned to one of the tasks 
in Yukio’s master project.

1. Yukio opens the master project and begins working on one of its 
subprojects.

2. Carlos would like to update his task, which is part of the subproject Yukio 
is currently editing.

3. Carlos receives a message that another user is currently editing that part of 
the project plan. Carlos cannot make changes.

Updating an Unrelated Task

Yukio is a project manager and Carlos is a resource assigned to one of the tasks 
in Yukio’s master project.

1. Yukio opens the master project and begins working on one of its 
subprojects.

2. Carlos opens his task, which is not part of the subproject Yukio is working 
on, and makes his changes successfully.

3. Yukio opens Carlos’s task.

4. Yukio receives a message that the task has been updated, and the newest 
data will be loaded.

5. The information for Carlos’s task is refreshed in Yukio’s Workbench 
window, while the other changes Yukio made persist.
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Updating the Schedule

If you have modified any of your project plan’s hierarchy, dependencies, 
resources or dates, you might want to re-level the schedule. Project 
Management generates a new schedule based on the updated dates, and 
whatever preferences have been set in the Settings window.

For more detailed information on updating a schedule, see Generating the 
Schedule on page 69.

You can also want to create a new baseline for the project plan. See Taking a 
Baseline on page 75 for more detailed information.

Viewing Project and Task Progress

As a project plan moves through its life, managers can keep track of:

� Projects and tasks as they are completed

� Exceptions that have been triggered

� High-level and low-level accounts of progress

Project Management provides this information through Project Management 
reports and the summary condition view.

Searching for Projects in the Workbench

The Query tab in the Project Workbench window is used to locate and open 
project plans.

To open project plans in the Workbench:

1. From the shortcut bar, select Project Mgmt > Projects.

When a user creates or edits a project or subproject, that user is the only one able to 
save changes. 

In the case of two users wanting to edit two different subprojects under one master 
project, opening and editing only the desired subprojects will enable each user to 
save changes without interfering with each other.

See Concurrent Editing on page 136 for more detailed information.
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The Project Workbench opens. 

2. Enter search criteria into the appropriate fields in the Query tab.

3. To save your query, click Save Query.

You can then perform a quick search using these specified criteria later. To 
clear all information entered into the Project Query fields, click Clear.

4. Click List to return the matching results in the Results tab.

5. From within the Results tab you can:

� Sort the results based on any field in the table by clicking on the 
column header.

� View a project plan by double-clicking on the desired project plan or 
selecting it and clicking Open.

� Open multiple project plans by selecting a group (using Shift+click or 
Ctrl+click from your keyboard) and clicking Open.

Searching for Tasks in the Workbench

You can locate tasks using the Query tab in the Task Workbench window.

To locate specific tasks in the Workbench:

1. From the shortcut bar, select Project Mgmt > Projects.

The Project Workbench opens. 
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2. Select the Task Workbench, behind the Project Workbench, by either clicking 
on its title bar or the Task Workbench button at the bottom of the Workbench 
window.

3. Enter search criteria into the appropriate fields in the Query tab.

4. To save your query, click Save Query.

You can then perform a quick search using these specified criteria later. To 
clear all information entered into the Task Query fields, click Clear.

5. Click List to return the matching results in the Results tab.

6. From within the Results tab you can:

� Sort the results based on any field in the table by clicking on the 
column header.

� View a task by double-clicking on the desired task or selecting it and 
clicking Open.

� Open multiple tasks by selecting a group (using Shift+click or Ctrl+click 
from your keyboard) and clicking Open.

Viewing the Summary Condition

The summary condition is a graphical indicator of the health of a project plan, 
located next to the project plan name. A project plan’s summary condition 
color begins as green and changes to yellow or red depending on the 
percentage of tasks within a project plan that have triggered exceptions. This 
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percentage is configurable in this tab by the project manager. A project plan’s 
summary condition is not calculated until the project plan is saved.

The summary condition view appears in its own column next to the names of 
all project plans in the Results tab of the Project Workbench. For more detailed 
information, see Summary Condition on page 33.

Viewing Milestones

In the Workbench, Milestones are visible in the Project window as black 
diamonds in the Gantt chart.

Figure 4-3. Gantt chart with milestones

The Project Overview page in the standard interface contains two sections that 
display Milestones:

� The Project Milestones section lists the Milestones in a project plan.

Figure 4-4. Project Milestones section
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� The Project Overview Gantt section shows the project plan’s Gantt chart, 
including Milestones.

Figure 4-5. Project Overview Gantt section with milestones

Viewing the Project Plan Critical Path

A project plan’s critical path is composed of all of the tasks in a project plan 
that determine its duration. In Project Management, the critical path of a 
project plan can be displayed in the Project window’s Gantt chart. Tasks that 
are part of the critical path are cross-hatched.

Figure 4-6. Gantt chart with critical path

There are several ways to display or access a project plan’s critical path. 

Viewing the Critical Path in the Project Window

A project plan’s critical path can be displayed in the Project window’s Gantt 
chart. 

To see a project plan’s critical path:

1. In the Workbench, open the project plan.

For more details on searching for and opening project plans, see Searching 
for Projects in the Workbench on page 138.

2. Click Display Options in the upper-right corner of the Project window.

The Gantt Options window opens.
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3. Select the Highlight Critical Path checkbox.

4. Click OK.

5. The Project window’s Gantt chart displays the project plan’s critical path.

Viewing the Critical Path from the Project Overview Gantt Portlet

A project plan’s critical path can also be viewed from the Project Overview Gantt 
portlet in the Project Overview page of the standard interface.

To see a project plan’s critical path in the Project Overview Gantt portlet:

1. Navigate to the Project Overview page of the project plan.

For more detailed information, see Searching for Tasks and Project Plans 
on page 159.

2. Scroll down to the Project Overview Gantt section and click Edit.

The filter page for the Project Overview Gantt section opens.
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3. In the Display Options section of the filter page, select the Highlight Critical 
Path checkbox.

4. Click Done.

5. The Project Overview page opens, refreshing all of the portlets including the 
Project Overview Gantt portlet.
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Obtaining a Critical Path Table

The Project Critical Path report generates a list of all the tasks that comprise a 
Project’s critical path in convenient HTML form.

For more information on running reports in Project Management, see the 
Reports Guide and Reference.

Viewing Exceptions

Exceptions indicate that a rule that has been defined in the project plan has 
been violated for a particular task. For example, resources have not been 
assigned to a task that is due to begin soon, or a task is being completed a 
certain number of days late. Exception rules are configurable; for more 
detailed information, see Setting Up Exception Behavior on page 29.

Tasks that have triggered exceptions can be viewed from the Workbench or the 
standard interface. 

Viewing Exceptions in the Standard Interface

The Exception Details page in the standard interface lists all the tasks in a 
particular project plan that have triggered exceptions. Tasks with an 
Unassigned Task exception can be assigned a resource directly from the Project 
Exception Details page.

To get to the Project Exception Details page for a project plan:

1. Open the project plan in the standard interface.

For more details on searching for and opening project plans in the standard 
interface, see Locating Project Plans Using the Project Search Page 
on page 161.

2. In the Project Exception Summary portlet, click Exception Details.

The Project Exception Details page opens.

3. Drill down to any tasks that merit attention.

Unassigned tasks can be assigned a resource directly from the Project 
Exception Details page.
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Viewing Exceptions in the Workbench

Exceptions that have been triggered display as a red exclamation mark in the 
first column on the left in the Results tab of the Task Workbench.

To view a particular triggered exception for a task:

1. Select a task in the Project Plan tab.

2. Click Edit.

The Task Information window opens.

3. Click the Exceptions tab.

The Exceptions tab lists the exception rules for the project plan containing 
that particular task. 

Depending on whether you have the proper access grant to edit the task, the button 
in the Project window might read Edit or View. Users who can only View a task 
include project plan participants who have not been assigned to that particular task, 
as well as project managers who are not managing the project plan within which that 
particular task is contained.
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� The red exclamation point in the Triggered column indicates that the 
task has triggered an exception. 

� The Violation column displays the number of days the task is from the 
exception.

Using the Mercury IT Governance Dashboard to View Progress

Project managers can also view project plans using the standard interface. This 
interface comes with a configurable set of application windows, known as 
portlets, through which common Project Management queries and actions can 
be performed.

This interface can be expanded to include the Mercury IT Governance 
Dashboard, which offers an expanded set of portlets that feature additional 
functionality, such as the Project List portlet. 

Project Management Reports

Project Management is capable of generating a wide range of reports for 
project management purposes. For example, a manager could query for the 
custom fields being used in a project plan. A manager can also generate reports 
on any tasks that had triggered exceptions, the resources assigned to a project 
plan or which security groups are associated with a project plan.

For a full list of Mercury IT Governance Center reports, see Reports by 
Category on page 269.

For more detailed information about Project Management reports, see the 
Reports Guide and Reference.

Comparing Against the Baseline

If you have taken a baseline of your project plan, you might want to compare it 
to your current project plan. This can be done using the Project Schedule 
Change report, which can compare the current project plan to any baseline, or 
baselines to each other.
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Figure 4-7. Project Schedule Change report 

For more information on running reports in Project Management, see the 
Reports Guide and Reference.
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Tracking and Analyzing Project Plan Costs

Mercury IT Governance Center’s Financial Management capabilities allow 
you to track and analyze project plan costs in ways including the following:

� Capturing and comparing financial data in budgets including rollups from 
project plans 

� Using Mercury Time Management to track task costs

� Performing analyses of project cost data in graph and portlet form

� Enforcing SOP 98-1 compliance at the project plan level with project 
templates

� Enabling the use of different currencies depending on project participants’ 
locations

See the Mercury Financial Management User’s Guide for more detailed 
information on cost data, budgets, currencies, exchange rates, and SOP 98-1 
compliance.

Tracking Project Plan History

Project Management maintains a state change history for both project plans 
and tasks. The transaction history includes the date, user name, project or task 
name, and project or task state.

To view the state change history for a particular task:

1. In the Project Plan tab, select the task whose state change history you want 
to view.

2. Select Project > View > State Change History from the View drop-down list. 

The State Change History window opens.
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3. Click Refresh to update the history list.

4. Click Close to close the window.

To view the state change history for a particular subproject:

1. In the Project Plan tab, select the subproject whose state change history you 
want to view.

2. Select Project > View > State Change History from the View drop-down list. 

The State Change History window opens.

3. Click Refresh to update the history list.

4. Click Close to close the window.

Completing, Cancelling, and Deleting Project Plans

All project plans must reach an endpoint. The project plan can either be 
brought to completion, or reach a point where no more work can be done. 
Project plan states provide distinct ways of differentiating between project 
plans that have been Completed or Cancelled. For more detailed information 
on project plan states, see Project Plan States on page 131.

When a user creates or edits a project plan or subproject, that user is the only one 
able to save changes. 

In the case of two users wanting to edit two different subprojects under one master 
project, opening and editing only the desired subprojects will enable each user to 
save changes without interfering with each other.

See Concurrent Editing on page 136 for more detailed information.
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Completing Project Plans

Project managers can set the project plan state to Completed. For more 
information, see Modifying States on page 132.

If a project plan is manually set to Completed:

� Any incomplete tasks under that project plan are set to Bypassed.

� Any incomplete projects under that project plan are set to Completed.

Reopening a Completed Project Plan

A project plan that is Completed can be moved to On Hold.

� Upon moving the project plan from Completed to On Hold:

� Bypassed tasks will move to a task state of New.

� If the project plan is moved to Active:

� Task states will be recalculated.

� Tasks previously In Progress will not regain the task state of In 
Progress.

To change a Completed project plan’s state:

1. Open the project plan to edit.

For more details on searching for and opening project plans, see Searching 
for Projects in the Workbench on page 138.

2. In the Project Plan tab, select the project plan at the top of the hierarchy.

This will be the master project.

3. Select a new state for the master project from the drop-down list in the 
State column.

4. Click Save.
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Canceling Project Plans

Occasionally, all work on a particular business initiative can be stopped. The 
endeavor might have been found to be unprofitable, it might not be feasible 
given current resource limitations or there might be another business reason. 
Project plans can have their states changed to Cancelled to reflect this 
circumstance. 

� If a project plan is manually set to Cancelled, any incomplete tasks or 
project plans under it are set to Cancelled.

� From Cancelled, a project plan can be moved back to On Hold using the 
same procedure as Reopening a Completed Project Plan on page 151. 
Upon moving the project plan from Cancelled to On Hold, bypassed tasks 
will move to a task state of New.

� Once the project is moved into an Active project plan state:

� Task states will be recalculated.

� Tasks previously In Progress will not regain the task state of In 
Progress.

Deleting Project Plans

Once a project plan has been completed, it continues to reside in the Mercury 
IT Governance database. It might not be necessary to archive completed 
project plans in the Mercury IT Governance Center system. Project plans can 
be deleted from the Results tab of the Project Workbench. 

To delete a project plan:

1. Locate the project plan that you want to delete using the Query tab of the 
Project Workbench.

2. In the Results tab of the Project Workbench, select the project plan you 
want to delete.

3. Click Delete.

Subprojects cannot be deleted from the Results tab of the Project Workbench.
152 Mercury Project Management™ User’s Guide



 Chapter 4: Managing a Project Plan
Creating a URL to Open the Project Plan Window

Project managers and can construct a Web address (URL) that opens their 
project plan in the Workbench. They can then use this URL to access the 
project plan from the World Wide Web or from their Intranet.

Users can construct this URL manually using either of the following formats:

http://host:port/mercury/servlet/
SmartURL?screen=PRJ&pkid=PROJECT_ID
http://host:port/mercury/servlet/
SmartURL?screen=PRJ&pkname=PROJECT_NAME

You can also configure your task notifications to automatically create and send 
these URLs in an email message. Include the following token in the Message 
area in the Notification window. When the email is sent, the full URL will be 
displayed.

[PRJ.WORKBENCH_PROJECT_URL] 

See Using Smart URLs in Notifications on page 94 for more information on 
setting up task notifications and using Smart URLs.

Printing a Project Plan Gantt Chart

A project plan Gantt chart can be printed or exported to an image file for use in 
presentations.

Printing a Gantt Chart

To print a project plan Gantt chart, select File > Print from the menu at the top 
of the Workbench. The Print Gantt Chart wizard opens, allowing you to select 
options for the Gantt chart’s project plan display, time range, project plan 
columns, and generic printer settings.
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Figure 4-8. Print Gantt Chart wizard

Exporting a Gantt Chart to an Image File

A project plan Gantt chart can also be exported to an image file with the same 
options as normal printing. The following file formats are supported:

� JPEG

� PNG

� GIF

� BMP

To export a project plan Gantt chart to an image, select File > Export to Image 
from the menu at the top of the Workbench. The Export Gantt Chart wizard 
opens, allowing you to select options for the Gantt chart’s project plan display, 
time range, project plan columns, and generic image settings.
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Figure 4-9. Export Gantt Chart wizard
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� Deleting References
� Visibility Between Project Plans and Programs
� Running Reports

Overview of Updating Tasks

This chapter explains how project plan participants locate, update, modify, and 
report on tasks to which they are assigned.

Locating Tasks

Project Management defines project plan participants as users who work on 
tasks as part of a project team, but do not have the administrative 
responsibilities of a project manager. Project plan participants view and update 
their tasks using the standard Project Management interface.

Project plan participants update their task status in Project Management. 
Project Management provides several different ways for participants to locate 
their tasks:

� Searching for Tasks and Project Plans
Project plan participants can search for tasks directly, or they can search for 
project plans in order to get to the tasks they want through the project plans 
that contain them.

� Finding Tasks Using the My Tasks Portlet
The My Tasks portlet allows users to update multiple tasks at once, as well 
as providing links to individual task details.

� Finding Tasks Using Notifications
Tasks can be reached from a notification simply by clicking on the link 
provided in the body of the email, or by copying and pasting it into any 
Web browser.

� Finding Tasks in the Workbench
Project plan participants can also search for and update tasks in the 
Workbench.
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Searching for Tasks and Project Plans

Participants can search for tasks and project plans that match certain criteria 
using the Task Search and Project Search pages.

Locating Tasks Using the Task Search Page

Participants can search for tasks using the Task Search page. 

To locate tasks in Project Management:

1. Log on to Mercury IT Governance Center.

2. From the menu bar, select Search > Tasks.

The Task Search page opens.

3. Enter the search criteria for the desired task.

You can search for an existing task based on any of the fields located on 
the Task Search page. Limiting the maximum number of results in the 
Maximum Tasks Displayed field can yield quicker results.

4. Click Search.

The Task Search Results page opens, displaying the results matching your 
search criteria.
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5. Click on the name of any task in the list to view its Details page. 

See Viewing and Updating Task Details on page 176 for more information. 
To clear all fields in the Task Search Query page and reset to default values, 
click Clear Fields.
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Locating Project Plans Using the Project Search Page

While project plan participants can locate and view project plans, only 
participants with a Project Manager access grant can edit project plans, through 
the Workbench interface. Participants can locate project plans using the Project 
Search page. 

To search for project plans in Project Management:

1. Log on to Mercury IT Governance Center.

2. From the menu bar at left, select Search > Projects.

The Project Search page opens.

3. Enter the search criteria for the desired project plan.

You can search for an existing project plan based on any of the fields 
located on the Project Search page. Limiting the maximum number of 
results in the Maximum Projects Displayed field can yield quicker results.

4. Click Search.

The Project Search Results page opens, displaying the results matching your 
search criteria.
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5. Click on the name of a project plan to view its Project Overview page. 

See Viewing Project Overview on page 166 for more information. To clear 
all fields in the Project Search page and reset to default values, click Clear 
Fields.

Finding Tasks Using the My Tasks Portlet

The My Tasks portlet is available to all Project Management users. This portlet 
is included on your Mercury IT Governance Center home page by default. It 
shows a configurable list of the tasks currently assigned to the user.

Participants can update task states and fill in information that the project 
manager would like to collect for all tasks displayed. In this way, the My Tasks 
portlet can save valuable time by providing a single point for multiple tasks to 
be updated at once.

The participant can also click on the name of a task in the task list to view its 
Details page. See Viewing and Updating Task Details on page 176 for more 
information.

Figure 5-1. My Tasks portlet
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Finding Tasks Using Notifications

Email notifications can be configured by project managers to include 
hyperlinks to tasks in Project Management. If you have received an email 
containing a link to a task, click on it, and it will open to that task’s Details page 
in your Web browser. If your email client doesn’t handle HTML links directly, 
copy and paste it into your Web browser.

Finding Tasks in the Workbench

The Workbench is the Java application that allows for configuration as well as 
creation and processing of project plans, project templates, and tasks. Project 
plan participants can also search for and update tasks in the Workbench.

Project plan participants can find tasks by searching for them directly, or by 
looking for the project plans that contain them.

Searching for Tasks in the Workbench

You can locate tasks using the Query tab in the Task Workbench window.

To search for tasks from within the Workbench:

1. Log on to Mercury IT Governance Center and open the Workbench.

2. From the shortcut bar, select Project Management > Projects.

The Project Workbench opens.

3. Select the Task Workbench, behind the Project Workbench, by either clicking 
on its title bar or clicking Task Workbench at the bottom of the Workbench 
window.
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4. Enter search criteria into the associated fields.

To save your query, click Save Query. You can then perform a quick search 
using these specified criteria anytime later.

5. Click List to return the matching results in the Results tab.

6. From within the Results tab:

� View a task by double-clicking on the desired task or selecting it and 
clicking Open. The Task Information window opens.

� Open multiple tasks by selecting a group (using Shift+select or 
Ctrl+select) and clicking Open. Many Task Information windows open, 
one for each selected task.

7. Update task information in the Task Information window.

For details on updateable fields, see Updating Tasks in the Task 
Information Window on page 166.

Searching for Project Plans in the Workbench

The Query tab in the Project Workbench window is used to locate and open 
project plans.

To search for project plans from within the Workbench:

1. Log on to Mercury IT Governance Center and open the Workbench.

2. From the shortcut bar, select Project Management > Projects.

The Project Workbench opens, with the Query tab defaulted to appear on top.
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3. Enter search criteria into the associated fields.

4. To save your query, click Save Query.

You can then perform a quick search using these specified criteria anytime 
later.

5. Click List to return the matching results in the Results tab.

6. From within the Results tab:

� View a project plan by double-clicking on the desired project plan or 
selecting it and clicking Open. The Project window opens.

� Open multiple project plans by selecting a group (using Shift+select or 
Ctrl+select) and clicking Open. Multiple Project windows open, one for 
each selected project plan.

7. From within the Project window, you can edit tasks directly, or edit them in 
the Task Information window.

See the following sections, Updating Tasks in the Project Plan Tab and 
Updating Tasks in the Task Information Window, for more information.

Updating Tasks in the Project Plan Tab

Project plan participants can update tasks displayed in the Project Plan tab.

To update task information from the Project Plan tab:

1. Select the task to update. 

2. Click on the desired field to update its contents directly.

Project plan participants can only update the fields that have been enabled 
for them to edit by the project manager. This set of fields can vary. 
Additionally, participants can only update those tasks that have been 
assigned to them. All other tasks will be view-only. This is also true for 
project managers viewing tasks and project plans that they are not in 
charge of.
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Updating Tasks in the Task Information Window

Project plan participants can also update tasks inside the Task Information 
window of each task.

To edit task information in the Task Information window:

1. Open the Task Information window by one of the following ways:

� Query and open the task directly from the Task Workbench. The Task 
Information window opens.

� Query and open an existing project plan. Double-click the task to edit, 
or select it and click Edit. The Task Information window opens.

2. Make all necessary changes in the Task Information window.

3. Click OK.

Project plan participants can only update the fields that have been enabled 
for them to edit by the project manager. This set of fields can vary. 
Additionally, participants can only update those tasks that have been 
assigned to them. All other tasks will be view-only. This is also true for 
project managers viewing tasks and project plans that they are not in 
charge of.

Viewing Project Plan Information

Project plan participants might want to view the project plans they are part of 
in the standard interface, as a way of setting context for their own tasks, 
checking on other dependent tasks, or keeping track of deadlines.

Viewing Project Overview

The Project Overview page displays a wide range of information about a 
particular project plan: its subprojects and tasks, its state and project manager, 
and any exceptions it might have triggered. All of this data and more is 
presented and arranged through the following sections of the Project Overview 
page:

� Project Summary
Displays the project plan’s name, state, % complete, manager, description, 
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scheduled start, and scheduled finish. It also contains a link to the Project 
Details page. See Viewing Project Plan Details on page 169.

� Project Overview Gantt 
Displays the Gantt chart for a project plan. See Viewing the Project Plan 
Gantt Chart on page 173.

� Project Milestones 
Lists the Milestones in a project plan. See Viewing Project Plan Milestones 
on page 174.

� Subprojects and Tasks Summary
Provides a list of all subprojects and tasks included in that project plan, as 
well as a link to the project plan, located on the Project Hierarchy page. See 
Viewing Project Plan Hierarchy on page 170.

� Exception Summary
Shows the number and kinds of exceptions triggered and links to the 
Exception Details portlet. See Viewing Exceptions on page 171.

� Project References
Provides a list of all references linked to the project plan (requests, 
packages, tasks, other project plans, releases, attachments, URLs) and 
where in the project plan they are referenced from. See Viewing Project 
References on page 172.

� Project Related Actions 
Displays links to a project plan’s assignment visualizations and staffing 
profiles. See the Mercury Resource Management User’s Guide for more 
details.
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Figure 5-2. Project Overview page

Users can access the Project Overview page through the Project Search Results 
page, as well as the Project List portlet, which is available for display on the 
participant’s Mercury IT Governance Center Home page as part of the 
Mercury IT Governance Dashboard. 
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Viewing Project Plan Details

The Project Details page contains detailed information on a particular project 
plan, grouped into the following categories:

� Progress
% complete, confidence, start date (scheduled and actual), finish date 
(scheduled, estimated, and actual), duration (scheduled, estimated 
remaining, and actual), and effort (scheduled, estimated remaining, and 
actual).

� Details
Project number, project template, department, description, priority, 
complete and incomplete predecessors.

� Action Items
Action item names, states, and priorities.

� Notes
Any notes.

� References
Requests, packages, other project plans, URLs, and attachments.

Figure 5-3. Project Details page

The Project Details page can be accessed through the Project Summary section in 
the Project Overview page, which contains a link to the Project Details page. 
Click Project Details to go to the Project Details page.
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Figure 5-4. Project Summary section 

Viewing Project Plan Hierarchy

The Project Hierarchy page displays the project plan’s hierarchical organization 
of tasks and subprojects as well as information such as:

� Task or subproject name

� Task or subproject state

� Task or subproject scheduled duration, start, and finish

� Task or subproject predecessors

� Task or subproject resource or manager

� Task exceptions or subproject summary condition

The Project Hierarchy page is useful for providing context for participants in 
terms of the location of their tasks in the overall project plan framework, as 
well as indicating summary conditions and exceptions at a glance.

Clicking on any task within the Project Hierarchy page takes the user to that 
task’s Details page. See Viewing and Updating Task Details on page 176 for 
more detailed information.
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Figure 5-5. Project Hierarchy page

The Project Hierarchy page can be accessed through the Subprojects and Tasks 
Summary section in the Project Overview page, which contains a link to the 
Project Hierarchy page. Click Project Hierarchy to go to the Project Hierarchy 
page.

Figure 5-6. Subprojects and Tasks Summary section 

Viewing Exceptions

The Project Exception Detail page displays the exceptions that have been 
triggered for the project plan being viewed, breaking each triggering task down 
according to:

� Exception type and number of days violated

� Task state, resource, scheduled start and finish

� Project path
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This is useful for participants in that it provides specific context for every 
exception in a project plan, telling them what task has gone wrong (or what 
might go wrong, depending on the exception rules enabled), when it went 
wrong, and where the problem task is located. Additionally, tasks that have not 
been assigned a resource can be assigned one directly from the Project 
Exception Detail page.

Figure 5-7. Project Exception Detail page

Getting to the Exception Detail Page

The Project Exception Summary section in the Project Overview page contains a 
link to the Project Exception Detail page. Click Details to go to the Project 
Exception Detail page.

Figure 5-8. Project Exception Summary section 

Viewing Project References

The Project References section in the Project Overview page displays all entities 
linked to the project plan as references. References (requests, packages, tasks, 
other project plans, releases, attachments, and URLs) are listed with details 
including:

� Reference Type

� Description

� Referenced By

The Project References section provides a convenient single point of access for 
all entities referenced by a project plan.
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Figure 5-9. Project References section

Viewing the Project Plan Gantt Chart

The Project Overview Gantt section, displayed on the Project Overview page, 
shows the project plan’s Gantt chart including Milestones.

Figure 5-10. Project Overview Gantt section

Display criteria for the Gantt chart can be configured by clicking Edit, which 
opens the portlet’s filter page.

Figure 5-11. Project Overview Gantt section filter page - Display Options 

section
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Viewing the Critical Path

The critical path of a project plan is made up of the tasks that define its 
duration. A project plan’s critical path can be displayed in the Project Overview 
Gantt section by clicking Edit and selecting the Highlight Critical Path checkbox.

Viewing Project Plan Milestones

Milestones are used to mark significant events in a project plan, often the 
completion of a deliverable or arrival of a deadline. In the Project Overview 
Gantt portlet, milestones appear as black diamonds.

Milestones are also listed in the Project Milestones section, displayed on the 
Project Overview page.

Figure 5-12. Project Milestones section

Viewing Resource Information

Resources can view information on their current assignments using the View 
Resource page. The View Resource page includes a chart of their capacity and a 
customized Gantt chart illustrating their assignments for the next two weeks, or 
a time period of their choosing.

Project managers with the proper level of access can also view information on 
resources including their cost rate and workload capacity. Figure 5-13 
illustrates a View Resource as shown to a manager with access to cost data.
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Figure 5-13. View Resource page for a manager with cost access

To open the View Resource page, select Search > Resources from the menu bar. 
Enter any search criteria into the Search Resources page and click Search.

Updating Tasks

Project Management makes it easy for project plan participants to report on 
different aspects of tasks in multiple levels of detail:

� Viewing and Updating Task Details
Participants can view their tasks in detail, updating and saving information 
such as task progress, attachments, and action items.

� Viewing and Updating Multiple Tasks
Multiple tasks can also be updated simultaneously, with information 
deemed essential by the project manager available to update immediately.
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Updating a task can trigger events in the project plan that move it along its path 
to completion.

Viewing and Updating Task Details

The Task Details page contains detailed information on multiple aspects of a 
single task. Many fields in the Task Details page are updateable by project plan 
participants.

To update fields in the Task Details page:

1. Make the update in the desired field.

2. Click Save.

To clear all changes and reset all fields to their previous values, click 
Reset.

A task in a project plan that has predecessor tasks associated with it cannot be 
marked Complete until its predecessors have been completed, unless a project 
manager attempts it.

In order for updates to take effect, the participant must click Save. Only then will 
Project Management take into account the updates that have been made.
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Getting to the Task Details Page

A relevant task must first be located in order to get to its Details page and 
update its information. There are several ways for participants to locate and 
view details for any tasks that might require their attention:

� Searching for Tasks and Project Plans on page 159

� Finding Tasks Using the My Tasks Portlet on page 162

� Finding Tasks Using Notifications on page 163

Any task’s Details page can also be reached from the Project Hierarchy page. See 
Viewing Project Plan Hierarchy on page 170 for more detailed information.
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Viewing and Updating Multiple Tasks

Sometimes it might be necessary for a project plan participant to only update a 
specific task detail, such as the Task State or % Complete. The My Tasks portlet 
is perfectly suited to this need, and has the added advantage of being able to 
show multiple tasks at once.

The fields collected by the portlet can be configured by project managers. See 
Selecting Information to Track and Display on page 28 for details.

The My Tasks portlet displays information for multiple tasks. The maximum 
number of tasks displayed can be specified by the user, as well as the portlet 
title. Most fields in the My Tasks portlet are updateable by project plan 
participants. 

To update fields in the My Tasks portlet:

1. Make the update in the desired field.

2. Click Save.

To clear all changes and reset all fields to their previous values, click 
Reset.

Figure 5-14. My Tasks portlet

Getting to the My Tasks Portlet

The My Tasks portlet is defaulted to display on a project plan participant’s 
home page. The home page can be reached at any time by selecting 
Dashboard > My Pages > Front Page from the menu bar at left.

In order for updates to take effect, the participant must click Save. Only then will 
Project Management take into account the updates that have been made.
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Viewing and Adding Notes

Notes are available for viewing and editing in the Task Details page. See 
Viewing and Updating Task Details on page 176 for information on the Task 
Details page.

To create a new note:

1. Get to the Details page of the task to update.

2. Type the new note into the New Note text field.

3. Click Save.

Viewing and Modifying References

Project Management features a number of methods for capturing additional 
information, or references, related to your project plans. Tasks can include 
references to other entities or points of information, allowing easy access and 
visibility to data related to the current project plan. The following references 
can be attached to a task:

� Requests

� Packages

� URLs

� Attachments (anything that can be placed on a server: PDF files, JPEG 
images, Java .class files, and so forth)

� Tasks

� Other project plans

� Releases

References are attached from the Task Details page. References can be added 
and modified using both the standard interface and the Workbench.
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Adding References to Tasks

You can reference a Web accessible file or attach a file from your local 
machine to the current task. You can also reference an existing Mercury IT 
Governance Center entity (request, package, project plan, or task). 

To attach references to a task:

1. Open the Task Details page using one of the following methods:

� Search for and open the task directly using the Search > Tasks menu 
option.

� Query and open an existing project plan using the Search > Projects 
menu option. Locate the task within the project plan and open the Task 
Details page.

2. Scroll down to the References section of the page.

3. Select a reference type from the New Reference drop-down list. 

4. Click Add.

A page corresponding to the selected reference type opens. Enter the 
reference on this page. For certain reference types, you have the option of 
searching for a reference.

5. Attach the reference. 

6. Click Save on the Task Details page.

Attaching Existing Mercury IT Governance Center Entities

You can attach an existing Mercury IT Governance Center entity (request, 
package, project plan, or task) to a task.

To attach an existing Mercury IT Governance Center entity to a task:

1. Navigate to the Task Details page and scroll down to the References section.
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2. Select <Entity> (Existing) (<Entity> can be Task, Project Plan, Request 
(Existing), Request (New), Package (New), or Package) to be added from the 
New Reference drop-down list.

3. Click Add.

A page opens presenting search criteria for the request, package, release, 
project plan, or task to be referenced.

4. Enter the appropriate information and click Search.

A page opens presenting search results.
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5. Select the checkbox next to the entity or entities to be referenced.

To check all boxes, click Check All. To deselect all boxes, click Clear All.

6. Select a relationship for the referenced entities from the drop-down list at 
the top of the page.

For a complete list of all reference relationships, see Dependency 
Relationships on page 113.

7. Click Add.

The referenced entities appear in the References to be added on Save list on 
the Task Details page. The references have not been added yet.

8. Click Save to add the references to the task.

Attaching New Requests

A new request can be created from the References section of the Task Details 
page.

To create a new request from the references section of the Task Details page:

1. Select Request (New) from the New Reference drop-down list.

2. Click Add.
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The Create New Request page opens.

3. Choose the request type that you want to generate from the Request Type 
drop-down list in the Create New Request section.

A description of each request type displays below the list. To save time, the 
most recently created request types will be first on the list.

4. Select the relationship for the new request from the Relationship drop-down 
list.

5. Click Create.

6. Enter the information related to your new request in the Create New Request 
page.

Required fields are displayed in red. If you would like to make additional 
comments on the request, enter them in the Notes field.

7. Save and submit the new request.

The referenced request appears in the References to be added on Save list on 
the Task Details page. The reference has not been added yet.

8. Click Save to add the reference to the task.

Attaching Files

To add a file as a reference:

1. Navigate to the task’s Details page and scroll down to the References 
section.
Viewing and Modifying References 183



 Chapter 5: Updating Tasks: Project Plan Participant Activities
2. Select Attachment from the New Reference drop-down list.

3. Click Add.

The Add Document page opens.

4. Select the desired file from your local machine and enter a description if 
desired.

5. Click Add to add the selected attachment as a reference.

The referenced attachment appears in the References to be added on Save 
list on the Task Details page. The reference has not been added yet.

6. Click Save to add the attachment to the task.

Attaching URLs

To add a URL as a reference:

1. Navigate to the Task Details page and scroll down to the References section.

2. Select URL from the New Reference drop-down list.

3. Click Add.

The Reference URL page opens.
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4. Type the URL into the URL field and enter a description if desired.

5. Click Add to add the specified URL as a reference. 

The referenced URL appears in the References to be added on Save list on 
the Task Details page. The reference has not been added yet.

6. Click Save to add the reference to the task.

Viewing and Editing References

You can view the references that have been linked to a task. The references are 
listed in the References section of the Task Details page.

To view the references currently linked to the task:

1. Open the Task Details page.

2. Scroll down to the References section.

Expand and collapse sections by clicking the + and - icons to view 
additional details.

3. Click on the name of the reference you want to view.

� If the reference is a URL, it opens inside your Web browser.

� If the reference is a file of any other kind, it is handled by your Web 
browser in the usual fashion, either opening directly or asking to be 
saved to your local machine.

� If the reference is a project plan, its Project Overview page opens, 
displaying summary information related to that particular project plan.
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� If the reference is another Mercury IT Governance Center entity 
(request, package, or task) it will open the entity’s Details page.

If you have permission to edit the task, you can modify the task’s references. In 
addition to adding new references, you can delete and change the relationships 
of existing references. The following figure illustrates the functionality related 
to references.

Figure 5-15. Task Detail page References section 

You can also view references related to your tasks and project plans using the 
Project References section on the Project Overview page. Add the section to the 
Project Overview page and then personalize it to show the references that are 
relevant to your activities. The section can be personalized to display 
references based on the following information: Reference types, relationship, 
time period when they were added, and whether or not they are preventing 
actions on tasks. 

If you have licenses for Mercury Demand Management and Mercury Change 
Management, you can click the request or package to access their detail pages. You 
can then update those entities according to normal Mercury IT Governance Center 
operation. 

Lists current
references.

Select a new 
Relationship from 
the drop-down list.

Add new
references.

Click Save to save
your changes.
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Figure 5-16. Project References section

Deleting References

If you have permission to edit the task, you can delete the task’s references. 

To delete a task reference:

1. Navigate to the Task Details page and scroll down to the References section.

2. Click the X to the left of the reference.

A message will appear asking you to confirm the deletion. 

3. Click Yes.

The reference is removed from the task.

Figure 5-17. Task Detail page References section

Click X to remove
the reference.
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Visibility Between Project Plans and Programs

Mercury Program Management provides a way for managers to link multiple 
project plans together as programs, and to submit and track requests against 
them.

Organizations implement a Program Management Office in order to:

� Ensure alignment of IT projects with business objectives

� Eliminate duplicate and non-priority efforts

� Improve operational efficiency

� Leverage resources

� Ensure on-time and on-budget delivery

Programs can be tracked and analyzed with the same kind of familiar Cost 
metrics as project plans.

For more detailed information on Mercury Program Management, see the 
Mercury Program Management User’s Guide.

Running Reports

You can run reports on your Project Management information from the 
Reports menu group in the menu bar.
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Figure 5-18. Project Custom Detail report creation page

This example of a report creation page shows the required and optional fields 
for the Project Custom Detail report. Each report type has its own set of 
required and optional fields. The report creation page always displays a 
different set of fields depending on which report type is selected. See the 
Reports Guide and Reference for more information.
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In This Chapter:
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� Setting Ownership for a Project Template
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Overview of Using Project Templates

This chapter explains how to create and use project templates in Project 
Management.

Setting up a Project Template

Project templates are used in Project Management to create repeatable 
processes to be used as a model and basis for numerous master projects. 
Templates can also be created and then imported as a subproject into a master 
project.

Project templates speed up the process of setting up your project plans. A 
repeated set of tasks are bundled into a template and dropped into any project 
plan while preserving its notifications, project plan, and any custom fields the 
template can have.

For example, a company with several different software products might use the 
same process for all development efforts. A project template could be used to 
create the master project for each one, as opposed to creating them all 
individually every time a project is planned. Information for each individual 
project plan can then be modified by a particular project manager as needed.

Project templates consist of three parts: 

� Project Plan
An ordered list of tasks. The sequence of tasks is identical in form and 
function to the Project Plan tab.

� Any custom fields created by the user
Configurable custom fields define and collect any necessary information 
that is not already covered by standard task or project plan detail fields. 

� Project Template settings
Settings for a project template work the same way as settings for a master 
project.
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Figure 6-1. Project Template window

Adding Tasks to a Project Template

The process of adding tasks to a project template is identical to adding tasks in 
the Project Plan tab. See Adding Tasks to the Project Plan Tab on page 50 for 
details.

Creating Custom Fields for Project Templates

Project managers can create custom fields that collect information not covered 
by project plan or task detail fields. Custom fields are unique to each template. 

Defining Custom Fields for Project Templates

To add a custom field to a project template:

1. Log on to Mercury IT Governance Center and open the Workbench.

2. From the shortcut bar, select Project Management > Project Templates.

The Project Template Workbench opens.

Project templates do not contain references, action items, or notes. Some fields 
cannot be updated.
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3. Open an existing template by searching for and double-clicking the 
template, or create a new template by clicking New.

The Project Template window opens.

4. Click Custom Fields.

The Custom Fields for Project Template window opens.

5. Click New.

The Field: New window opens.
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6. Enter the general field information which includes the following:

� Field Prompt

� Token

� Validation

7. In the Attributes tab, enter information as described in Table 6-1.

8. Click the Default tab.

9. Enter information as described in Table 6-2.

Table 6-1. Field window Attributes tab fields

Field Description

Parameter Col.
Used to determine the place in the internal database 
column where the field value is stored. Fields in a project 
template cannot use the same column number.

Transaction History
Controls the transaction auditing facility for this field. If set to 
Yes, whenever this field changes in a project plan, the 
change is logged in a transaction history table.

Display Only
Determines if the field is only displayed and cannot be 
updated. To use the logic defined in the Dependencies tab, 
select Use Dependency Rules.

Notes History
Turns notes auditing on or off for this field. If set to Yes, 
whenever this field changes in a project plan, the change 
will be logged in the notes.

Required
Determines if the user is required to specify a value for this 
field. To use the logic defined in the Dependencies tab, 
select Use Dependency Rules.

Workbench Only
Determines if the field is visible in the Workbench only and 
not in the HTML interface.
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10. Click the Dependencies tab.

11. Enter information as described in Table 6-3.

12. Click the Security tab to define the field security.

See Setting Visibility at the Field Level for details.

Table 6-2. Field window Defaults tab fields

Field Description

Default Type
Defines if the field will have a default value. Either defaults the field 
with a constant value by selecting Constant, or with a value from 
another field by selecting Parameter.

Visible Value
If Default Type is set to Constant, enter the constant value in this 
field. This value should be what the user would normally enter in 
the field.

Depends On

If the Default Type is set to Parameter, select the token name of 
that field. At runtime, any value that is entered or updated in the 
source field will automatically be entered or updated in this 
destination field.

Table 6-3. Field window Dependencies tab fields

Field Description

Clear When Changes
Indicates that the current field should be cleared when the 
specified field changes (the field needs to be on the project 
template).

Display Only When

Indicates that the current field should only be editable 
when certain logical criteria are satisfied. This field 
functions with two adjacent fields: a drop-down list 
containing logical qualifiers and a text field. To use this 
functionality, select Use Dependency Rules in the 
Attributes tab.

Required When

Indicates that the current field should be required when 
certain logical criteria are satisfied. This field functions with 
two adjacent fields: a drop-down list containing logical 
qualifiers and a text field. To use this functionality, select 
Use Dependency Rules in the Attributes tab.
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13. Click Add to save the configuration for this custom field and create 
additional custom fields, or click OK to save the configuration for this 
custom field and close the Field: New window.

Setting Visibility at the Field Level

By default, all fields are set to be visible to all users and editable by all users. 
Field visibility and editability can be controlled from the Field window’s 
Security tab using the Edit Field Security window. To configure field visibility 
from the Field window:

1. Open the desired project template.

2. Click Custom Fields to open the Custom Fields for Project Template window.

3. Select the desired field and click Edit.

The Field window opens.

4. Click the Security tab.

5. Click Edit.

The Edit Field Security window opens.
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6. Deselect the Visible to all users box to begin fine-tuning field properties.

7. Make a choice from the Select Users/Security Groups that can view this field 
drop-down list.

You can select a User, Security Group, Standard Token, or User Defined 
Token.

8. Once you have made your choice from the drop-down list, select the user, 
security group, or token from the auto-complete list.

If you want to assign the selected user, security group, or token editing 
rights as well as viewing rights to the field, select the Provide Editing Rights 
checkbox.
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9. Click the Add arrow button to add the selected user, security group, or 
token to the This field is visible to these Users/Security Groups area.

If you change your mind about granting the selected user, security group, 
or token editing rights, you can deselect the box in the Editable column of 
the This field is visible to these Users/Security Groups area. The field will then 
be visible but not editable to the selected user, security group, or token. To 
remove viewing rights entirely, select the user, security group, or token and 
click Remove.

10. When you are finished adding users, security groups, or tokens to the This 
field is visible to these Users/Security Groups area, click OK to save changes 
and return to the Security tab.

The Security tab is updated with the list of users, security groups, or tokens 
with viewing or editing rights to the field.
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Modifying the Layout of Custom Fields

You can modify the graphical representation and placement of the custom 
fields in the project template. These changes are made in the Layout tab in the 
Custom Fields for Project Template window.

Figure 6-2. Custom Fields for Project Template Layout tab

Modifying Custom Field Widths

To change the column width of a project template’s custom field:

1. Open the desired project template.
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2. Click Custom Fields to open the Custom Fields for Project Template window.

3. Click the Layout tab.

4. Select the custom field.

5. Select either the 1, 2, or 3 choice in the Width drop-down list.

For custom fields of component type Text Area, the number of lines the text 
area displays can be specified. Select the field in the Layout tab and change 
the value in the Component Lines attribute. If the selected custom field is not 
of the type Text Area, this attribute is blank and cannot be updated.

Moving Fields

To move a custom field or set of custom fields:

1. Open the desired project template. 

2. Click Custom Fields to open the Custom Fields for Project Template window.

3. Click the Layout tab.

4. Select the custom field(s).

To select more than one custom field, press the Shift key while selecting 
the last custom field in a set. Only a group of adjacent fields can be 
selected.

5. Use the directional arrow buttons to move the custom fields to the desired 
location.

The Layout editor will not allow changes to be made if the change conflicts with 
another field in the layout. For example, a field’s width cannot be changed from one 
to two if another field exists in column two on the same row

Custom fields cannot be moved to an area where other fields already exist. The other 
fields must be moved out of the way first.
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Adding Sections

To add a section to a project template:

1. Open the desired project template.

2. Click Custom Fields to open the Custom Fields for Project Template window.

3. Click the Layout tab.

4. Click New in the Sections frame.

The Input dialog opens.

5. Enter a Section Name.

6. Click OK.

The name of the new section appears in the Layout tab. When project 
templates are used to create a master project, the sections with the 
appropriate custom fields are displayed. To change a section name, click 
on a field that resides in that section and click Rename to enter a new value 
in the Input dialog. The change is reflected immediately.

Previewing Layouts

Click Preview to view the layout. This opens a small window that shows the 
fields as they will appear.

Remember that:

� If all of the custom fields have a width of one column, all displayed 
columns will automatically span the entire available area when the 
template is displayed.

� Any rows with no custom fields are ignored. They do not show up as a 
blank line.

� Any non-displayed custom fields do not affect the layout. The layout 
engine considers them the same as blank fields.

Adding Fields to Existing Project Plans

Custom fields can be imported into an existing project plan at any time without 
simultaneously importing the project template they come from. This allows 
you to capture whatever information is needed without having to deal with a 
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superfluous set of project plans or tasks. Custom fields appear in the Project or 
Task Information window on their own tab.

For information on adding custom fields to existing project plans, see 
Importing Custom Fields from a Project Template on page 48.

Configuring Tasks in a Project Template

Tasks and notifications in a project template can be configured the same way 
as they are in the Project Plan tab. See Editing Task Information on page 87 for 
details.

Configuring Settings for a Project Template

Project templates contain settings identical to the settings for a master project. 
The process of configuring these settings is also identical. From the Project 
Template window, you can access the Settings for Project Template window 
where you can configure the following:

� Project fields

� Exception rules

� Indicators 

� Scheduling

� Security

� Project teams

� Financial Management

Project templates do not contain references, action items, or notes. Some fields 
cannot be updated.
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See Setting Up a Master Project on page 26 for detailed instructions on 
configuring the project template settings.

Setting Ownership for a Project Template

Different groups of users can have exclusive control over the project templates 
used by their group. These groups are referred to as ownership groups. 
Members of the ownership group are the only users who can edit, delete or 
copy the project template. Each project template can be assigned multiple 
ownership groups. 

Ownership groups are defined in the Security Group window in the Workbench. 

To set the ownership for a project template:

1. Open a project template.

If a master project is created from a project template, that master project will have all 
of the template’s settings.

However, if a project template is used to create a subproject inside a master project, 
then that template’s settings will be overridden by the current master project’s 
settings.
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2. Click Ownership.

The Ownership window opens.

3. Select the Only groups listed below that have the Edit Project Templates Access 
Grant option.

4. Click Add.

The Add Security Group window opens.
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5. Select a security group from the Security Group auto-complete list.

The name of the security group you selected is displayed in the Security 
Group field.

6. Click OK to close the Add Security Group window. 

7. Click OK.

The security groups are added to the ownership group and the Ownership 
window closes. Now only members of the security group(s) specified in the 
Ownership window can edit, delete, or copy this project template.

Creating a Project Template from an Existing Project Plan

Project managers can create a new project template from an existing project 
plan. Project managers who want to convert their Microsoft Projects into 
Project Management templates can first import their Microsoft Project into a 

If no ownership groups are associated with the entity, the entity is considered global 
and any user with the Edit access grant for the entity can edit, copy, or delete it. 

Application administrators have the Ownership Override access grant and can 
access configuration entities even if the application administrator is not a member of 
one of the ownership groups and does not have the Edit access grant.

If a security group is disabled or loses the Edit access grant, that group will no longer 
be included in the ownership group.
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Mercury IT Governance project plan and then convert it into a template. See 
Integrating Project Management with Microsoft Project on page 215 for 
detailed instructions on converting a Microsoft Project file into a Mercury IT 
Governance project plan.

To create a project template from an existing project plan:

1. Log on to Mercury IT Governance Center.

2. From the shortcut bar, select Project Management > Projects.

The Project Workbench opens.

3. Locate and open the project plan that you would like to convert to a project 
template.

4. Select Project > Convert Project to Template from the menu.

The Convert Project to Template window opens.

5. Enter a new Template Name, Template Owner and Description for the new 
project template.

6. Select whether to include Project Setup, Custom Fields, Notifications and 
Resource Groups by selecting the associated checkbox.

In order to successfully convert a project plan to a template, you must be the only 
user editing the project plan. If other users are editing the project plan, a message 
will appear stating that the “Project is being edited by another user” and the 
conversion stops. 
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See Project Plan to Project Template Conversion Details for a list of items 
copied from the project plan to the template.

7. Click Convert.

When the conversion is complete, a dialog window opens.

8. Click Yes to edit the new project template.

Project Plan to Project Template Conversion Details

Table 6-4 describes the items that are copied or created in the project template 
when converted from an existing project plan. 

In the project plan to template conversion, not all project plan details are copied to 
the new template. The project plan’s actuals information is discarded during the 
conversion, such as the actual duration, efforts, start date and end date of the project 
plan and tasks. The resource, task notes and all references in the project plan are 
also discarded because the project template cannot represent these data.

Table 6-4. Items copied or created during the project plan to project template conversion 

Item in Project Template Description

The new Template Name Provided by the user.

Enabled Initially set to not enabled.

Template Owner Set to the username of the user performing the conversion.

Description Provided by the user.
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Default Project Settings

Uses the standard default or copies the settings from the project plan, 
depending on the choice the user makes. Project settings include all of 
following:

� Project fields (Planning fields and activity fields)

� Exception rules

� Indicators

� Scheduling settings

� Security settings

Custom Fields and Layout

The user can select to copy custom fields and their layout. For custom 
fields defined at the master project level, the field definitions are copied 
into the new template. For custom fields defined at the subproject level, 
only the references to the source project plans are copied.

Notifications Optional setting in the Convert Project To Template window.

Project Hierarchy Copied based on the project plan.

Table 6-4. Items copied or created during the project plan to project template conversion  

Item in Project Template Description
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Project Info

� Project Name: copied

� Project Manager: set to blank

� Project State: clear to default value

� Department: copied

� Template: converted (blank for master projects)

� Project Path: converted

� Description: copied

� Priority: copied

� % Complete: set to 0

� Confidence: set to blank

� Predecessors: converted

� Start Date/Actual: set to blank

� Finish Date/Estimate: set to blank

� Finish Date/Actual: set to blank

� Duration/Scheduled: copied

� Duration/Est. Remaining: set to blank

� Duration/Actual: set to blank

� Effort/Scheduled: copied

� Effort/Est. Remaining: set to blank

� Effort/Actual: set to blank

Table 6-4. Items copied or created during the project plan to project template conversion  

Item in Project Template Description
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Task Info

� Task Name: copied

� Task Category: copied

� Task State: cleared to default value 

� Department: copied

� Template: copied

� Project Path: converted

� Resource: set to blank

� Resource group: copied

� Description: copied

� Priority: copied

� % Complete: set to 0

� Confidence: set to blank

� Predecessors: converted

� Start Date/Actual: set to blank

� Date/Estimate: set to blank

� Finish Date/Actual: set to blank

� Duration/Scheduled: copied

� Duration/Est. Remaining: set to blank

� Duration/Actual: set to blank

� Effort/Scheduled: copied

� Effort/Est. Remaining: set to blank

� Effort/Actual: set to blank

� Scheduling Constraint: all constraints are removed

Table 6-4. Items copied or created during the project plan to project template conversion  

Item in Project Template Description

Task notes and all references are dropped, since the project template cannot 
represent this data.
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Creating a Master Project from a Project Template

If a company has a business process that is used repeatedly, it will be easier to 
create and manage if it has its own template containing preconfigured settings. 

To create a new master project from a project template:

1. Log on to Mercury IT Governance Center.

2. From the shortcut bar, select Project Management > Projects.

The Project Workbench opens.

3. Click New Project.

4. Enter a master project name in the Master Project Name field.

5. Select the desired template from the Project Template auto-complete list.

6. Click OK.

A new master project is created, including the project plan, all of the fields 
to be collected, indicators, exception rules, custom fields, notifications, 
Financial Management and scheduling parameters defined in the project 
template.

Creating a Subproject from a Template

Project templates can be used to add subprojects to a master project, adding 
tasks in a predefined order and hierarchy. The new subprojects added will 
include notifications, custom fields, and default values for Scheduled Effort 
and Duration. 
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To add a set of tasks to a project plan using a project template:

1. Open the Project window for the project plan that you would like to change. 

2. Select Project Created from Template from the drop-down list.

3. Click Add.

The Add Project Template window opens.

4. Select a Project Template from the auto-complete list and click OK.

The selected template is added to the project plan as a collapsed subproject. 
If the subproject is not in the place you want it to be, you can move it with 
the arrows in the Project Plan tab (See Setting Up Project Hierarchy 
on page 52 for more details).

5. Modify the information in any task inside the subproject by double-
clicking on it.
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The Task Information window for that task opens.

6. Edit the information.

7. Click OK to save the information and close the Task Information window, or 
click Save to save the changes without closing the window.
214 Mercury Project Management™ User’s Guide



Chapter

7

Integrating Project Management with

Microsoft Project

In This Chapter:

� Overview of Integrating Project Management with Microsoft Project
� Synchronization Modes

� Project Management controlled
� Microsoft Project controlled
� Project Management controls actuals

� Project Management Strategies
� Overview of Converting a Microsoft Project File to an IT 

Governance Project
� Publishing a Mercury IT Governance Project through Microsoft 

Project
� Publishing a Microsoft Project File through Project Management
� Using Project Management to Track Actuals in Microsoft Project

� Requirements for the Project Management–Microsoft Project Interface
� Microsoft Project Requirements
� Access Grants
� Required Software

� Exporting to Microsoft Project from Project Management
� Importing from Microsoft Project
� Synchronizing Microsoft Project and Project Management
� Synchronization of Resources
� Impact of Microsoft Project Rules on Fields

� Solutions for Project Managers
� Conditional Editing Allowed In Project Management
215



 Chapter 7: Integrating Project Management with Microsoft Project
� Editing Project Management Controlled Projects
� Editing Microsoft Project Controlled Projects
� Project Management Controls Actuals
� Conditional Editing Summary Table

� Summary of Synchronization Behavior
� Integration with Other Mercury IT Governance Center Products

� Limitations on References
� Allowed Types of References During a Synchronization
� References Summary Table

� Available Reports
� Microsoft Project Synchronization Report
� Unsuccessful Resource Matches Report
� Project Detail Report

� Troubleshooting
� Resource Calendars
� Units
� Advanced Predecessors
� Advanced Constraints
� Calculation of Roll-up Values
� Microsoft Project’s Manual Scheduling Mode
� Scheduling Your Project in Microsoft Project
216 Mercury Project Management™ User’s Guide



 Chapter 7: Integrating Project Management with Microsoft Project
Overview of Integrating Project Management with 
Microsoft Project

This chapter explains how to integrate Project Management with Microsoft 
Project. The Project Management–Microsoft Project interface allows project 
managers to import project information from Microsoft Project to a new 
Mercury IT Governance project. Project information can also be exported from 
Project Management to Microsoft Project, creating a new project in Microsoft 
Project. Projects that have been imported or exported can be synchronized. 
Any information that is shared between projects in both applications is updated 
during synchronization.

Synchronization Modes

By importing, exporting and synchronizing information between Project 
Management and Microsoft Project, you have the advantage of using the “best 
of both possible worlds.” Depending on your project management strategy, 
you can use one application to perform all planning and tracking activities, and 
then use the other for publishing project information to managers, participants 
and stakeholders. See Project Management Strategies for more information 
about different project management strategies.

The project manager can select from three synchronization modes for 
importing/exporting information between Project Management and Microsoft 
Project. Each mode offers a different strategy for communication between the 
two applications and has its own set of advantages.

Project Management controlled

The project manager initially creates a project in Project Management to 
perform planning and tracking activities. These activities include defining the 
project, scheduling tasks and tracking actuals. The first time the project is 
synchronized, Project Management creates a new project file on the project 
manager's desktop computer. For each subsequent synchronization, all of the 

The Project Management–Microsoft Project interface is only compatible with 
Microsoft Project 98, 2000, and 2003, North American localization. It is not 
compatible with earlier versions of Microsoft Project such as Project Central. 
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information in the Microsoft Project file that is also contained in the Mercury 
IT Governance project is replaced with the current information in Project 
Management. Other information in the Microsoft Project file (custom fields, 
resource cost rates, and so forth) is not altered.

After exporting, the project manager can distribute the Microsoft Project file or 
use it to run reports for managers and other people in the organization. 

Microsoft Project controlled 

The project manager creates a project in Microsoft Project to perform project 
planning and tracking activities and then synchronizes it in the Workbench. 
The synchronized Mercury IT Governance Project automatically rolls up into 
the Mercury IT Governance Dashboard. Also, participants can create 
references from tasks in the synchronized project to other Mercury IT 
Governance Center information (requests and packages). These references can 
provide information back to the project manager, or can automatically inform 
external participants of project events they are monitoring.

For all subsequent synchronizations, information in Project Management is 
updated with current information from Microsoft Project.

Project Management controls actuals

The project manager plans and schedules the project in Microsoft Project while 
using Project Management to track actuals. Participants in the project directly 
report actuals data using the Task Update portlet in the standard interface. Each 
subsequent synchronization updates the Microsoft Project file with actuals data 
from Project Management. The Mercury IT Governance Project is updated 
with changes to the project structure or schedule in Microsoft Project.

See Synchronizing Microsoft Project and Project Management on page 234 
for more information about synchronization.
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Project Management Strategies

The following scenarios demonstrate how project managers can use different 
project management strategies offered by the Project Management–Microsoft 
Project interface.

Overview of Converting a Microsoft Project File to an IT Governance 
Project

A project manager who has previously used Microsoft Project but is adopting 
Project Management can use the interface to convert a Microsoft Project file to 
a Mercury IT Governance Project. Conversion is a one-time action, but the 
project manager might want to keep the Microsoft Project file and the Mercury 
IT Governance Project synchronized after conversion. 

To convert a Microsoft Project file to a Mercury IT Governance Project:

1. Save the Microsoft Project file to a local file on your computer.

2. Open the Workbench and start an import from the Project window. 

3. Follow the instructions from the Import from Microsoft Project wizard. (See 
Importing from Microsoft Project on page 228 for detailed instructions.) 

a. Browse for the Microsoft Project file. 

b. Enter additional information about the new Project in the wizard as you 
go through the steps of the import.

When the Import from Microsoft Project wizard completes the procedure, the 
project manager can see the new project in Project Management and can 
decide whether or not to save the project. The Microsoft Project file has been 
updated with hyperlinks to the related pages in the standard interface. The 
project manager can decide whether to save these changes also. Both projects 
will have unsaved changes.

Initially, the project manager might want to keep the project under the control 
of Microsoft Project, and periodically synchronize the Mercury IT Governance 
Project with Microsoft Project information. (See Publishing a Microsoft 
Project File through Project Management for more information about 
synchronizing projects.) This allows the project manager to see how the project 
is presented in Project Management. Later, when the project manager is more 
comfortable with Project Management, the project manager can change to the 
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Project Management controlled mode, and can decide to stop synchronizing 
the project with Microsoft Project entirely.

Publishing a Mercury IT Governance Project through Microsoft Project

A project manager who uses Project Management to manage projects can use 
the Project Management–Microsoft Project interface to publish the projects. 
Publishing can simply mean distributing the Microsoft Project file to external 
audiences (such as a PMO group). Publishing could also mean synchronizing 
the Microsoft Project file with Project Management, and then running 
Microsoft Project reports for distribution. The projects can be published on a 
regular basis (weekly or quarterly) or at defined milestones (such as design 
completion). 

To publish a Mercury IT Governance project through Microsoft Project:

1. Open the project to be exported in Workbench. 

2. Export the project into a new Microsoft Project file. (See Exporting to 
Microsoft Project from Project Management on page 224 for detailed 
instructions.)

Since a project created in Project Management defaults to the 
synchronization settings for Project Management controlled mode, the 
project manager will probably not need to change any project settings.

3. In the new Microsoft Project file that created and that opens, save the 
project and run reports as usual.

After the first export, you will synchronize the Mercury IT Governance project 
with the Microsoft Project file. This will effectively overwrite shared 
information, but will not affect additional information in the Microsoft Project 
file that is added manually after the export has occurred (such as a baseline). 

If you want to export a new project each time, the project manager can simply 
rename the Microsoft Project file on the computer before clicking the Synch button, 
which causes Project Management to export into a new file.
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Publishing a Microsoft Project File through Project Management

A project manager who uses Microsoft Project to manage projects can publish 
those projects using Project Management. Publishing means loading the 
project data into the Project Management repository, which has the following 
benefits:

� The project status appears in the Mercury IT Governance Dashboard. 
Project Management calculates exceptions and stoplight status (red/yellow/
green) based on the project settings on the Mercury IT Governance project.

� Project participants and external audiences can see the project in various 
interfaces such as the My Tasks portlet and the search screens. Although 
these participants cannot use Project Management to update project status, 
this is an effective way to increase visibility of project information through 
the standard interface.

� Project Management users can create references from other Mercury IT 
Governance entities (such as requests and packages) to tasks in the 
synchronized project. These references could be used to monitor the state 
of a particular task, and block progress on a request or package until the 
predecessor task is complete.

The project manager is likely to publish the project to Project Management on 
a regular basis. The project manager's actions are identical to the scenario 
described in the previous section, Publishing a Mercury IT Governance 
Project through Microsoft Project, except that synchronization is left in 
Microsoft Project–controlled mode for all shared project data.

Using Project Management to Track Actuals in Microsoft Project 

A project manager who uses Microsoft Project to plan and manage projects can 
use Project Management to collect actuals from participants. In addition to the 
benefits described previously in Publishing a Microsoft Project File through 
Project Management, this integration shifts some of the effort of collecting and 
entering actuals information from the project manager to the participants. The 
project manager will need to synchronize the projects periodically, either to 
publish a re-planned project to Project Management or to collect new actuals 
updates into Microsoft Project.

To use Project Management to track actuals from Microsoft Project:

1. Import the Microsoft Project file into Project Management.
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2. During the import, select the Project Management controls actuals 
synchronization mode.

Initially, the Mercury IT Governance project is identical to the Microsoft 
Project file. After the import, participants or the project manager can enter 
actuals information into Project Management.

3. The project manager synchronizes the two projects, and the Microsoft 
Project file is updated with the new actuals in Project Management.

This causes some changes to schedule dates in the Microsoft Project file. 
For example, an actual start date entered into Project Management will 
overwrite a scheduled start date in Microsoft Project.

The Mercury IT Governance Project is updated to match the project structure 
and schedule information of the modified Microsoft Project file. Both Projects 
are shown to the project manager in their respective applications, and the 
project manager can choose whether to save either or both projects. If 
necessary, the project manager can adjust the Microsoft Project file. This can 
mean shifting assignments, changing schedule dates (using the Microsoft 
Project resource-leveling feature), or other changes. The project manager saves 
the changed Microsoft Project file and synchronizes it with Project 
Management a second time to publish these schedule changes to participants.

Requirements for the Project Management–Microsoft 
Project Interface

The project manager configures the interface behavior and performs 
synchronizations from the Workbench. The Project Management–Microsoft 
Project interface is transparent from the Microsoft Project side, with the 
exception of task hyperlinks added to Project Management Web pages.

Microsoft Project Requirements

The Microsoft Project requirements for the interface are:

� Microsoft Project must be installed on the desktop PC.

� The saved project file must either be on the local PC, or on a mapped 
network drive.
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Access Grants

The project manager needs a Mercury Project Management license and the 
appropriate access grants. The Project Management–Microsoft Project 
interface relies on two Project Management access grants: Edit Projects and 
project manager.

The Edit Projects access grant allows a user to edit planning data for a Mercury 
IT Governance project, but only if that user is identified as one of the project 
managers. (Each Mercury IT Governance project has a distinct list of one or 
more project managers.) 

The Project Manager access grant is a skeleton-key grant that allows the user 
to edit planning data for all Mercury IT Governance projects. Both grants 
allow the user to create new projects.

In order to use the Project Management–Microsoft Project interface, a user 
needs to have one of the following:

� Edit Projects access grant and the user must be a project manager for the 
specific project

� Project Manager access grant

Required Software

In order for the Workbench to communicate with the Microsoft Project 
installation on the project manager’s desktop computer, an additional file must 
be installed. 

The Security model for the Project Management–Microsoft Project interface is as 
follows:

� If the user is allowed to edit the planning data for the Project Management master 
project, then that user can export or synchronize the project. Any user who can 
create a Mercury IT Governance project in the Project Management application 
can also create a Mercury IT Governance project by importing an Microsoft Project 
file.

� The Project Manager access grant is an easy way to give global permissions to 
the Program Management Office (PMO) staff.
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A Windows Dynamic Link Library (.dll) file must be installed on the project 
manager’s desktop computer. This .dll file needs to reside somewhere in the 
path of the Windows operating system.

If using Internet Explorer, the process of installing the .dll file is automatic.

Exporting to Microsoft Project from Project Management

The following procedure describes how to export a Mercury IT Governance 
project to Microsoft Project. This creates a new project in Microsoft Project 
using the exported project’s information.

1. Log on to Mercury IT Governance Center and open the Workbench.

2. From the shortcut bar, select Project Mgmt > Projects.

The Project Workbench opens.

Before exporting or synchronization, the project manager can select a 
synchronization mode from the MSP Synchronization tab in the Settings window or 
accept the default, Project Management controlled. See Setting Up Microsoft 
Project Integration on page 46 for more information about selecting a 
synchronization mode in the Settings window.
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3. Query for and open the project to be exported.

When the Project window opens, a menu option File > Export to Microsoft 
Project is available if the project was not originally imported from 
Microsoft Project or if it has never been exported to Microsoft Project. If 
the project does not meet these criteria, then the option displays as Synch 
with MSP.

4. Select the menu option File > Export to Microsoft Project.

The Export to Microsoft Project wizard opens. 

The various steps of the export process are shown in the Progress Indicator 
column on the left side of the wizard. The current step of the export process 
always displays in bold. Each step has its own interface that displays within 
the Export to Microsoft Project wizard. After each step is completed, a check 
mark appears by the name of the step. At this point, you should be at the 
Select Destination File step of the process.

You can click Next after completing each step of the wizard or click Export 
Now.

� Click Next to go to the next interface for selecting options for the 
export. 

� Click Export Now at any step to bypass the remaining steps and begin 
exporting the Mercury IT Governance project file. The wizard uses the 
system default settings the first time you export a project. For each 
subsequent export, the wizard uses the settings from the last time you 
exported a Mercury IT Governance project.
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5. Select a drive/directory as a destination for the new Microsoft Project file.

Either enter a new file name or select an existing file name for the 
Microsoft Project file to be created during the export. 

The path and name of the new Microsoft Project file appears in the File 
Chooser field.

6. Click Next.

The Confirm Options interface displays in the Export to Microsoft Project 
wizard. It displays the following information:

� The path and name of the Microsoft Project file to be created during the 
export.

� The properties selected by the user on the MSP Synchronization tab of 
the Project Settings window.

7. If the options presented on this interface are not correct, click the Back 
button, go to the appropriate step in the export process and change the 
options. (Or close the wizard to access the Microsoft Synchronization 
Project Settings. These are located on the MSP Synchronization tab of the 
Project Settings window.)

If the options presented on this interface are correct, click Export Now.

The Microsoft Project file is created from the Mercury IT Governance 
project and displays as an icon on the Windows taskbar. The Finish 
interface displays in the Export from Microsoft Project wizard. This interface 
informs you whether or not the export was successful and if there are 
warnings in the Synchronization report. 

8. To see the Synchronization report, click Show Synchronization Report.

The report displays in a separate browser window, as shown in the 
following example.
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See Available Reports on page 249 for more information about the 
Synchronization report.

9. (Optional) Go to the Messages section of the report to see any warnings 
created during the export process. 

10. Click Finish to close the Export from Microsoft Project window. 

11. Verify the project data in both Project Management and Microsoft Project 
and either save or abandon the projects.

An example of a Microsoft Project file created by exporting a Mercury IT 
Governance project is shown in the following figure. 

To see the most recent Synchronization report after the export from Microsoft Project 
window has been closed, select View > Latest Synchronization Report from the 
Project menu. 
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Importing from Microsoft Project

The following procedure describes how to import a Microsoft Project file into 
Project Management. This creates a new project in Project Management using 
the imported project’s information.

To import a Microsoft Project file into Project Management:

1. Log on to Mercury IT Governance Center and open the Workbench.

2. From the shortcut bar, select Project Mgmt > Projects.

When you import a large Microsoft Project (or a large number of projects) into Project 
Management, tables in the Mercury IT Governance Center database are updated to 
handle this new configuration. Because of the scope of database changes, you 
should re-run the database statistics on your Mercury IT Governance Center 
database. Contact your application administrator for help with this procedure.
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The Project Workbench opens.

3. Click Import From MSP.

The Import from Microsoft Project wizard opens. 

The various steps of the import process are shown in the Progress Indicator 
column on the left side of the wizard. The current step of the import 
process always displays in bold. Each step has its own interface that 
displays within the Import from Microsoft Project wizard. After each step is 
completed, a check mark appears by the name of the step. At this point, you 
should be at the Select Source File step of the process.

You can click Next after completing each step of the wizard or click Import 
Now.
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� Click Next to go to the next interface for selecting options for the 
import. 

� Click Import Now at any step to bypass the remaining steps and begin 
importing the Microsoft Project file. The wizard uses the default 
settings the first time you import a project. For each subsequent import, 
the wizard uses the settings from the last time you imported a Microsoft 
Project file.

4. Select the appropriate drive/directory and choose the Microsoft Project file 
to be imported. 

The path and name of the Microsoft Project file to be imported appears in 
the File Chooser field.

5. Click Next.

The Enter Project Details interface displays in the Import from Microsoft Project 
wizard. 

6. Enter a unique Project Name for the new Mercury IT Governance project 
in the Project Name field. 

7. Select a project manager (or managers) for the new Mercury IT 
Governance project from the Project Manager auto-complete list.

8. Click Next.

The Select Control Mode interface displays in the Import from Microsoft Project 
wizard.

9. Select the synchronization control mode for the new project by clicking the 
appropriate radio button.

Clicking a control mode’s radio button displays a description of the control 
mode in the Description information box. See Synchronization Modes 
on page 217 for more information about synchronization modes.
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10. Click Next.

The Verify Resources interface displays if there are Microsoft Project 
resources that could not be matched to Project Management users. The 
unmatched resources shown in the wizard and their assignments will not be 
imported. To display the unmatched resources in a browser window, click 
Show Printable Version. An example of the Unsuccessful Resources Match 
report is shown below.

11. Click Next.

The Confirm Options interface displays the following information:

� The path and name of the Microsoft Project file to be imported.

� The Project Name and project manager of the new Mercury IT 
Governance project.

� The synchronization control mode selected by the user.

� Whether or not unmatched resources were found.

12. If the options presented on this interface are not correct, click the Back 
button, go to the appropriate step in the import process and change the 
options.
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If the options presented on this interface are correct, click Import Now.

The Microsoft Project file opens and is imported into Project Management. 
A new Mercury IT Governance project is created.

The newly created Mercury IT Governance project opens. An example of 
the Mercury IT Governance project created by importing the Microsoft 
Project file Software Release 5.mpp is shown below. Notice that it has the 
unique name Software_Release_5.

13. To view the Synchronization report, click Show Synchronization Report.

The report displays in a separate browser window. See Available Reports 
on page 249 for more information about the Synchronization report.
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14. Click Finish to close the Import from Microsoft Project window.

15. Verify the project data in both Project Management and Microsoft Project 
and save the projects.

To see the most recent Synchronization report after the import from Microsoft Project 
window has been closed, select View > Latest Synchronization Report from the 
Project menu.

During the import process, Project Management adds a hyperlink from each 
Microsoft Project task to the related page in the standard interface (such as a Task 
Detail, Subproject Summary or Project Summary page). This hyperlink is placed in 
the standard fields for task hyperlinks, and can overwrite existing hyperlinks. 

Existing hyperlinks can be moved to a Microsoft Project custom field of the type 
“Text.” 
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Synchronizing Microsoft Project and Project Management

The following procedure describes how to synchronize projects in Project 
Management and Microsoft Project. Any information that is shared between 
them is updated during the synchronization.

To synchronize projects in Project Management and Microsoft Project:

1. Log on to Mercury IT Governance Center and open the Workbench.

2. From the shortcut bar, select Project Mgmt > Projects.

The Project Workbench opens.

3. Query for and open the project to be exported.

When the Project window opens, a menu option File > Export to Microsoft 
Project is available if the project was not originally imported from 
Microsoft Project or if it has never been exported to Microsoft Project. If 
the project does not meet these criteria, then the option displays as Synch 
with MSP.

4. Select Synch with MSP.

The Synchronize with Microsoft Project wizard opens. 

Before exporting or synchronization, the project manager can select a 
synchronization mode from the MSP Synchronization tab in the Settings window or 
accept the default, Project Management controlled. See Setting Up Microsoft 
Project Integration on page 46 for more information about selecting a 
synchronization mode in the Settings window.
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The various steps of the synchronization process are shown in the Progress 
Indicator column on the left side of the wizard. The current step of the 
synchronization process always displays in bold. Each step has its own 
interface that displays within the Synchronize with Microsoft Project wizard. 
After each step is completed, a checkmark appears by the name of the step. 

5. The Confirm Options interface displays the following information:

� The path and name of the Microsoft Project file that the current 
Mercury IT Governance project will be synchronized with. This will be 
either a file that was originally imported from Microsoft Project or a 
file that was exported to Microsoft Project from the current Mercury IT 
Governance project.

� The properties selected by the user on the MSP Synchronization tab of 
the Project Settings window.

6. If the options presented on this interface are not correct, click the Cancel 
button and change the properties in the Settings window.

If the options presented on this interface are correct, click Synch Now.

The Mercury IT Governance project is synchronized with the Microsoft 
Project file.

7. To see the synchronization report, click Show Synchronization Report.

See Available Reports on page 249 for more information about the 
synchronization report.
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8. Click Finish to close the Synchronize with Microsoft Project window. 

9. Verify the project data in both Project Management and Microsoft Project 
and either save the projects or close them without saving.

Synchronization of Resources

In Project planning, the concept of “resources” can have multiple definitions. 
A resource can be a team member, time on a mainframe computer, or 
construction materials. A resource in Project Management is a Project 
Management user or group of users capable of performing tasks. Resources are 
chosen from the project team specified by a project manager. Microsoft Project 
supports tracking and costing of both human and material resources. Project 
Management supports only human resources.

A project can also contain resources that have not been assigned. In Microsoft 
Project, unassigned resources appear in some resource-centric project views 
but have little functional significance. In Project Management, unassigned 
resources are Project Management users listed in the project team who have no 
task assignments. During synchronization, all assigned human resources are 
synchronized. Unassigned human resources and unassigned material resources 
are not synchronized. 

To see the most recent synchronization report after the Synchronize with Microsoft 
Project window has been closed, select View > Latest Synchronization Report 
from the Project menu. 
236 Mercury Project Management™ User’s Guide



 Chapter 7: Integrating Project Management with Microsoft Project
After synchronization, there will be a Microsoft Project resource matching 
every Project Management resource. If a Project Management resource is 
missing from the Microsoft Project file, a matching resource will be created. 
Each Mercury IT Governance project has a configuration setting (in the MSP 
Synchronization tab of the Settings window) specifying whether Microsoft 
Project resources created during synchronization are labeled with the Project 
Management username or the Project Management first/last name. The default 
value is by Project Management username.

Because the two applications define resources differently, not every Microsoft 
Resource will be defined in Project Management. After synchronization, there 
can be some Microsoft Project resources with no matching Project 
Management resource, because new Project Management resources (which are 
always users) are not automatically created. These unmatched Microsoft 
Project resources are listed in the Microsoft Project Synchronization report. 
See Available Reports on page 249 for more information on reports.

When the Import from Microsoft Project wizard detects unmatched resources, the 
wizard displays a list of these resources (in the Verify Resources step of the 
process) and offers the option of opening a printable version of this list in a 
browser window. This is in addition to listing the unmatched resources in the 
Microsoft Project Synchronization report. The project manager can cancel the 
import at this point, create the missing users (or have the application 
administrator create the users) and run the import again. 

Resource synchronization is based on either of two factors:

� A match between the Microsoft Project resource name and Project Management 
username.

� A match between the Microsoft Project resource name and the concatenation of 
Project Management user’s first name and last name (or last name and first 
name). 

This match is not case-sensitive. In Microsoft Project, it is possible to have two 
resources with the same name that vary only by which letters are uppercase or 
lowercase. The synchronization mapping logic first checks for a match with the same 
upper/lower case. If no match with exact case is found, the first case-insensitive 
match is used. 

In Project Management, the synchronization does not guarantee that all assigned 
resources are part of the project team. If the project team needs to be maintained, 
then this must be done manually.
Synchronization of Resources 237



 Chapter 7: Integrating Project Management with Microsoft Project
Impact of Microsoft Project Rules on Fields

Microsoft Project contains a number of internal rules that determine the way 
field values are calculated in planning and actuals fields. These rules affect the 
synchronization process between Microsoft Project and Project Management 
because calculations that work in one application do not necessarily carry over 
to the other application.

For example, reporting actuals in Microsoft Project is complicated due to its 
task reconciliation rules. Entering values into several actuals fields triggers 
automatic revisions of other planning and actuals fields. If you enter more than 
two or three actuals values, later entries start revising earlier entries in the 
Project. 

Another difference is the method of defaulting logic between Project 
Management and Microsoft Project. An example is the calculation of actual 
start date. Microsoft Project assumes that the task starts on the scheduled start 
date, unless the project manager specifically enters other data. This is because 
actuals are usually entered after-the-fact by the project manager. Project 
Management assumes that work starts when the participant changes the task 
state from Ready to In Progress. Project Management assumes that actuals are 
reported near real-time.

The most common Microsoft Project rules for planning and actuals fields are 
listed below.

Planning Fields

� Start + Duration = Finish

� Effort = Duration * (sum of resources * units)

Actuals Fields

� Start = Actual Start (if known)

� Finish = Actual Finish (if known)

� Duration = Actual Duration + Remaining Duration

� % Complete = Actual Duration / Duration

� Remaining Duration is zero when task is 100% Complete

� Effort = Actual Effort  + Remaining Effort
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Solutions for Project Managers

In order to give consistent behavior during synchronization, Mercury IT 
Governance project managers must:

� Synchronize only those actuals fields (such as % Complete, Actual Start and 
Actual Finish) that are enabled. See Enabling/Disabling Fields for more 
information about enabling fields.

� Synchronize these fields according to their defined priority order. See 
Priority Order for more information about the field priority order.

The Project Management–Microsoft Project interface ignores Project 
Management default values that are not enabled.

Enabling/Disabling Fields

To enable or disable actuals fields: 

1. In the Project Workbench, search for and open the project to be exported, 
imported or synchronized.

2. From the menu at the top of the Workbench, select Project > Settings.

The Settings window opens.

3. Click the Project Fields tab.
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4. In the Activity Fields pane:

� Enable a field by selecting the appropriate checkbox in the Enabled 
column. 

� Disable a field by deselecting the appropriate checkbox in the Enabled 
column.

5. Click OK.

Priority Order

The following list of actual fields is ordered from the highest priority to the 
lowest priority for the purpose of synchronization.

� % Complete

� Actual Start

� Actual Finish

� Actual Duration

� Actual Effort

� Estimated Finish Date

� Remaining Duration

� Remaining Effort

The priority order is the same for all projects. ‘% Complete’ is ranked highest 
because it is used prominently in the Dashboards and reports of both 
applications. Thereafter, fields that display actual measures take precedence 
over estimates, and dates take precedence over durations. Fields with the 
highest priorities should be enabled in a project more often than those fields 
with lower priorities.

Setting Up Projects

When setting up Mercury IT Governance projects for synchronization, project 
managers should:

� Enable as few fields as necessary that will accurately give visibility to the 
results of a synchronization, export or import.
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� Not enable potentially conflicting sets of fields. (See the next section, 
Avoiding Potential Conflicts When Setting Up Your IT Governance 
Project, for potential conflicts.)

Avoiding Potential Conflicts When Setting Up Your IT Governance Project 

The following guidelines describe strategies for avoiding potential conflicts.

� Enable only two of the three calendar actuals (Start, Finish and Duration) for 
a Mercury IT Governance project.

� Enable only two of the three calendar estimates (% Complete, Estimated 
Finish and Remaining Duration) for a Mercury IT Governance project.

� If Actual Duration is enabled, then enable either % Complete or Remaining 
Duration.

� Do not enable all three duration actuals (% Complete, Duration and 
Remaining Duration) for a Mercury IT Governance project.

See Troubleshooting on page 253 for more information about unsupported 
fields and features in the Project Management–Microsoft Project interface.

Conditional Editing Allowed In Project Management

Depending on the synchronization mode that has been selected for a project, 
the project structure and task information will be controlled by either Project 
Management or Microsoft Project. Depending on the synchronization control 
mode selected for the project, some editing features in Project Management 
will be disabled. Information controlled by Microsoft Project cannot be edited 
in Project Management.

Summaries of the conditional editing restrictions for each synchronization 
mode are listed in Conditional Editing Summary Table.

Editing Project Management Controlled Projects

When Project Management controls the project, the user is allowed to edit all 
information in Project Management. This includes changing the task structure, 
adding or deleting new subprojects and tasks, and editing task scheduling and 
actual fields. 
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Editing Microsoft Project Controlled Projects

When Microsoft Project controls all the project planning and tracking 
activities, the comparable editing functions in Project Management are 
disabled. The data that is distinct to Project Management and not shared with 
Microsoft Project can still be edited. This includes user data, custom project 
fields, and task references.

Workbench Interface

In the Workbench, subprojects and tasks can be edited in the Project Plan tab, 
the Subproject Detail window, and the Task Detail window (when it is opened in 
the Project window or the Task Workbench). All the shared fields are disabled 
in these windows. 

Any function that could change the project and task structure is disabled. This 
includes the following components:

� Add Task button

� Delete button

� Indent/Outdent buttons

� Move up/Move down buttons

Since scheduling can change dates and durations, the Schedule Project button 
is disabled. The state of the Mercury IT Governance Project cannot be changed 
in this synchronization mode; therefore the Change State is also disabled. The 
key shortcuts for these buttons are disabled as well.

Standard Interface

In the standard Project Management interface, the My Tasks portlet and the 
Task Detail page will not allow users to enter task actuals. The My Tasks 
portlets and the Task Search page still return the current incomplete tasks 
assigned to a user regardless of the control mode. This provides visibility to the 
project’s participants. The actuals collected in Microsoft Project are visible 
through the My Tasks portlet.

Roll-up calculations are disabled through Project Management, whether 
triggered by actions in the Workbench, the standard interface, or any other 
method.
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Project Management Controls Actuals 

The Project Management controls actuals mode is more complex than the other 
two modes when disabling fields. This mode allows users to change the actual 
fields while keeping the planning fields unchanged.

In the Project Plan tab, Project Detail window, and Task Detail window, only 
actual fields are editable. The planning fields are disabled. In the Project Detail 
window, planning fields in the subproject/task table are also not editable. 

Similar to the Microsoft Project control mode, any function that could change 
the project and task structure is disabled. This includes the following 
components:

� Add Task button

� Delete button

� Indent/Outdent buttons

� Move up/Move down buttons

Some roll-up operations are disabled. Roll-up of actuals fields still occurs, but 
schedule fields will not roll-up. The imported values from Microsoft Project 
are retained. 

The functionality allowed in the Shared control mode is very similar to the 
functionality allowed to a user who has been given only the Update Tasks 
access grant.

Conditional Editing Summary Table

Table 7-1 summarizes the allowed or restricted conditional editing in Project 
Management for each of the three synchronization modes.

Table 7-1. Conditional editing allowed in Project Management 

 Fields in Project 
Management

Project 
Management 

controlled 

MSP controlled Project Management 
controls actuals

Project Plan

Structure fields Yes No No

Planning fields Yes No No

Actual fields Yes No Yes
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Subproject Detail window

Structure fields Yes No No

Planning fields Yes No No

Actual fields Yes No Yes

Other non-shared fields Yes Yes Yes

Task Detail window

Structure fields Yes No No

Planning fields Yes No No

Actual fields Yes No Yes

Other non-shared fields Yes Yes Yes

Project window

Add/Delete Task button Yes No No

Indent/Outdent Task button Yes No No

Move up/Move down Task button Yes No No

Schedule Project button Yes No No

Change State button Yes No No

Roll-up

Schedule fields Yes No No

Actuals fields Yes No Yes

My Tasks portlet

Actuals fields Yes No Yes

Task Detail page

Actuals fields Yes No Yes

Table 7-1. Conditional editing allowed in Project Management  [continued]

 Fields in Project 
Management

Project 
Management 

controlled 

MSP controlled Project Management 
controls actuals
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Summary of Synchronization Behavior 

The following sections describe the behavior of a Mercury IT Governance 
project after a successful export to Microsoft Project.

The task structure and task names for the project in Project Management and 
the project in Microsoft Project will be identical. There will be a 1-to-1 
relationship between tasks, and tasks will appear in the same sequence in both 
projects. The exception to this rule is that the Microsoft Project file might not 
have a master project row. The synchronization will not create a master project 
row.

The resources assigned to each task will be identical. The predecessors and 
constraints will be identical, for the types of predecessors and constraints 
supported by Project Management.

If Project Management is collecting actual start and finish dates, then these 
dates will be exported to Microsoft Project. Actual dates take precedence over 
Project Management scheduled dates. Time information will also be 
synchronized.

If Project Management is collecting “estimated actuals” then this information 
will be exported to Microsoft Project. Estimated actuals fields deal with 
estimated time to completion and estimated time of completion. Examples are 
the % Complete, Estimated Finish Date and Remaining Effort fields. These 
estimates can cause Microsoft Project to revise the task duration or schedule 
dates.

Scheduled start and finish dates for tasks without actuals will be identical in 
Project Management and Microsoft Project. Roll-up dates are automatically 
calculated in Microsoft Project, and can not be identical to those in Project 
Management. Time information will also be synchronized.

If Project Management is tracking task effort, then this will be exported to 
Microsoft Project. Microsoft Project will infer resource assignment units based 
on the task duration, effort and number of resources. Roll-up effort is 
calculated by Microsoft Project, but will be identical.

Duration is calculated by Microsoft Project based both on the start and finish 
dates and the resource calendars in Microsoft Project. Task durations and 
roll-up durations will sometimes differ slightly between the two applications.

Regional calendar settings applied to the Microsoft Project standard calendar 
include:

� Number of hours/day
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� Working days for each week

� Regional calendar exceptions

Integration with Other Mercury IT Governance Center 
Products

Tasks in Mercury IT Governance projects can include additional references to 
other Mercury IT Governance entities (such as requests and packages) or 
points of information, allowing easy access and visibility to data related to the 
current task. Summary information for references is viewed as part of the task. 
(See Attaching References to Tasks on page 100 for more information about 
attaching references to tasks.)

Limitations on References

The Project Management–Microsoft Project interface supports most of the 
task-related reference types.

Creating New Tasks while Adding a Reference

Normally, when a user adds a reference to a Mercury IT Governance project, 
that user can either attach the reference to an existing task, or the user might 
create a new task. (The user must also have the right security permissions to do 
so.) However, in the two synchronization modes where Microsoft Project 
controls the task structure, this is not allowed. References to existing tasks can 
still be created.

Task Updated by Request/Request Updates Task

A reference can be configured so that the % Complete of the request updates 
the % Complete of the referenced task. In the synchronization mode where 
Microsoft Project controls the entire project, a reference of this type cannot be 
created.

Task-Successor References

References can also be created where a request is the predecessor of a task. 
This can be either a finish-to-start predecessor or a finish-to-finish predecessor. 
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In the first case, the task could not start (or could not progress if already 
started) until the request predecessor is completed. In the second case, this 
means that the task could be 100% complete but cannot reach the “Completed” 
state until the request predecessor is completed. Both types of references are 
allowed, but are not visible in the synchronized Microsoft Project file.

Allowed Types of References During a Synchronization

The reference types that are allowed during a synchronization are described 
below, along with their limitations.

Microsoft Project control mode

All types of references are allowed in this mode except for Task Updated by 
Request/Request Updates Task.

If a task that has a reference is marked as 100% complete but the request 
predecessor is not complete, the potential problem will be flagged as a warning 
in the Microsoft Project Synchronization report.

Dependent references will not stop Project Management actuals from being 
updated by synchronization.

References cannot be created during synchronization.

Shared control mode

All types of references are allowed in this mode.

When a task is 100% complete in Project Management but is pending a finish-
finish predecessor, it will be synchronized out to Microsoft Project as only 
99% complete. This ensures that any milestone successors of the task will not 
incorrectly be shown as complete. This correction will be noted as an 
informational message in the Microsoft Project Synchronization report.

References cannot be created during synchronization. 

References Summary Table

Table 7-2 lists the allowed references during synchronization for each control 
mode.
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Table 7-2. Allowed references during synchronization 

Type of Reference Project 
Management 

controlled 

Project 
Management 

controls actuals

MSP controlled

Informational Yes Yes Yes

Task is the predecessor of a 
Request or Package

Yes Yes Yes

Task is the finish-to-start 
successor of a Request or 
Package

Yes Yes
Yes, but not enforced in 
Microsoft Project. 
Detected during 
synchronization.

Task is the finish-to-finish 
successor of a Request or 
Package 

Yes

Yes, but is 
sometimes 
synchronized as 
99% complete

Task Updated by Request/
Request Updates Task

Yes Yes No
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Available Reports

Project Management features three reports that contain information about the 
Project Management–Microsoft Project interface:

� Microsoft Project Synchronization Report

� Unsuccessful Resource Matches Report

� Project Detail Report

Only the Project Detail report is available from the Project Management Report 
Submission Workbench interface. The other two reports are created 
automatically during an import, export or synchronization. 

Microsoft Project Synchronization Report

The Microsoft Project Synchronization report is created during an import, 
export or synchronization. The report displays in a separate browser window 
when requested by the user. 

Figure 7-1. Microsoft Project Synchronization report
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Table 7-3. Microsoft Project Synchronization report parameters 

Sections/Fields Description

Synchronization Settings

Run Date The date and time the report was run.

Project Name The name of the Project.

Last Update Date
The date and time the Project was last 
updated.

Project Manager
The name of the project manager who 
performed the synchronization.

Microsoft Project File Location
The drive and path of the Microsoft Project 
file.

Microsoft Project File Name The name of the Microsoft Project file.

Synchronization control mode
The synchronization behavior selected by 
the project manager.

Resource Identification
The type of name (either full name or 
username) given to new resources created 
during synchronization.

Synchronization Summary 

Result
Whether the synchronization was successful 
or unsuccessful.

Messages

Information, warning or error about the 
export, import or synchronization process. 
Messages include a Message Source, 
Message Type, and Description.

Unsuccessful Resource Matches
Resources that were unsuccessfully 
matched during export, import, or 
synchronization.

Successful Resource Matches
Resources that were successfully matched 
during export, import, or synchronization.

Trace Log
A log of successful/unsuccessful processes 
that occurred during the export, import, or 
synchronization.
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Unsuccessful Resource Matches Report

The Unsuccessful Resource Matches report is created during an import, export 
or synchronization. It lists any resources that were not successfully matched 
between the Project Management and Microsoft Project files. The report 
displays in a separate browser window when requested by the user. 

Figure 7-2. Unsuccessful Resource Matches report

Table 7-4. Unsuccessful Resource Matches report parameters

Sections/Fields Description

Synchronization Settings

Run Date The date and time the report was run.

Project Manager
The name of the project manager who 
performed the synchronization.

Microsoft Project File Location
The drive and path of the Microsoft Project 
file.

Microsoft Project File Name The name of the Microsoft Project file.

Synchronization control mode
The synchronization behavior selected by 
the project manager.
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Project Detail Report

This report lets you query projects by their header fields. You can specify 
whether to include the following aspects of the Project:

� Custom fields

� Status

� Notes

� Activities 

� Packages

� Requests 

� References

� Transaction history

The Show Project Settings radio button must be set to Yes to display 
synchronization-related information.

The Project Detail report parameters are shown in Figure 7-3. 

Resource Identification
The type of name (either full name or 
username) given to new resources created 
during synchronization.

Unsuccessful Resource Matches
Resources that were unsuccessfully 
matched during export, import, or 
synchronization.

Table 7-4. Unsuccessful Resource Matches report parameters [continued]

Sections/Fields Description
252 Mercury Project Management™ User’s Guide



 Chapter 7: Integrating Project Management with Microsoft Project
Figure 7-3. Project Detail report 

Troubleshooting

Microsoft Project supports many features that are not duplicated in Project 
Management. Some of these unsupported features relate to information that 
Project Management does not track or support, such as cost calculation, 
baseline tracking and earned-value calculations. When a Microsoft Project file 
is imported into Project Management, this information is not represented.
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Information of these types is not affected by the interface. Importing the 
Microsoft Project file into Project Management does not remove this data from 
Microsoft Project. Exporting from Project Management does not create or 
default this data.

Other Microsoft Project features deal with the scheduling and tracking 
information that is synchronized between the two applications. In these cases, 
the interface converts the Microsoft Project data into information that Project 
Management can represent. The interface attempts to maintain the intent of the 
original Project Plan as closely as possible. 

Resource Calendars

The project regional calendar is exported to Microsoft Project in Project 
Management controlled mode. However, resource calendars are not 
synchronized between the two applications. Since both duration and effort are 
a function of both start/finish dates and resource calendars, the duration and 
effort values in Project Management and Microsoft Project might not match.

Units

Units are also referred to as resource load percentages. In Microsoft Project, 
each resource can be assigned to a task with a different load percentage (from 
zero percent to one hundred percent.) For example, the same resource could be 
assigned to two different tasks and have a resource load percentage of fifty 
percent for each one.

Since Project Management does not track assignment units, the load 
percentage of any resource imported into Project Management will not be 
recognized.

Advanced Predecessors

Microsoft Project has several advanced predecessor types not available in 
Project Management: start-to-start (SS), start-to-finish (SF) and finish-to-finish 
(FF).

Project Management cannot represent these advanced predecessors, but it will 
represent the scheduled start and finish dates resulting from them. During 
synchronization, these types of predecessors will be omitted from the Mercury 
IT Governance Project Plan. This can cause successor tasks in Project 
Management to incorrectly appear in a “Ready” state. 
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To convert a project from Microsoft Project to Project Management, a project 
manager needs to replace unsupported predecessor types with a supported 
alternative - a constraint, for instance. 

Advanced Constraints

Microsoft Project supports several advanced constraint types not available in 
Project Management: as late as possible (ALAP), must finish on (MFO), finish 
no earlier than (FNE), and task deadlines.

Project Management cannot represent these advanced constraints, but it will 
represent the scheduled start and finish dates resulting from them. During 
synchronization, these types of constraints are omitted from the Mercury IT 
Governance Project Plan.

Calculation of Roll-up Values

Microsoft Project allows you to choose between ‘automatic’ and ‘manual’ 
scheduling modes. The default mode is ‘automatic,’ and many users can not be 
aware another mode is available. When Microsoft Project is in manual 
scheduling mode, the F9 button must be pressed to recalculate task grouping 
roll-up values and reschedule tasks. 

Microsoft Project’s Manual Scheduling Mode

If your Microsoft Project file is in manual scheduling mode and you did not 
select this option, it could be because:

� You created this project by exporting a Mercury IT Governance project 
from Project Management. The Export to Microsoft Project wizard turns off 
automatic scheduling mode in order to have the task dates in Microsoft 
Project match those in Project Management.

� You opened a project that was in manual mode and then created the new 
Microsoft Project file. This caused the new project to inherit the manual 
mode setting as a default.

Scheduling Your Project in Microsoft Project

The synchronization process can sometimes stop in mid-operation because 
Microsoft Project displays a warning dialog. Microsoft Project is not 
completely consistent about when it will respond to a COM call with a warning 
dialog, so this cannot always be avoided.
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When the synchronization process stops and the warning dialog appears, the 
Microsoft Project button in the Windows task bar flashes as a signal that the 
application needs attention. To continue the synchronization process, go to the 
Microsoft Project file and dismiss the warning dialog.

The best way to prevent the warning dialog from appearing during 
synchronization is to resolve all planning problems in Microsoft Project (such 
as violated constraints) prior to synchronization. You might need to manually 
recalculate the project’s schedule by pressing the F9 key before you attempt 
synchronization.
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Integrating Requests and Project Plans

In This Appendix:

� Overview of Integrating Requests and Project Plans
� Referencing Requests from Project Plans
� Creating Tasks from Requests
� Dependencies Between Tasks and Requests

� Making Tasks Dependent on Requests
� Making Requests Dependent on Tasks

� Visibility into Tasks and Requests
� Requests Holding Up Progress
� Project References Section
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Overview of Integrating Requests and Project Plans

Mercury IT Governance Center integrates issue tracking with project 
management using Mercury Demand Management and Mercury Project 
Management. Mercury Demand Management requests and Mercury Project 
Management project plans and tasks can be linked to each other through a 
variety of dependent and informational relationships. Utilizing these 
relationships, requests can be folded seamlessly into a scalable framework of 
interlocking initiatives. Linking tasks to requests from Mercury Demand 
Management also gives instant visibility to detailed activities supporting an 
overall project.

The components required to integrate requests and project plans are:

� Mercury Project Management
Mercury Project Management enables collaborative project management 
for both repetitive projects, such as installing a new release of your HRMS 
applications, and one-time projects, such as developing a new e-commerce 
capability. With Mercury IT Governance Center, you accelerate project 
delivery while reducing your project costs.

� Mercury Demand Management
Mercury Demand Management is a workflow-driven request resolution 
system for business applications. It allows you to effectively capture, route 
and resolve business requests. 

Referencing Requests from Project Plans

Requests can be linked to project plans through an informational reference 
relationship. This is done from the References tab in the Project Information 
window in the Workbench, or from the References section of the Project Detail 
page. 
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Figure A-1. Project Information window - References tab

Creating Tasks from Requests

Occasionally, a request can be filed by a user that would be desirable to make 
into its own task in a Mercury Project Management project plan, creating for it 
deliverable dates and track-able actuals. Tasks can be created from requests in 
the Project Management Workbench. A task created from a request behaves like 
any other task in the project plan, save for that the tasks’s % Complete and State 
are automatically updated by the originating request as it moves through its 
workflow. The new task has the dependency relationship Task Updated by 
Request.

For example: A manager in a software company wants to create a project plan 
that will track all of the bugs currently logged against a particular product. In 
the Workbench, the manager can search for bug requests related to the product, 
and turn them into tasks in the project plan. From there, the manager can 
perform any typical project plan action, such as tracking the completion dates 
for each task or monitoring triggered exceptions.

You must be in the Project Management Workbench in order to create a task from a 
request.
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To create a task from a request:

1. Open the project plan.

2. From the Project window, select Task Created From Request from the 
drop-down list at the bottom-left corner of the window.

3. Click Add.

The New Task From Request window opens.

4. To select the request to attach, use one of the following methods:

� Select a request number from the Request No. field.

� Click Search to search for a request to add in a separate query window.
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5. Click OK to create the new task and close the window. 

The new task has been created from the selected request and is part of the 
current project plan. The task is linked to the request. 

Dependencies Between Tasks and Requests

The dependencies that can be created between requests and tasks are described 
in Table A-1.

For more detailed information on using these dependencies, see Making Tasks 
Dependent on Requests and Making Requests Dependent on Tasks.

Making Tasks Dependent on Requests

When selecting dependencies between tasks and requests, there are many 
relationships to choose from. These relationships are set by attaching a request 
to a task as a reference. This is done from the References tab in the Task 
Information window in the Workbench, or from the References section of the 
Task Detail page in the standard interface. 

Table A-1. Dependency relationships - requests to tasks 

Relationship Description

Related to this Task (Informational) - Selected request is related to the task.

Successor
(Blocking) - Action not allowed on selected request until 
the task closes.

Predecessor
(Blocking) - Action not allowed on the task until the 
selected request closes.

FF Predecessor
(Finish Finish Predecessor: Blocking) - The task and 
request complete together.

Task Updated by 
Request

(Auto-Updating) The task is automatically updated by 
the selected request. 
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Figure A-2. Task Information window - References tab and References 

section

The following sections contain more detailed information on dependencies for 
tasks created from requests. 

Task Waits on Request Closure (Successor Relationship)

This relationship dictates that the task state cannot change until the associated 
request is closed. The task will immediately move into a "Pending Request" 
state. When the request is closed, the task can be acted upon once more. This 
does not stop other fields from being edited. 

For example: A software company’s Support Division makes the decision that 
no patches will be released without accompanying documentation. The 
company has an unfortunate history, however, of changing its mind about 
patches that are to be released, and numerous times there have been 
documentation changes made to accommodate patches that were cancelled 
after being initially approved. Patch A’s approval request is moving through its 
resolution process in Mercury Demand Management. The Documentation 
team is ready to begin making changes to all documents to account for Patch 
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A, and has created a project plan in Project Management. The project plan 
includes the task Begin Doc Changes for Patch A. 

The Documentation Team’s manager creates a reference to Patch A’s Request 
from the Begin Doc Changes for Patch A Task, with the relationship Successor. 
This way, the task cannot be moved from its status of Ready to In Progress until 
Patch A’s approval request is closed, ensuring that the documentation changes 
are valid and needed.

Task Can’t Complete Until Request Closes (FF Predecessor)

This relationship dictates that the task state cannot change to Complete until the 
associated request is closed. When the resource working on the task is finished 
with it, and the state is set to Completed (% Complete will be set to 100%), this 
task will move into a Completed (Pending Request) state. When the request is 
closed, the task is then set to ‘Completed.’ This does not stop other fields from 
being edited.

For example: A software company’s Support Division makes the decision that 
no patches will be released without accompanying documentation, including 
bug fixes. The Documentation Team wants to make sure that its documentation 
is accurate and complete for every bug fix that takes place. The last step in the 
company’s bug fix resolution process is a review by the person who originally 
filed the bug. A request to fix Bug 62547 has been filed and nearly completed, 
necessitating changes to the documentation. 

The Documentation Team has a project plan in Project Management, one of 
whose tasks is Doc Changes Complete. The Documentation Team manager 
creates a reference to Bug 62547’s request, with the relationship FF 
Predecessor. This way, the task cannot be fully completed until Bug 62547’s 
fix has been approved by the requestor, closing the request.
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.

Figure A-3. Example process for FF Predecessor relationship

Task Auto-Updated by Request

This relationship is for tasks created from requests. As the request moves 
through its process, it will update the task with its status information. When the 
request is submitted, the tasks moves to In Progress. When the request is 
completed, the task is Complete. When the request is cancelled or deleted, the 
task is cancelled. A single request can drive multiple tasks. If the request’s 
workflow has % Complete values defined, the request will also update the task 
with % Complete information.

Making Requests Dependent on Tasks

Requests can be made dependent on tasks. This is done from the References 
section of the Request page in the HTML interface.

Request Resolution Process

Final
Approval

Documentation Team Project

(Task Completed)
(Task Completed - Pending Request)

Bug
Fixed

Bug Fix
Request

Since % Complete and task state are automatically updated by the driving request(s), 
users cannot update these two fields. The text “(Updated by Request)” will be 
appended to the Ready and In Progress states to indicate this.
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Figure A-4. References section for requests

The section, Request Waits on Task Closure (Predecessor), contains more 
detailed information on dependencies for requests set by tasks:

Request Waits on Task Closure (Predecessor)

This relationship dictates that the request’s user cannot perform any workflow 
actions until the associated task is closed (completed, bypassed, or cancelled). 
The request will immediately move into a ‘Pending Task’ status. When the task 
is closed, the request can be acted upon once more. This does not stop other 
fields from being edited.

For example: A software company’s Support Division makes the decision that 
no patches will be released without accompanying documentation. The 
Documentation Team wants to make sure that any patch request won’t close 
until the patch documentation is finished. A Mercury Demand Management 
user is assigned a request going through the company’s patch approval/release 
process. At the same time, the Documentation Team has a project plan in 
Project Management, one of whose tasks is ‘Patch Docs Completed.’ The user 
creates a reference to that task, with the dependency ‘FF Predecessor.’ This 
way, the patch request will not close until the ‘Patch Docs Completed’ task is 
complete.

Visibility into Tasks and Requests

Mercury IT Governance Center enables visibility into request and task 
integration.

Requests Holding Up Progress

You can search for requests that are holding up progress on your projects. Each 
portlet in the Dashboard that deals with requests includes the field Preventing 
Action on Requests/Tasks. This field can be set to display requests that are 
preventing action on other requests or tasks.
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Figure A-5. Request portlet filter page Preventing Action On field

Project References Section

You can also view references related to your tasks and project plans using the 
Project References section on the Project Overview page. Add the section to the 
Project Overview page and then personalize it to show the references that are 
relevant to your activities. The section can be personalized to display 
references based on the following information: Reference types, relationship, 
time period when they were added, and whether or not they are preventing 
actions on tasks. 

Figure A-6. Project References section
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Project Management Portlets

Information regarding Project Management data can be organized and 
presented using the Mercury Project Management portlets. Mercury does not 
supply a preconfigured Project Management Dashboard page. See Table B-1 
for a complete list of the Project Management portlets. 
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Projects Portlets 

Table B-1. Projects portlets 

Projects Portlets Description

My Tasks
Lists all project tasks currently assigned to you 
and having a scheduled finish date two weeks 
from the current date.

Program Project List

Lists the projects within a program. The default 
parameters show all project items for the 
program. Project items are sorted by the project 
hierarchy and optionally, by:

� Name

� Resource

� State

� Scheduled finish

� Project hierarchy

Project Gantt
Gantt chart for all projects, tasks, and 
milestones. 

Project List

Lists general information about projects, such as 
how close they are to completion and their 
scheduled finish date. Information displayed can 
be based on project name or other project 
related criteria. 

Project Summary Pie Chart

Pie chart summary of projects grouped by their 
summary condition. Filter the data by a set of 
specific projects and subprojects, or filter by 
department and/or project manager.

Resource Gantt

Gantt chart for resources showing work items 
including:

� Requests

� Tasks

� Milestones

� Staffing Profiles
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Reports by Category

In This Appendix:

� Overview of Report Categories
� Administrative Reports
� Change Management Reports
� Demand Management Reports
� Financial Management Reports
� Portfolio Management Reports
� Program Management Reports
� Project Management Reports
� Resource Management Reports
� Time Management Reports
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Overview of Report Categories

Reports available through the Mercury IT Governance Center standard 
interface are listed (by category) and described in the following sections.

Administrative Reports

The administrative reports (listed in Table C-1) are available to users with an 
administration license.

Another type of report in Mercury IT Governance Center (not discussed in this 
document) are server reports, which are submitted and viewed from the Workbench 
interface, For information about server reports, see the System Administration Guide 
and Reference.

Table C-1. Administrative reports

Report Definition

Contact Synchronization
Provides an interface for checking whether Mercury 
Demand Management contacts are properly defined.

This report is also in the Resource category.

Environment Comparison
Helps audit environment definitions when different 
environments (for example, development and production) 
are similar to each other.

Environment Detail

Lists the detailed definitions of a given environment or 
group of environments, the major attributes of the 
environments, and the attributes of applications tied to 
the environments.

Environment Group Detail
Contains detailed information about specified 
environment groups.

Import Requests

Imports requests into Demand Management request 
tables, moves the requests to the appropriate status, and 
reports on the results of the execution.

For more information about this report, see the Open 
Interface Guide and Reference.
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Import Users

Imports data from the user interface tables or an LDAP 
server.

For more information about this report, see the Open 
Interface Guide and Reference.

Lookup Types Provides information about one or more lookups.

Notification History
Provides information about notifications that have been 
sent or are pending.

Object Type Detail
Lists all parameters and commands associated with a 
given object type.

Portlet Detail Provides information about a portlet or range of portlets.

RCS Check In
Template of a report used to check files into the RCS 
repository (if the RCS file management system is being 
used).

RCS Check Out
Template of a report used to check files out of the RCS 
repository (if the RCS file management system is being 
used).

Report Type Detail Provides information about report type definitions.

Request Header Type Detail
Lists detailed definitional information for request header 
types.

Request Type Detail Lists detailed definitional information for request types.

Run Field Security Denormalization
Runs field level security-related denormalization tasks for 
particular entities.

Run ITG Organization Unit Interface

Imports data from the organization unit interface tables or 
an LDAP server.

For more information about this report, see the Open 
Interface Guide and Reference.

Run ITG Package Interface

Validates and loads package data from the package open 
interface tables into the standard Mercury Change 
Management data model.

For more information about this report, see the Open 
Interface Guide and Reference.

Run Workflow Transaction Interface

Validates and runs workflow transactions based on data 
in the workflow open interface tables.

For more information about this report, see the Open 
Interface Guide and Reference.

Security Group Detail
Lists definitional information for one or more security 
groups.

Table C-1. Administrative reports [continued]

Report Definition
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For More Information

Unless otherwise indicated in Table C-1, see the Reports Guide and Reference 
for more information about Administrative reports.

Special Command Detail
Provides details for a command (special command) or a 
range of commands.

Synchronize Meta Layer
Assesses or synchronizes the RML (Reporting Meta 
Layer).

User Data Detail
Displays the definition of custom user data field (for 
example, fields on entities like packages, requests, 
workflows, and security groups).

User Detail

Lists the users who have been defined in the Mercury IT 
Governance system, as well as the security groups 
attached to each user.

This report is also in the Resource category.

Validations

Provides information about the various custom 
validations that have been entered into the system as 
well as those that are standard with Mercury IT 
Governance Center products.

Workflow Detail
Provides detailed definitional information about specific 
workflows or sets of workflows.

Workflow Statistics
Given a date range and a workflow (or a range of 
workflows), this report provides statistical information 
regarding workflow usage.

Table C-1. Administrative reports [continued]

Report Definition
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Change Management Reports

The Change Management reports (listed in Table C-2) are available to users 
with a Mercury Change Management application license.

Table C-2. Change Management reports

Report Definition

Compare Custom Database Setup Runs custom database comparisons.

Compare Filesystem Environment Compares the files and file structures of two machines.

Compare MS SQL Server 7 
Environments

Compares the data model of two SQL Server Version 7 
databases.

Compare Oracle Environments Compares the data model of two Oracle schemas.

Distribution Detail Lists the contents and results of a distribution.

Environment Comparison by Objects 
Migrated

Given two environments, this report looks at the history of 
all the objects migrated into each environment (using 
Mercury Change Management) and lists any differences.

Environments/Objects Detail
Lists objects that have been migrated into a given 
environment or set of environments.

Object History
Provides a workflow step transaction history for 
packages.

Objects/Environments Detail
Lists objects that have been migrated into a given 
environment or a set of environments.

Package Details Returns details about a given package.

Package History Lists the complete workflow history of a given package.

Package Impact Analysis

Lists three separate sections for analysis:

� Other packages that contain common objects with a 
given package

� Objects that have migrated alongside one or more of 
the objects being migrated on the given package but 
are not included in the given package

� Recent migrations for each object in the package, 
showing where changes to the given objects have 
recently been deployed

Packages Pending

Lists:

� Open packages with pending activity

� Details about each package

� Pending work for a group of users
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For More Information

For more information about Change Management reports, see the Reports 
Guide and Reference.

Release Detail
Lists requests, packages and distributions associated 
with a release.

Release Notes
Shows all of the requests and packages in a release as 
well as their associations.

Table C-2. Change Management reports [continued]

Report Definition
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Demand Management Reports

The Demand Management reports (listed in Table C-3) are available to users 
with a Mercury Demand Management application license.

For More Information

For more information about Demand Management reports, see the Reports 
Guide and Reference.

Table C-3. Demand Management reports

Report Definition

Contact Detail
Queries the contacts already entered in the Demand 
Management system that are available for entering and 
updating requests.

DEM Demand Creation History
Shows the history of demand creation for a specified 
demand set.

DEM Historical SLA Violation
Shown the history of SLA violations for a specified 
demand set.

DEM Satisfied Demand History
Shows the history of demand that has been satisfied for a 
specified demand set.

Request Detail
Provides information about requests using a number of 
selection criteria.

Request Detail (Filter by Custom 
Fields)

Similar to the Request Detail report except that requests 
can be filtered by values in custom fields.

Request History
Lists the complete workflow and field change history for 
each selected request.

Request Quick View
Lists a quick summary of open and closed requests, 
breaking down the requests by priority.

Request Summary
Displays the total counts for groups of requests matching 
the selection criteria.

Request Summary (Filter by Custom 
Fields)

Similar to the Request Summary report except that 
requests can be filtered by values in custom fields.

Resource Load by Priority
Lists all open requests assigned to different users.

This report is also in the Resource category.
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Financial Management Reports

The Financial Management reports (listed in Table C-4) are available to users 
with a Mercury Time Management application license.

For More Information

For more information about Financial Management reports, see the Reports 
Guide and Reference.

Table C-4. Financial Management reports

Report Definition

Actual Time/Cost Summary

Summarizes actual time information entered in 
non-cancelled time sheets and the calculated charge 
dollar totals for each grouping.

This report is also in the Time Management category.

Project Cost Breakdown
Shows the costs for a project, and the activities with 
which the costs are associated.

This report is also in the Project Management category.

Project Cost Details
Shows the cost details for select projects, grouped by 
labor/non-labor or operating categorizations.

This report is also in the Project Management category.
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Portfolio Management Reports

The Portfolio Management reports are available to users with a Mercury 
Portfolio Management application license.

There are currently no Mercury-supplied reports in this category, but you can 
create your own custom reports, if you like.

Program Management Reports

The Program Management reports are available to users with a Mercury 
Program Management application license.

There are currently no Mercury-supplied reports in this category, but you can 
create your own custom reports, if you like.
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Project Management Reports

The Project Management reports (listed in Table C-5) are available to users 
with a Mercury Project Management application license.

Table C-5. Project Management reports

Report Definition

Project Cost Breakdown

Shows the costs for a project, and the activities with 
which the costs are associated. 

Totals include both labor and non-labor costs.

This report is also in the Financial Management category.

Project Cost Details
Shows the cost details for select projects, grouped by 
labor/non-labor or operating categorizations.

This report is also in the Financial Management category.

Project Critical Path Displays the tasks that are on a project’s critical path.

Project Custom Detail
Generated in HTML table format, showing only the 
columns that are selected from the header fields and 
custom fields based on the selected project.

Project Detail Queries projects by their header fields.

Project Detail (Filter by Custom 
Fields)

Queries projects by their header fields. You can filter the 
query using the project’s custom fields.

Project Exception Detail
Lists task details for tasks that have violated user-defined 
exception rules.

Project Resource
Lists all resources working on a given project and the 
tasks on which they are working.

This report is also in the Resource category.

Project Schedule Change
Compares a project plan with a baseline, or a baseline to 
another baseline.

Project Status Detail
Summarizes project statuses of selected projects and 
tasks.

Project Summary
Displays all projects that meet the criteria selected in the 
header fields.

Project Task Assignment
Shows assignment information for a user or a group of 
users.

This report is also in the Resource category.

Project Template Detail
Lists the parameters and parameter details for project 
templates.
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For More Information

For more information about Project Management reports, see the Reports 
Guide and Reference.
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Resource Management Reports

The Resource Management reports (listed in Table C-6) are available to users 
with the licenses indicated in the definition column in the table.

Table C-6. Resource Management reports

Report Definition

Contact Synchronization

Provides an interface for checking whether Mercury 
Demand Management contacts are properly defined.

Available to users with an administration license.

This report is also in the Administrative category.

Project Resource

Lists all resources working on a given project and the 
tasks on which they are working.

Available to users with a Mercury Project Management 
license.

Project Task Assignment

Shows assignment information for a user or a group of 
users.

Available to users with a Mercury Project Management 
license.

Resource Load by Priority
Lists open requests assigned to different users.

Available to users with a Mercury Demand Management 
license.

User Detail

Lists the users who have been defined in the Mercury IT 
Governance system, as well as the security groups 
attached to each user.

This report is available to users with any application 
license.

This report is also in the Administration category.

Work Allocation Details

Shows much of the same information shown on the Work 
Allocation definition page—for example, allocation work 
item information, budget and actuals to date, charge code 
allocations, and resource restrictions.

Available to users with a Mercury Time Management 
application license.

This report is also in the Time Management category.
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For More Information

For more information about Resource Management reports, see the Reports 
Guide and Reference.
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Time Management Reports

The Time Management reports (listed in Table C-7) are available to users with 
a Mercury Time Management application license.

For More Information

For more information about Time Management reports, see the Reports Guide 
and Reference.

Table C-7. Time Management reports

Report Definition

Actual Time/Cost Summary
Summarizes actual time information entered in 
non-cancelled time sheets and the calculated charge 
dollar totals for each grouping.

Actual Time Summary
Summarizes actual time information entered in 
non-cancelled time sheets.

Time Sheet Details Summarizes multiple time sheets displays their details.

Time Sheet Summary
Summarizes time information entered in non-cancelled 
time sheets.

Work Allocation Details

Shows much of the same information shown on the Work 
Allocation definition page—for example, allocation work 
item information, budget and actuals to date, charge code 
allocations, and resource restrictions.

This report is also in the Resource category.
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